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RESUMEN

Se plantea como area de estudio la microcuenca Puyllucana localizada en la

 cordillera occidental de los Andes Peruanos a una distancia de 9 km. al noreste
de la cuidad de Cajamarca, y con una altitud que varia de los 2,687msnm. a los
3,305msnm. En el presente estudio se busca, con un enfoque geolégico, mejorar
la calidad de los datos al obtener la oferta hidrica del caudal en la microcuenca
Puyllucana cuyo valor sea lo mas cercano a la realidad, para lo cual se obtienen
los parametros morfométricos con ayuda de uno de los software mas comple{os
y utilizado a nivel mundial, como es el ArcGIS y haciendo la comparacién entre
el formato tradiciqnal 2D y una nueva metodologia a manera de propuesta en
formato de relieve 3D péra finalmente sefalar que el valor de la oferta hidrica del.
caudal en una cuenca hidrogréfica deberia ser realizado siempre en relieve 3D.
La unidad de estudio queda clasificada como: Microcuenca, de forma alargada,
de forma oval alargada con tendencia a crecida media, moderadamente
empinada, en fase de madurez, ubicada en la Regién Quechua Baja, bien
drenada y con bifurcacién de orden 3. '

Palabras clave: microcuenca, oferta hidrica, parémetros morfométricos, ArcGIS,
grelieve 3D.



ABSTRACT

It arises >as a study area the Puyllucana watershed, located in the Western
- mountain range of the Peruvian Andes at a distance of 9 km northeast of the city
of Cai_jamarca, and with an altitude ranging from 2, 687msnm. 3 305msnm. In the
present study sought, with an ecoiogical approach, improving the quality of the
data to get the water supply flow in micro Puyliucana whose value is as close to
reality, for which morphometric parameters are obtained using one of the most
complete and software used worldwide, such as ArcGIS and making comparison
betWeen the traditional 2D format and a new methodology proposed by way of
3D landscape format to finally noted that the value of the water supply flowin a
river basin it should always be made in 3D relief. Classifying the unit of study as:
wate‘?shed, of elongated, oval-shaped élongated with tendency to fioéd a\'/er,age,
moderately stéep, 'in phase of maturity, located in the Regidn Quechua,:;well
drained and fork of order 3.

Keywords: watershed, water supply, ‘mbrphometric parameters, ArcGIS, 3D
relief.
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CAPITULO |
INTRODUCCION

El agua es un recurso y un elemento vital para el desarrollo de las actividades:
humanas y de los procesos naturales; el manejo y formas de gestion de estas
actividades tienen un reflejo directo sobre los atributos de calidad y cantidad de
_ agua, conocer los factores que condicionan el balance entre la disponibilidad y
usos del agua es uno de los temas mas importantes al abordar la gestion de los
recursos hidricos. La necesidad hidrica viene a ser afectada por los factores de
oferta y demanda al ser bien necesario para la vida en el planeta, por lo que los
factores que determinan la disponibilidad y cbn ello el punto de equilibrio,
primeramente se abordan los relacionados con la oferta y posteriormente se
aborda los relativos .a‘ la demanda hidrica, con ello podemos hacer
consideraciones en cuanto a géstién se trata. 1 '

Planteamiento del Problema.

La creciente necesidad de lograr el equilibrio hidrolégico que asegure el
abastecimiento suficiente de agua a la poblacién se logrard armonizando la
disponibilidad natural con las extracciones del recurso mediante el uso eficiente
del agua. Nuestro pais es rico en recursos naturales, obtiene el égua que
consume la poblacién de fuentes tales coma rios, arroyos' y acuiferos del
subsuelo. Estos acuiferos.se recargan de forma natural en época de liuvias. Sin
embargo, la época de lluvias tiene ur{a duracién promedio de cuatro meses lo
que propicia una escasa captacion. Aunado a esto, del total de agua captada por
lluvias, se tiene una fuerte evaporacién de la misma. La despropdrcién gue existe
entre la cantidad de agua que se capta por escurrimiento y las extensiones
territoriales que comprenden aunado a la corta temporada de lluvias hace que la
disponibilidad del agua sea cada vez menor. ‘

" En tal sentido, actualmente la determinacién de la disponibilidad hidrica de una
cuenca se realiza utilizando todos los alcances de la técnica conocida,
cimentando sus alcances en la determinaciéon del area y el coeficiente de

escorrentia en base de un plano en condiciones de dos dimensiones. Sabiendo



que este importante parametro hidrico se basa en el area de una determina zona,
estimamos que se esta desarrollando calculos que no se ajustan a la realidad, a
pesar que con el paso del tiempo se ha avanzado en el desarrollo de la ciencia
y la tecnologia que hace posible el estudio y caractérizacién de los sistemas
naturales cada vez més precisos y cercanos.a la realidad, como es el caso de
los software SIG (entre ellos ‘el ArcGIS) cuya metodologia en formato 3D
proporcionaria resultados mas cercanos a la realidad de la oferta hidrica en una
zona especifica. Para el caso de: nuestra investigaciénvlo hemos tratado de
aplicar en la microcuenca del Rio Puyllucana. '

Formulacién del Problema,
¢Cémo se puede determinar la oferta hidrica del caudal en la microcuenca
Puyllucana de modo mas cercano a la realidad?

Justificacion de la Investigacion _

La oferta hidrica del caudal en una'cuenca hidrografica y especificamente en la
zona de estﬁdio, no tiene el mismo valdr en un plano 2D que realiz'arl_avde un
modo mas cercano a la realidad como es en relieve 3D cuyas herramientas
necesarias disponen muchos de Iés software del mundo SIG, para finalmente
sirva de base a los usuarios y autoridades en considerar su uso y disponibilidad
en proyectos actuales y futuros. |

Objetivos

General

= Determinar el caudal, mediante la caracterizacién hidromorfométrica de la
microcuenca Puyllucana con la aplicacién ArcGIS.

Especificos

= Elabofacién de perfil geolégico de la zona de estudio. |

= Realizar la clasificacion hidrogeolégica de la zona de estudio.

* Realizar la comparacion en 2D y en 3D de los parametros morfométricos en
la zona de estudio.

= Determinar el valor en 2D y en 3D del caudal aportado en la zona de estudio.

Académico

* Obtener el titulo profesional de Ingeniero Gedlogo.



Hipotesis de Investigacién ‘

La oferta hidrica del caudal en la microcuenca Puyllucana calculando sus
parametros hidromorfométricos mediante el uso de software en la plataforma
SIG, tiene un valor mas cercano a la realidad.

El trabajo esté estructurado en cinco capitulos:

En el capitulo | se bresenta la situacién a investigar, abarca los objetivds,
justificacién e hipétesis. '

En el capitulo Il se muestra la recopilacién de los antecedentes teéricos de la
investigacién como eétudios de aguas termales del INGEMMET, prevencién de
desastres del INDECI, trabajos geoléglcos de cuencas sedimentarias, y tesis
relacionadas con la investigacién, como bases teéricas se considerd
fundamentos en geologia, en cuencas hidrograficas y el uso de los SIG en la
‘morfometria de cuencas, ademés de la definicién de términos bésmos usados
para la investigacién. ’

En el capitulo Il se considera la ubicacién geografica, accesibilidad a la zona,
ademas hace referencia a la metodologia de investigacién, trabajo de gabmete
y de campo; s€ ‘describe también la geologla e hidrogeologia local y regional. .

En el capitulo IV se presenta la aplicacién del software ArcGIS planteando una
nueva metodologia en la deiimitacién de la microcuenca Puyllucana asi como en
la obtencion de sus parametros morfémétricoé en relieve 3D y finalmente obtener
el valor mas cercario -a la realidad de la oferta hidrica del caudal. Por uitimo el
capitulo V, donde se presenta las conclusiones, resultados y recomendacuones
finales como consecuencia del trabajo de investigacion.



CAPITULO Il
MARCO TEORICO

- 2.1 ANTECEDENTES TEORICOS DE LA INVESTIGACION

* INGEMMET BOLETiN N°31 (1980), cuadrangulo de Cajamarca - San
Marcos - Cajabamba. Analizan regionalmente el area de estudio.
Considerando la existencia del cartografiado a escala 1:100,000. Afio 1980.

* INGEMMET (20035,'_Estudios hidrogeolégico y geofisico Bafios del Inca,
Cajamarca: Aguas Termales Para El Nuevo Milenio. Donde describe el
estudio geologico y geoquimico de las aguas termales en los alrededores del

 Distrito de los Bafios del Inca. ‘ — '

= INDECI (2004), Proyecto INDECI~pnud per/02/051 Ciudades Sostenibles,
tltulado Mapa o’e Peligrosidad de la Cludad De Los Bafios del Inca. Donde-
se presenta manantlales principales de agua termal y los planos del estudio
hidrolégico y geoldgico en la zona central de la ciudad de los Bafios del Inca.

= [NDECI (2005), Proyecto INDECI-pnud per/02/051 Ciudades Sostenibles,.
titulado: Programa de Prevencién y Medidas De Mitigacion Ante Desastres
de la Ciudad de Céjamarca. Donde se plasma en planos y se describé
niveles de peligro en la ciudad de los Bafios del Inca.

» LAGOS A; QUISPE Z (2007), Trabajo de investigacion: Aportes al Analisis
de Cuencas Sedimentarias en los Alrededores de las Localidades de los
Barios del Inca, Cruz Blanca, Otuzco. Distrito de Cajamarca. Presentado en

el XIll Congreso Peruano de Geologia.

» CHUQUIRUNA, W (2009), en su Tesis: Caracterizacion Estratigrafica Y

Estructural de la Subcuenca Chonta - Cajamarca; mediante aplicacion SIG.



Realiza la correlac.ién de variables estratigréﬁcas y estructurales de la
Subcuenca Chonta bajo el modelamiento del software ArcGIS v9.3.

BARDALES, B (2014), en su Tesis: Analisis Estructural dé la Secuencia
Cretéacica de los Barios del Inca y Alrededores, Cajamarca - Peru. Analiza el
comportamiento estructural y lo relaciona como un controlador en la
disposicion de la red fluvial.

ASCURRA, M (2014), en su Tesis: Caracterizacion Geolégica e
Hidrogeolégica de la Microcuenca Shaullo, Bafios del Inca-Cajamarca.
Realiza la caracterizacién geolégica e hidrogeolégica de la microcuenca
Shaullo, usando estaciones geomecanicas e inventariado de manantiales.

2.2 BASES TEORICAS

- 2.2.1Principios Fundamentales de la Geologia :

i. Principio de la Superposicion de Estratos. (Steno, 1669).

En una sucesién de estratos, las capas de sedimento se depositan en una

secuencia temporal, en la que las mas antiguas se encuentran en posicién
L -

inferior a las més recientes.

Prmclplo de Horizontalidad Original. (Steno, 1669).
No |mporta cudl sea la orientacién actual de un estrato, fue creado por un

depésito de agua, y por tanto, fue en su origen horizontal.

Principio de Continuidad Lateral. (Steno, 1669).
El agua deposita sedimentos en una capa continua que termiha solamente
en el borde de su cuenca. Por tanto, capas de rocas correspondientes a -

ambos lados de un valle fueron originalmente una tnica capa.

Principio de Interseccién. (Hutton, 1788).

Cualquier fenémeno o acontecimiento geoldgico (intrusion ignea, falla,

- plegamiento, etc.) es mas joven que las rocas a las que afecta.
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Principio de Inclusion. (Hutton, 1788).
Las inclusiones (o clastos) que se encuentran dentro de una formacién, son
mas antiguos que la formacién que los contiene.

Principio de la Sucesién Faunistica o de Correlacion (Smith, 1815).
Los fésiles de la parte inferior de una secuencia de estratos son més antiguos
que aquellos situados en la parte superior de la secuencia. Y que dos
estratos que tengan los mismos fésiles son de la misma antigiedad

Principio del Uniformismo y del Actualismo. (Hutton, 1788).
Los procesos naturales que actuaron en el pasado son los mismos que '
actuan en el presente. Su significado se resume a menudo en: “El presente
es la clave del pasado”. -

2.2.2Ciclo Hidrolégico

El ciclo hidrolégico del agua es el proceso por el que el agua se mueve desde el

aire (condensacién) hasta fa tierra (precipitacién) y vuelve a la atmoésfera

(evaporacién). La mayor parte de la masa del agua se encuentra en forma

liquida, sobre todo en los océanos y mares y en menor medida en forma de agua

subterranea o(fde agua superficial (en rios y arroyos). También el agua

acumulada como hielo en tos glaciares, en el Pertu le encontramos en la

Cordillera Blanca-Ancash. El agua'nunca estd quieta, estd en continuo

movimiento, y durante ese movimiento va pasando de un estado a otro. Este

proceso es lo que se denomina ciclo del agua. (Portal Web: Autoridad Nacional del

Agua §2).
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Figura 01. Ciclo Hidrolégico del Agua.

Fuente: Pérez y Rodriguez, 2009



2.2.3Cuenca Hidrografica
Son espacios geograficos, cuyos limites inician en las partes altas de las
montafias - conocidos como "parteaguas” y terminan en donde el agua de las

precipitaciones que corren por un rio principal llega al mar, lagos o embalses
artificiales. (Jiménez, F. 2005). '

o e

Figura 02. Cuenca Hidrografica.
Fuente: Sanz, 2008. :

En la cuenca hidrografica se encuentran los recursos naturales y la
infraestructura creada por las personas, en las cuales desarrollan sus actividades

econémicas y sociales generando diferentes efectos favorables y no favorables

para el bienestar humano. (Dourojeanni, 1994 y Faustino, 1997).

2.2.3.1 Divisién Espacial de una Cuenca Hidrografica -

Para el ordenamiento y manejo de una cuenca, es necesario dividirla en
unidades mas pequefias:

Una subcuenca, es toda area en la que su drenaje va a directamente al rio
principal de la cuenca. También se puede definir como una subdivisién de la

cuenca. Es decir que en una cuenca puede haber varias subcuencas.
(Umafia, 2012).

Una microcuenca, se define como el "campo de la formacién natural, drenada
‘por un curso de agua y sus afluentes aguas arriba de una seccién transversal
considerada, donde converge toda la zona de aguas”. En términos generales,

la microcuenca es una subcuenca de area pequefa. (Cecilio y Reis, 2006).



Subcuenca

Microcuenca

Figura 03. Cuenca, subcuenca y microcuenca.
Fuente: Amanalco, 2014.

Las microcuencas son unidades pequefias y a su vez son areas donde se
_originan quebradas y riachuelos que drenan de las laderas y pendientes altas.
También. las microcuencas constituyen las unidades adecuadas para la
plaﬁiﬁcac'ién de aéciones para su manejo. (Umanfa, 2012). - o

2.2.3.2 Cuenca Hidrografica y Cuenca Hidrolégica

Una cuenca hidrogréfica y una cuenca hidrolégica se diferencian en que la
cuenca hidrografica se refiere exclusivamente a las aguas superficiales, mientras
que la cuenca hidrolégica incluye también a las aguas subterraneas (acuiferos).
Es muy |mportante conocer esta caracteristica interna de la cuenca, porque en
algunos casos se realiza el balance hidrolégico sin considerar los aportes o fugas
de una cuenca vecina a otra. Un caso partlcular es el de las cuencas ubicadas
en terrenos cérstacos (Mag y Forgaes 2014)
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Figura 04. Divisorias de aguas Topografica e Hidrogeolégica
Fuente: Mag y Forgaes, 2014. ‘



2.2.3.3 Las cuatro dimensiones de una cuenca hidrografica

Entre las dimensiones convencionales que siempre destacan en una cuenca
- hidrografica, esta el largo y ancho (cohﬁguran la forma), pero no muy
frecuentemente se caracteriza la profundidad (manto rocoso) y el vuelo (altura
de la cobertura vegetal, relieve y caracteristicas aéreas), o sea que en términos
practicos se manejan tres ejes X, Y, Z, (ancho, Iérgo y altura). Pero para entender
el comportamiento de la cuenca es indispensable conocer escenarios en el
tiempo, que éxpliquen cambios y dindmicas, lo cual lleva a valorar la dimensién
temporal (t). (Faustino, 2006).

TIOMPO  macseccsmmmimess

. Montanas

.Ill'll.l’

Figura 05. Dimensiones de una Cuenca Hidrografica
Fuente: Faustino J. 2006 ) -

2.2.4 Oferta Hidrica ‘
Corresponde al volumen disponible de aglja para satisfacer la demanda -
generada por las actividades sociales y econémicas del hombre. (Corponarifio).
2.2.4.1 Férmula Racional : |

Es un método muy apropiado cuando la informacién di'sponible de la zona de
trabajo, de superficie no superior a 1.000 ha, no es muy exhaustiva; su validez
ademas depende de la fiabilidad de los valores del coeficiente de escorrentia (c)
y del tiempo de concentracion empleados en ei calculo. (Ibafez, et. al. 2011).

La expresion utilizada para el calculo toma la siguiente forma: Q = C*I*A / 360.

Donde: Q = caudal de escorrentia (m3/s), C = coeficiente de escorrentia, | = intensidad
de la precipitacién (mm/h), A = superficie de la cuenca (ha)



2.2.5 SIG enla Morfometria de Cuencas Hidrograficas

El uso de sistemas de informacién geografica (SIG), en particular el analisis de
superficies a través de modelos digitales de eleyacién. representa una alternativa
que ha tomado relevancia en estudios de parametros mor_fométricos por ser muy

util para analizar caracteristicas de un ambiente geomorfolégico. (Viramontes et
al., 2007). ‘ '
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Figura 06. Modelo de cuenca hidrogréfica y parametros morfométricos
Fuente: Franz, 2012 '

El uso de sistemas de informacién geogréfica (SIG), en particular el andlisis de
superficies a través de modelos dié}tales de elevacion, representa una alternativa
que ha tomado relevancia en estudios de'parémetros morfométricos por ser muy
atil para analizar caracteristicas de un ambiente geomorfol6gico. (Viramontes et
al., 2007). ’

Entre las ventajas de esta herramienta SIG estan su adaptabilidad a una gran
variedad de modelamiento con una minima inversién de tiempo y dinero; Iqs
datos espaciales y no espaciales pueden ser analizados simultaneamente en
una forma relacional; gran diversidad de modelos conceptuales pueden ser

probados rapidamente y repetidos verias veces facilitando su ajuste y evaluacion
(Valenzuela, 1989). '
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- Fuente: Oserm, 2002,

Cartogréﬁa temética |

Datos estadisticos |

Iméagenes de Satélite |

Tablas de.oatos ] . Trabajo de Campo |

Procesado de la Informacién

SI1G ‘
BASES DE DATOS |

b

{

e

Anéfisis e interpretacién de los datos

o

[Cartografias especificas’
Modelos o [fndices

Figura 07. Manejo de informacién espacial en un SIG

Modificado por el tesista. -

Los sistemas de inforfnacién geogréfica permiten complementar los diferentes
tipos de priorizacién en las cuencas donde esta herramienta se ha convertido en
la metodologia de analisis geografico de gran difusion. La causa principal de esto
reside en la multitud de actividades en las que pueden ser Utiles. (Bosque y Garcia,
2000).

Calle

Uso de suelo

Area Administritiva
Hidrografia
 Elevacion

Imagen

Figura 08. Estructura de capas de informacién en un SIG
Fuente: Esri, 2011.
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El uso de sistemas de informacién geografica (SIG), en particular el analisis de
superficies a través de modelos digitales de elevacion, representa una alternativa
que ha tomado relevancia en estudios de parametros morfométricos por ser util
para analizar caracteristicas de un ambiente geomorfolégico. (Viramontes et al.,
2007). | ‘

Los Sistemas de Informacién Geografica cambian la manera en la que pensamos:
y actuamos, permitiéndonos medir, planear, tomar mejores decisiones, evaluar
y posteriormente tomar accién'para crear un futuro mejor. (Angelides, 2013).

2.2.5.1 PARAMETROS MORFOMETRICOS

Las caracteristicas fisicas de una cuenca de drenaje revisten gran importancia
para la frea‘liz’acién de estudios geomorfolégicos, hidrolégicos ngeoté'cnicos, ya
que influyen en el desarrollo de multiples procesos fluviales y en el riesgo de
inundacién. (Busnelli, 2009). ' ' o

Para el andlisis de los parametros morfométricos los podemos agrupar segin

Ibafiez,S., et al. 2011,en: ' | | : |
A. Descripcién General

Paramétros Generales

Parametros de Forma

Parametros de Relieve

moOoOw

Caracteristicas de la Red de Drenaje

A. DESCRIPCION GENERAL _

Aporta informacién bésica como: ubicacién, rio al que desemboca, coordenada.s
del punto de desfogue_, etc. Para tener una visién general en un contexto mas
amplio de la cuenca en estudio. .

Por ejemplo:

'~ B bamanco de La Falconera se encuentra situado en el término municipal de Javea, |
en lo provincia de Aliconte. Recoge los aguas de la parte mds occidental de la
" ladera sur det macizo del Monigs, conduciéndolas hacla el rio Gorgos a través de su
recomdo. Pertenece por lo tanto o lo cuenca vertiente de! Mar MediterrGneo.

Nombre N° Hoja Punio de Desagise

8ananco Mapa Término Escala
principal 1750.000 | Municipat | Vuelo Ao | Fologramas | Cord. UTM X Cord. UTM Y

1 La
{|Folconera| 822 | Javea { ICV | 2008 | 1/25000 724520 42153200

Figura 09. Modelo de datos para una descripcion general
Fuente: Ibéfiez, et al., 2011. ‘
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B. PARAMETROS GENERALES

Se recogen los aspectos mas basicos de una cuenca hidrografica, como son:

B.1 AREA (A) ‘
En general, se simboliza tanto con la letra A como con la S que coinciden con la
iniciales de las palabras érea y superficie. (Jardi, 1985).

La relacién existente entre el area y la hidrologia de la cuenca es fundamental,
hasta tal punto que los datos proporcionados por una estacién de aforos no
tendran utilidad practica si no se tiene el dato de la superficie drenada hasta
dicha estacién, ni se podra conocer la aportacién de agua en un periodo
determinado de tiempo. (Jardi, 1985).

Esta 4rea se .calcula a través de la representacién a escala, sobre un mapa
topograﬁép de la cuenca. Por tanto, la medida célculada sobré 'un mapa no
coincidira con la medida real, ya que se tratara del area de la proyeccién en el
plano hofizontal de la superficie de la cuenca. Cuanto maybr éea el relieve,
entendiendo por relieve las diferencias de nivel, ma{yor sera el errér cometido en
la medida .de la superficie. (Jardi, 1985).

Distancia real y distancia reducida son dos conceptos a tener en cuenta a la
{ B
hora de afrontar un desnivel; y cuanto mayor sea este mas determinante resulta.

Perfil

|

\ ‘Distancla real sobre ¢
i 4 tetfeno (Ratural)
A — Distancia “reducida” st plano
- - (representada en ia cartogralis)

sascnan:  Digtancia Veitical
{diferencia de aftura)

m———
H

]& sessnsencessssanans

T

- b

Planta fl Al “«—> B

LS P R

Figura 10. Distancia real y distancia reducida
Fuente: Cantabricalia, 2014
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Por lo anterior, es recomendable realizar todos los célculos de aqui en adelante
considerando el relieve, es decir que las mediciones no sean en forma
planimétrica (2D), sino en forma de relieve (3D); esto va depender en gran
medida del tipo de datos a trabajar, asi como de la habilidad del que lo realiza al
procesar la informacién espacial.

Figura 11. Area de una cuenca hidrografica, (a): vista en planta 2D y (b): vista en
_ relieve 3D.
Fuente: Franz, 2011 =

De acuerdo a la magnitud de la superficie, se tienen varias clasificaciones con
respecto al nombre que reciben, como: cuenca, subcuenca, microcuenca o
también como: pequefias, medianas, grandes.

Cuadro 01. Clasificacién de cuencas — varios autores

Autores cuencas Sub-cueqcés Micro-cuencas
Faustino Mayora . |. 100 km*a Menor a
(1996) 700 km? 700 km? | 100 km?
Rocha e Kurtz Mayor a- 200km* |  Menora
(2001) 3.000 km?- a 3.000 km? | 20 km?
Cecilio e Reis Mayor a 0,1 km?
(2006) 200 km? a 200 km?

Fuente: Reich et al, 2011.
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Cuadro 02. Clasificacion de cuencas - Campos Aranda.

Tarhaﬁo de la cﬁenca (Km?) Descripcion
<25 Muy pequefa
- 25a250 Pequefia .
250 a 500 Intermedia - Pequefa
500 a 2500 Intermédia — Grande
2500 a 50000 Grande
>50000 Muy grande

Fuente: Campos, 1998.

Por otra parte, la clasiﬂcécién en orden a su tamafo, a la vez que conocer su
valor nos permitira escoger de antemano la escala. Por lo general, en orden de
magnitud, las escalas que se utilizan, en funcion de la superficie de la cuenca,
se presentan en la cuadré 05; pero dichas escalas al no ser variables aleatorias, ~
dependera de otras variables de la cuenca que nos permitira la escala del mapa
mas idénea seguin sea el tipo de estudio QUe se quiera realizar. (Jardi, 1985).

ps

¢

Cuadro 03. Escalas mas htilizadas en funcién de la superficie de una cuenca. -

Superficie (Km?) Escala
l 1 155,000
100 1:10,000
1,000 1:25,000
5,000 1:50,000
10,000 1:100,000
25,000 1:200,000
50,000 1:500,000
100,000 1:1,000,000

Fuente: Jardi, 1985.
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B.2 PERIMETRO (P)

El perimetro de la cuenca se designa con la letra P, que coincide con la inicial de
la palabra “perimetro”, tanto en castellano como en inglés (perimeter). (Jardi, M.,
1985). | ' |
El perimetro de una cuenca se refiere a la medicién del parteaguas de la
cuenca, expresada en kilometros. Entiéndase por parteaguas de la cuenca a la
linea imaginaria que une los puntos de mayor altitud entre dos rios, y que divide

el flujo de las aguas en direcciones 'opuestas, hacia uno u otro lado (Gutiérrez, et
al. 1986).

=

Figura 12. Linea de parteaguas, cuenca del Rio Sonora-México.
Fuente: Dicym, 2009.

El perimetro.y su forma estan intimamente relacionados con la litologia y edad
de la cuenca de drenaje. Materiales blandos daran formas redondeadas,
mientras que materiaies mas duros daran formas mas quebradas o lobuladas.
lgualmente, ya que la tendencia de las cuencas es la de conseguir formas

redondeadas, a igualdad de litologia, una cuenca redondeada implicara mayor
desarrollo. (Jardi, 1985).

B.3 LONGITUD DE LA CUENCA (L)
La longitud de la cuenca es también llamada longitud axial y se define como la
distancia de una linea recta en proyeccién horizontal que va desde la salida de

la cuenca hasta el parteaguas en su punto mas alejado. Paralela al cauce
principal. (Barboza, 2011).
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Figura 13. Area (A), longitud (L) y perimetro (P) de una cuenca. :

Fuente: Jardi, 1985
‘Modificado por el tesista

Al igUaI que la superficie, este parametro influye enormemente en la generacion
de escorrentia y por ello es determinante para el calculo de la mayoria de los
indices morfométricos. (Ibafez, et al. 2011). '

/s
‘
4
¥

B.4 LONGITUD DEL CAUCE PRINCIPAL (L¢)

Dado due en general el cauce principal no se extiende hasta el limite de la
cuenca, es necesario suponer un trazado desde la cabecera del cauce hasta el
“limite de la cuenca, como ‘se aprecia én la figura 14. La Longitud del Cauce (Lc)
queda definida por la longitud del cauce principal, desde el punto de saAIid_a hasta
su cabecera. (Tutoriales al dia-1.C. 2010-2013). |

" “Este parametro influye en el tiempo de concentracion. (Fuentes, 2004)
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v | ongitud del Cauce (LE)

Figura 14. Longitud del cauce principal (Lc).
Fuente: Tudi, 2010 : -

B.5 ANCHO DE LA CUENCA (W)

EI ancho se define como la relacién entre el area (A) yla Iohgitud (L) de la cuenca
y se designa por la letra W. (Villon, 2002). " - ;

. (1)

Figura 15. Ancho promedio de la cuenca
Fuente: Suérez, 2010
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B.6 DESNIVEL ALTITUDINAL (DA) _
Es el valor de la diferencia entre la cota més alta (Hw) y la cota méas baja (Hm) de

la cuenca, teniendo como referencia el nivel del mar (msnm):

(DA:H"“‘H"'] - e (2)

DA : Desnivel dititudinal (msnm); Hy, : Cota Méximd (msnm); H,, : Cota Minima (msmnm)

REGIONES  msom } ZONAS AGROECOLOGICAS

3%0 ZAdelos
«| ALTA pastos
b 3600 naturales
)
<
S BAadA ZA de
3300 tuberosas y
aita 3200 cersales
ALTA baja
3000
< aita
= 2800 ,
o
w
D N
G IBAA F ZA de maiz
baja ’
2000
ZA de raices
YUNGA _ }’ y frutales
1900

Figura 16. Zonas agroecolégicas en una cuenca altoandina, Cajamarca.
Fuente: Grillo, et al. 1988

Se relaciona con la variabilidad climatica y eé_olégica buesto que una cuenca con
mayor cantidad de pisos altitudinales ':puede albergar mas ecosistemas al
presentarse variaciones importantes en su precipitacion y temperatura. (Ibafez,
S., etal. 2011). o

C. PARAMETROS DE FORMA

La forma de la cuenca definitivamente afecta las caracteristicas de la descarga
de la corriente, principalmente en los eventos de flujo maximo. (Campos, 1998).

C.1 FACTOR DE FORMA (RF)
La forma de la cuenca es la configuracién geométrica de la cuenca tal como esta

proyectada sobre el plano horizontal, por lo que para una misma superficie y una
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misma tormenta, el factor mencionado se comporta de forma diferente entre una
cuenca de forma redondeada y una alargada. (Apaclla, R. 2010). _
Factor definido por Horton y se expresa como la relacién entre el ancho promedio

de la cuenca y la longitud del rio. (L6pez, F. 1998).

Tenemos: . (3

Reemplazando (1) en (3): . (4

RF + factor de forma de Horton; W : Ancho promedio (km) ; L, : Longitud axial (km)

L

1111'

- 10Kn - ! S R e -
ar= 187102 0,15 = 15/5=04

Figura 17. Vanacaén del factor de forma con la geometria de la cuenca
Fuente: Musy, 2001

El valor méximo que se pude obtener del factor de forma cuando éste (RF) tiende
a 1, es 0,7854 para una cuenca completamente circular y, a medida que la
cuenca se hace mas alargada, el valor tiende a cero. (Londofio, 2011).

- -4
Cuadro 04. Forma de la cuenca en funcién al factor de forma.

" ) - FORMA DE LA
FACTOR DE FORMA
. CUENCA
RF = 14 Redondeada
RF =0 Alargada

Fuente: Villon, 2002.

Una forma u otra en una cuenca de drenaje apenas tendra ‘importancia en su
comportamiento hidrolégico, pero, sin duda, nos indicara relieves altos y Iitollogia
dura, caracteristica, éstas que si tienen importancia en el funcionamiento
hidrolégico. (Firco, 2005).
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C.2 COEFICIENTE DE COMPACIDAD (KC)

Para explicar el Kc de una cuenca, se ha propuesto su comparacién con una
cuenca ideal de forma circular (Kc=1), con sus tributarios dispuestos radialmente

| y que desembocan en el punto central. (L6pez, 1998). |

El Kc es adimensional y permite relacionar el perimetro de la cuenca con el

perimetro de un circulo de area equivalenté al de la cuenca. (Gaspari, 2002).
P

. Ke= Ser .
Tenemos la relacion: id . (5

A=mr? - r= |-

Despejandor : - (6)

Fcc = 0;282;% }
_Reemplazando (6) en (5): : . e (D)

K¢ : Coheficiente de compacidad de Cravelius; P:Perimetro (kim); A = Area (km?)

En este valor adimensional, los valores de Kc nunca serari inferiores a 1. El grado
de aproximacién de este indice a la unidad indicara la tendencia a concentrar
fuerte volumenes de aguas de escurrimiento, siendo mas acentuado cuando mas
cercano sea a la unidad, (lo cual quiere d%cir que entre mas bajo sea Kc mayor
serd la concentracién de agua. (UNAL, 1997).

El tiempo de concentracién, es el tiempo que tarda una gota de lluvia en moverse
desde la‘parte més lejana de la cuenca hasta la salida. (Gaspari, et al. 2002).

K=16 K=13 K~=12 Ke=1,1

Figura 18. Valores de Kc para diferentes formas de cuencas.
Fuente: Musy, 2001

A medida que su Kc tiende a 1, es decir cuando tiende a ser redonda, la
peligrosidad de la cuenca a las crecidas es mayor, porque las distancias relativas

de los puntos de la divisoria con respecto a uno central, no presenta diferencias
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mayores y el tiempo de concentracion se hace menor, por lo tanto mayor sera la
posibilidad de que las ondas de crecidas sean continuas. (Gaspari, et al. 2002).

Cuadro 05. Indice de Gravelius para la evaluacion de la forma.

| ' TENDENCIA A
CLASE RANGO _ DESCRIPCION CRECIDA

Key 1.0021.25 Forma casi redonda a oval - |

redonda Alta
_ . forma oval - redonda a oval .
Kc2 1.25a1.50 - alargada Media
Ke3 1502175 | Forma oval - alargada a Baja

alargada

Fuente: Ortiz, 2004.

c3 ‘RECTANGULO EQUIVALENTE

Se supone que el flujo a través de una cuenca dada es aproximadamente la
misma en igualdad de condiciones climéticas, como un rectangulo del mismo
tamafio, con el mismo coeficiente Gravelius y distribucién uniforme hipsométrica,
siempre que la distribucién de los suelos, la vegetacion y densidad de drenaje
se respeten en diferentes 4reas entre las curvas de nivel. (Roche, 1963).

Lo cual se resume en: El rectangulo equivalente de una cuenca es un rectangulo
que tiene igual superficie, perimetro, coeficiente de compacidad y distribuciéon

- /
hipsométrica que la cuenca en cuestion.

Para fa formula, se tiene:

Perimetro de un nacténgulé: P=2(L+1 ' e (9
.~ KcvVA
Despejando P de ec. (7): elsthih et

j ( P 5383 ... (10)
Igualando (9) y (10): 2L+ = ':;g e (11)

P = Perimetro (km); A = Area de la cuenca (km?); Kc : Coheficiente de compacidad G.
L = lado mayor del rectingulo; ! = lado menor del rectangulo;
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Despejando L y 1 de (11):

r

Lado Mayor: i=
L v (12)

=

Lado Menor: =
- (13

Ke : Cokeficiente de compacidad de Graveltus; A = Areadela cuenca (km?)
Nota: Para que esta representacioén sea pos:ble es necesario que el coeficiente de

compacidad Kc¢ sea mayor o igual que 1.12

La caracteristica mas importante del rectangulo equivalente es que tiene igual
distribucion de alturas, que ta curva hipsométrica de la cuenca. (Londofio, 2011).

EEgS & & L . x 2
¥Eeg 88 & 5 § g
2= 087 Ran| ] |
i 6 % s 15 s |
/ RIS Sy LTS 2 S —— -1

Figura 19. Ejemplo de un rectdngulo equivalente de una cuenca
Fuente: Londofio, 2001

Las distancias sobre el lado mayor a las cuales se localizan las curvas de nivel

(rectas), se obtienen dividiendo las éreas de la cuenca acumulada sobre cada

una de ellas, entre el lado menor (l). (Campos, 1998).

Aacs = Area acum.sobre la superficie kim?; A = Area de la cuenca km?; L = Lado mayor km
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Figura 20. Relacion de area de la cuenca son su rectangulo equivalente
Fuente: Verau, 2014

El rectangulo equivalente, ademas de facilitar la comparacién geométrica de las
cuencas, pemite ver la influencia de sus caracteristicas sobre la escorfentia.
{Londofio, 2011). _ ’
D.%’ARAMETRO'_S DE RELIEVE - _

Son de gran importancia puesto que el relieve de una cuenca tiene mas
influencia sobre Ié respuesta hidrolégica que su forma; con carécter geheral
pogemos decir que a mayor relieve o pendiente la generac_ién de escorrentia:.jse
produce en lapsos de tiempo menores. (Ibafiez, et al. 2011).

D.1 PENDIENTE MEDIA DE LA CUENCA (Sm) .
Es uno de los principales parametros que caracteriza el relieve de la misma y
permite hacer comparaciones entre cuencas. (Guilarte, 1978). '

Mayor
pendiente

Maior
pendiente

§IAN

Figura 21. Respuesta de una cuenca por pendiente

Fuente: Suarez, 2010
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La influencia del relieve sobre el hidrograma es ain mas evidente. A una mayor
pendiente correspondera una menor duracién de concentracion de las aguas de
escorrentia en la red de drenaje y afluentes al curso principal. (Suarez, 2010).

Tiene una relacién importante y compleja con la infiltracién, la escorrentia
superficial, la humedad del suelo y la contribucién del agua subterranea a la
escorrentia. La pendiente es uno de los factores que controla el tiempo de
escurrimiento y concentracion de la lluvia en los canales de drenaje y tiene una
importancia directa en relacién a la magnitud de las crecidas. (Villon, 2004).

De lo anterior podemos deducir que éste parametro puede ser muy Gtil en
un analisis inicial para deducir las zonas donde pueden haber cauces con
mayor pendiente y de ésta manera aprovecharlos en sistemas
hidroeléctricos.

Pendiente media de una cuenca con ArcGIS: -
ST

2@ cwa

]
Paso 1. Tener el MDE de la cuenca. | e e

Value |
High: 2038 1}

Pas‘o 2. A partir del MDE obtenemos el

mapa de pendientes, para &llo damos clic
en la herramienta Spatial Analyst seguido
de Surface Analysis y finalmente Siope. Distance

Interpolate to Raster »

Paso 3. En la ventana que aparéce Cell Spatistics...

. Neighborhood Statistics...

< Vﬁ_::.z‘_.'_r"_ .
N B N

seleccionamos el Raster al cual

queremos  hacerle el
contorno, en nuestro caso |
es “dtm_estudio”, y lo ;‘
demés por defecto.
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£ tayens

0 B cvence
Paso 4. Obtenemos como o

(212 Pendiente
resultado: O - 2460942287

I 2450942288 - 6,767591289
W 6,726759129 - 11,68947586
[ 1168947587 - 1661135084
73661136045 - 21,53324501
£30.53324502 - 2636274732
26,76274738 - 3291510309
1329151031 - 41,22078331
1 41,22078332 - 73 4425354

he] feiudiol

Paso 5. Como se explicé en el articulo

Funciones Zonales en ArcGis, nos

vamos a: Sptial Analyst Tool, seguido

de: Zonal Statistics as table. || vaveraster:

Cargamos el raster al cual le vamos a || F 1onre NoData in caladations

aplicar la estadistica zonal. En este | T 3 oueu tableto zone layer

caso de trate de “pendiente”. - I Chartstatistic:  [Mean 7 =]
Output table: [1e v cuencaEstadstica.cof

Paso 6. ‘
e
Obtenemos la y @5
- L@
tabla con los [+®
i Q
resultados. Nos : 52
. t®
interesa la : . 2
. . [ ]
pendiente media : ;2
|e®

de Jla cuenca

R4 |

que es el

T0ISH0B| 01572147 | 57 3147]1 11,8098(1 881764

parametro que

necesitamos.

Show: [Tl' Sected

Fuente: AGUA Y SIG, 2012

26



Cuadro 06. Clasificacion del relieve de una cuenca de acuerdo a su pendiente.

RANGOS DE PENDIENTE (%) DESCRIPCION
00-4 Nula o casi a nivel
4-8 Ligeramente inclinada
8-15 Ligeramente inclina@a a
_ - moderadamente empinada
16-25 Moderadamente empinada
25-50 Empinada
50 - 75 Muy empinada

> 75 Extremadamente empinada

Fuente: ZEE-OT. 2010.

Existen diversos criterios para evaluar la pendiente de una cuenca, si se lo
trabaja con un SIG es mucho més rapido que realizandolo manualmente, siendo
éste Gltimo mucho més tedioso, laborioso y requerir mucho tiempo.

Cuadro 07. R/Iétodoé manuales para la determinacion de la pendiente media de

una cuenca hidrografica.

| M&ToDO |

" GRAFICA REPRESENTATIVA

DESCRIPCION

Criterio de  »
ALVORD |

{ Analiza la

;deﬁnida por las

curvas de nivel

| existente entre curvas de
nivel, trabajando con la fgja |
lineas |

pendiente

' medias que pasan entre las |
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V; B
s + I Consiste en trazar una malla |
LA de cuadrados sobre .la|
! Criterio de t_ o proyeccion planimétrica de
{ HORTON G‘__ la cuenca orientandola
' {] . LAL/LK segin la direccion de la
i} cdones y Qnpenchis
| 8 R B A . corriente principal. ]
! |
_ Mif‘ﬁ"- EREENE Similar al criterio de Horton, |
’; : Hoof s '("Y.\“"\'W \ |se traza una cuadricula enel |
| ‘ @ \ S |sentido det ‘cauce principal |
{ Criterio de | < poaur=NNi , ad
' & = que debe cumplir fa]
NASH Lk g
T | // condicién de tener aprox.
T B S 1100 intersecciones ubicadas {
- L ‘ © T ¥ " "+ j|dentro de lacuenca. '

Fuente: Glem, 2011.

. t
D.2 PENDIENTE DEL CAUCE PRINCIPAL (Sc)
Este parametro es definido como la corriente de mayor longitud dentro de la
cuenca; medida desde su inicio, tomando en cuenta {a altura maxima hasta {a

finalizacién del cauce, osea la altura minima. (Viram.ontes. etal. 2012).
825

820 + — 35 £
Pendienfs Media ( pA
/

Eus — 5 i
Pendiente Media L [} \/ /
"0 Porderada =
X( L&‘\’ /
eos Sy
<S> >V ,
goo o7 - /K‘Porﬂdclcrrauco

>

795(‘ = — T R - T = L =
o+ooo 14000 24000 34000 44000 54000
Progresiva (m)

Figura 22. Pendiente media y media ponderada de! cauce principal
Fuente: Tudi. 2012 '
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El perfil del cauce,es simplemente el gréfico de altura en funcién de la longitud
a lo largo del rio principal. Con ésta base podemos inferir la variacién del caudal
con respecto al tiempo, generalmente cuencas con pendientes ‘altas en el cauce
principal tienden a tener hidrogramas mas picudas y mas cortas que cuencas
con pendientes menores. También los perfiles se usan para estudios de:
prefactibilidad de proyectos hidroeléctricos, producéién de sedimentos, ubicacién
de posibles sitios susceptibles de avalanchas, etc. (Web del profesor, 2012).

h N h|

Figura 23. Variacién de hidrogramas en funcioén de la pendiente del cauce.
Fuente: Mendoza, 2012 4

Para el célculo del factor: pendiente del cauce principal, podemos emplear
algunos métodos como:

1er Método: La pendiente de un tramo de rio es la'relacién que existe entre los
extremos inicial y final y la distancia horizontal de dicho tramo.(Brefia y Jacobo,
2006).
_ Hmax — Hmin
1e .
Hmix : Cota mixima (mzwm); #¥min: Cota mimimea (msnm);
ic = Longitud del cance principal (km)

2do Método: Dividir el desnivel del cauce entre sus puntos a 10% y 85% de su
longitud total, de tal manera que el 15% del tramo del rio con fuerte pendiente y
el 10% de su parte plana, son excluidos. (Campos, 1998).

3er Método: Hallar la pendiente media ponderada, que es un valor mas
“razonable” para representar la pendiente media del cauce principal. Para
calcularlo se traza una linea, en el perfil longitudinal del cauce, tal que el area
comprendida entre esa linea y los ejes coordenadgjs sea igual a la comprendida
entre el perfil y dichos ejes, ver figura 22. (Tutoriales al dia, 2013).
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b1+ H2) - (14)

AT =

AT : T de areas parciates entre cada progresiva (m); b: valoer miximo de la progresibd (m);
M1 = valer cota mimtma (msnm); H2 = valor de altura a calcular (msam)

De aqui se obtiene el valor de elevacién que define la linea asociada a la
Pendiente Media Ponderada del Cauce Principal:

Pemienle Media

E
,Sﬁa

Figura 24. Valor de altura para hallar la pendiente media ponderada
Fuente: Tudi. 2012 '

4to Método: Se propone calcular la pendiente media como la de un canal de
seccién transversal uniforme que tenga una Iongitud y tiempo de recorrido
equivalentes a la del cauce. Para eéto se divide el perfil del cauce en tramos
iguales. (Taylor y Schwarz, 1952). -

Sec = :
- + .+ 1

b 53 3 .\7 ml
1: nimero de segmentos iguales en los que se divide el cauce principal;

S:Pendiente media del cauice(%); $1: Pendiente en el tramo { del cenice (%);
i

... (15)

Elevacion, msnen

Distancia, en Km

Figura 25. Divisién del cauce principal en tramos iguales
Fuente: Pérez y Rodriguez, 2009.
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Sto Método: Empleando software SIG, para lo cual se necesita un raster (mapa
de pendientes), y un vector (shapefile de la red hidrica). Para el calculo de la
pendiente media es necesario interpolar la red hidrica con el mapa de
pendientes. (Blog. Agua y SIG, 2013).

Paso 1. Vamos a 3D Analyst, seguido [= tepotste shape D
de Functional Surface e Interpolate Input Surface

[cmoE >l
Shape. Ingresamos -las alturas || woutresnwe ctoss , '
(C_MDE) y el archivo que contiene el | mm:m =

cauce principal ( LongestFlowPath). D:\FLRSO D€ HIOROLOGIA Védlogia 0 8 pasoCauce erpo

Paso 3. En el campo layer debe ®uee!ueRCiti A%as 3887005 .
— By bl Gogh
estar seleccionado e! archivo de 1% Pot e
[ AR S

donde vamos a sacar las alturas
(TIN- o MDE), luego la opcién
“Profile Graph”. :

Paso 4. Realizamos una consulta ' R —

. # Zonal Statistics as Table
zonal yendo a Hydrology, seguido -
Lo + 11 snoutraster or feature 20ne data
de Zonal y Zonal statistic as table. || [caxemepondo e |l
H “ H " ! Zone field ] }
Indicamos “cauce interpolado” y el HydrolD < |l
Irout vakue raster ' |
raster al cual queremos hacer la || ‘[Cwx = 7] |
- Oulput table -

consulta (en este caso C_MDE).

O DEHIDROLOGIA Wdrologia paso  pasoleturas cauce_princie |

El resultado es la siguiente tabia, [Tame =]
donde podemos ver que fa altura || +!/®B-1TW 0 < x ‘
alturas_ incipe! x|p

minima es igual a 28 msnm y la _m;::';;:m_ o} |
o i ‘ ’ 1 11029 [oeor1re] 28[1es7 [ |§
maxima es 1687 msnm. Luego la |[I. C v . 1R
pendiente media del cauce seria: " 10w |
s = (1687-28)/33560 = 4.94 m/m. O out of 1 Selected)
| atturas_cauce_principa! |

Fuente: Agua y SIG, 2013.
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D.3 CURVA HIPSOMETRICA (Ch)

La curva hipsométrica es la representacion grafica de la variacion altitudinal de
una cuenca en funciéon de la superficie dominante. (Villon, 2002) .
No es otra cosa que una curva acumulada que parte de la elevacién minima del
terreno localizada en la descarga o salida de la cuenca hidrolégica de anélisis
(Remenieras, 1974) '

Curva Hipsometrica

6670.00 f\
6270.00
$870.00 . e
X
5470.00 |- \
5070.00
467000 |- D, -
427000 - —
: 8 -
3870.00 ——

347000 | e .
3070.00 | [P,

A £y g
267000 | \:\3
2270.00 >

=

0.00% 10.00% 20.00% 30.00% 40.00% 50.00% 60.00% 70.00% 80.00% 90.00%100.00%
’ Area(%)

Cota (fh.s.n.m.)

Figura 26. Curva Hipsométrica Subcuenca rio Andamayo.
Fuente: Marit, 2012,

La curva hipsométrica, permite conocer la distribucién de masa en la cuenca
desde arriba hacia abajo. Se obtitne colocando en las ordenadas los valores
correspondientes a las diferentes alturas de la cuenca y, en las abscisas, los
valores acumulados de las areas expresadas en porcentaje. (Strahler, 1952)

De esta forima se utilizan valores relativos (porcentuales), o que hace posible
comparar curvas de diferentes cuencas, prescindiendo de las dimensiones
absolutas. Normalmente su forma es sigmoidal, céncava hacia arriba en la parte
superior y convexa en la parte baja; el grado de sinuosidad es muy variable, lo
mismo quebla pendiente en el punto de inflexion. (Strahler, 1952) )

Cuando las curvas hipsométricas presentan variaciones, ya sea por apartarse de
las teéricas o por presentar mas de un punto de inflexién, ello puede relacionarse
con controles tecténicos o litolégicos. (Racca, 2007)
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Consta de tres etapas:

1.- ETAPA DE DESEQUILIBRIO

= Zona donde predomina la produccion de sedimentos y aguas (rios jévenes).
~ ® La cuenca refleja un gran potencial erosivo (fase de juventud).
. & Cuenca geolégicamente joven (cuenca de montafia).

2.- ETAPA DE EQUILIBRIO
#  Zona donde predomina el transporte de etapas 1 y 3 (rios maduros).
# Es una cuenca en equilibrio (fase de madurez).

s Cuenca geolégicamente madura (cuenca de transicién)

- 3.- CUENCA EROSIONADA _

' ® Zona caracterizada por la deposicién de sedimentos (rios en etapé de vejez).
* Es una cuenca sedimentaria (fase de vejez).

.. Cuenéa g_eolégicamente en forma de valle o planicie.

(Llaﬁas. 1993 y Cambos, 1998).

Montafa . Teansicién  Planicle

Oistancia

Hey)

1
AG) "

Figura 27. Etapas de una cuenca en funcion a su curva Hipsométrica
Fuente: Pidsi, 2013.

Alternativamente, se aplica el uso de la grafica de curva hipsométrica para la
obtencion de la ELEVACION MEDIA de la cuenca, la cual equivale a la cota
correspondiente al 50% del area de la cuenca.
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Curva hipsométrica de la cuenca con ArcGIS:

Paso 1.- Clasificamos el raster de alturas
(MDE). Vamos a Spatial Analyst Tools, |
seguido de Raclass y luego Reclassify.

4 Reclassify

Input raster
jc_MDE
Redass field
[VALLE ©
Redassification

Old values ) New values -

166 - 306

26- 166 C
1 :

306 - 446

Paso 2.- Ahora vamos a Classify, en el
campo Method seleccionamos Equal |
Interval y en Classes colocamos 20.

Paso 3.- aplicamos una estadistica |

frput raster or feature zone data

zonal a través de Spatial Analyst || [ciredssy =] ‘

2one kg _
Tools, seguido de Zonal y por ultimo e rastr v
Zonal Statistics as Table. Eﬁ; 16

O-VCURS0 D€ HIDROLOGIAYAdrooga paso 8 pasowres-entearvas |

O

- - o Table | o - ¥ = .
Paso 4.- El procedimiento crea unatabla DBF, |1 - 1
: HERMA B LR
-éstos resultados los podemos llevar a Excel y ||aeiectrecives =~ |
realizar los graficos respectivos. e [y, i L
2] 51000 | 47624141 11| 194
- . 3] 48772| 1752633 195} 27¢
, . . : 511 | w6l
Paso 5.- Altura con mayor frecuencia = 68y el | . 6] 6930 65168211 447] s30
; T §3_90_ 59659721 531] 614
promedio de alturas = 866.48 m. Con los | BB ST ST o) S
- . o ] 1 1 4313 ] 40267981 783) 866 |
campos “altura Promedio” y “Area acumulada : 1] st7s] 2967914 671 950
. i 12 12| 2834 2645941] 95111034
entre curvas %" podemos realizar la curva 7Y T KT SR
° 1 15 15751 1470496 § 1203 | 1286 |
i i 6 4451 1350046 | 1287 | 1370
hipsomeétrica de la cuenca. T AT R R T
18 18] 2291 2138974 | 1455 | 1538 |
- 19 19 1647 | 1724437 | 1539 | 1622 |
Curva hipsefmétrica da fi cuenca 20 20 493 ] 460285.5[ 1623 [ 1706 |
o I P wo ]
1600 "’ -
14m “ =
1200 =%
g0
< o .5
600 2y
400 .4 g ry
200 *. ¥
0 >
0% 20% 40% 0% $0% 100%
Arca scurritada (%)

Fuente: Agua y SIG, 2013.
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D.4 HISTOGRAMA DE FRECUENCIAS ALTIMETRICAS

El andlisis de frecuencia altimétrica se utiliza para describir, en altitudes
sucesivas, las frecuencias de ciertos niveles, como ser altitud de sitios, puntos
mas altos en mallas cuadradas de muestreo, altitudes de cumbres o la de areas

de llanos o depresiones tales como hombreras, bancos y collados. (Clarke, 1968).

Es la representacion de la superficie, en km? o en porcentaje, comprendida entre
dos cotas, siendo la marca de clase el promedio de las alturas (Figura 28).

La representacion de varios niveles da lugar al histograma, que puede ser
obtenido de los mismos datos de la curva hipsométrica. Realmente la curva
hipsométrica y el histograma contienen la misma informacién pero con una
representacion diferente, dando una idea probabilistica de la variacién de la
altura en la cuenca. (lbafiez, et al. 2011).

030 +
025 +
0.20

T

Ll

0.15 1
0.10

Porcentaje del Intervalo

0.05 + ’ ' ;
0.00

1000-  1500- 1600  1700-  1800-  1900-
1500 1600 1700 1800 1900 2000

Intervalo de Alturas

Figura 28. Histograma de frecuencias altimétricas.
Fuente: Ibafiez, et al. 20011

D.5 ALTURA MEDIA (H)

La altura o elevacién media de la cuenca tiene importancia principalmente en
zonas montafiosas, pues nos da una idea de la climatologia de la regién,
basandonos en un patrén general climatico de la zona. La elevacién promedio
esta referida al nivel del mar. La elevacién media de la cuenca se obtiene a partir

de la curva hipsométrica, que equivale a la cota correspondiente al 50% del area
de ia cuenca. (Apadiia, 2010).
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Figura 29. Altura media en la curva hipsométrica.
Fuente: Glem, 2011."

Las variaciones de altitud en el interior de la cuenca, asi como su altitud media,
son datos esenciales para el estudio de la temperatura y la precipitacién. En este
sentido, las diferencias de temperatura, como consecuencia de la altitud,
tienen un efecto importénte en las pérdidas de agua por evaporacion.
(Llamas, 1993). | | i ‘

ALTITUD 1°c

Figura 30. Variacién de la temperatura con la altitud.
Fuente: Glem, 2011.:

En la capa més inferior, 1a troposfera (hasta los 12,000 m de altitud), el gradiente
térmico estandar es de -6,5 grados por cada 1000m. Dicho valor equivale a un
descenso de temperatura de un grado por cada 154 m de altura. Este gradiente
térmico determina la estructura y concepto de los pisos térmicos. En la practica
el gradiente térmico varia localmente seglin la zona geotérmica y segun sea la
orientacion de las laderas o vertientes. (Wikipedia, 2014).
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E. CARACTERISTICAS DE LA RED DE DRENAJE

Se llama red de drenaje de una cuenca, al sistema de cauces por el que fluyen
los escurrimientos superficiales, subsuperficiales y subterraneos, de
manera temporal o permanente. Su importancia se manifiesta por sus efectos
en la formacién y rapidez de drenado de los escurrimientos normales o
extraordinarios, ademas de proporcionar indicios sobre las condiciones fisicas
del suelo del suelo y de la superficie de la cuenca. (Campos, A. 1998).

TIPOS DE CORRIENTES

Las corrientes cominmente se clasifican en tres tipos (como se muestra el
cuadro N°10): permanentes, intermitentes y efimeras, en base a la constancia
de su escurrimiento o flujo, el cual est4 relacionado con las caracteristicas fisicas
y climaticas de la cuenca. (Campos, A. 1998).

Cuadro 08. Clasificacién de las corrientes de una cuenca.

TIPO DE -
' DESCRIPCION
CORRIENTE

Per'rha?hentes Conducen agua todo el tiempo.’

Lleva agua la mayor parte del tiempo,

Intermitentes. e L
pero principalmente en épocas de lluvia.

/

Solo conduce agua durante las lluvias o
Efimeras

inmediatamente después de éstas.

Fuente: Campos, 1998.

PATRONES DE DRENAJE _
Los patrones de drenaje son configuraciones en las redes hidricas que presentan
ciertos arreglos geométricos o irregulares, que permiten relacionar con sus

propiedades hidrolégicas o geohidrolégicas (superficial o subterraneo). (Londofio,
2011).
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F.1 ORDEN DE LA RED HIiDRICA
El orden de corrientes es una clasificacion que refleja el grado de ramificacion
o bifurcacién dentro de una cuenca. (Campos, 1998).

La jerarquizaciéon permite tener un mejor conocimiento de la complejidad y
desarrollo del sistema de drenaje de la cuenca. E! orden se relaciona con el
caudal relativo del segmento de un canal. (Ibafiez, et al. 2011).

Hay varios sistemas de jerarquizacién, como se muestra el siguiente cuadro:

Cuadro 9. Algunos Modelos de Orden de Drenaje.

MODELO
ORDEN DE GRAFICO ' DESCRIPCION
DRENAJE .
Los canales van numerados en funcion
del nimero de afluentes que tengan, de
L forma que aquel que fluye desde el
HORTON ma que aquel: que fluye

- origen y no.tiene ningun afluente es de

(1945) . '

) orden 1, mientras que uno de orden 2
recibe dos afluentes, ... El orden de los
canales va aumentando de uno en uno.

¢ Es muy parecido a Horton, con la |
] e .
diferencia de que un mismo canal puede
tener segmentos de distinto orden a lo
STRAHLER _
largo de su curso. El orden no se
(1964) _ :
incrementa cuando a un segmento de
o un determinado orden confluye uno de
A.N. Strahler .
orden-menor.
{©)
Define la magnitud de un canal como el
SHREVE nimero de afluentes que confluyen en
(1966) él.
R. L. Shreve
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~ MODELO
ORDEN DE
DRENAJE

SCHEI_
DEGGER
(1968)

GRAFICO

A. E. Scheidegger

DESCRIPCION

Solo asigna nUmero pares
cuestiones algebraicas.

por

Fuente: Gregory & Walling, 1973

Horton, introdujo la idea de ia ordenacién de los canales, que mas tarde seria

mejorada y ligeramente modificada por Strahler, adquiriendo la forma actual que
es un estandar y se le conoce como: ordenacién de Horton-Strahler.

Fuente: Ocites, 2009

Figuré 31. Clasiﬁ/qacién de Orden Horton-Strahler

La ordenacién Horton-Strahler, se trata de un sistema de jerarquizacién que

subdivide los distintos cursos de agua que integran la red de drenaje superficial

en segmentos de cauce clasificados en funcién del orden de magnitud de los

mismos, para lo cual se debe seguir los siguientes pasos:

i. se asigna el orden 1 a las corrientes que no presentan ningun tributario,

comunmente en las cabeceras de la red de drenaje.

ii. Al juntarse dos corrientes de orden “n” da lugar a una corriente de orden

“n+1”,
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ii. Cuando se juntan corrientes de diferentes érdenes, la corriente resultante
tomara el valor de mayor orden. '

Corrientes de mayor orden en la jerarquia de Horton-Strahler corresponderéan a
una red mas densa y comunicada y por ende a cuencas de menor tiempo de
respuesta hidrolégica.

En la clasificacién Horton-Strahler, no existe ningiin pardmetro que defina el
orden de una cuenca, por lo que el orden maximo del cauce principal
definira el orden de la cuenca. (RSI, 1999).

Orden de la red hidrica de una cuenca con ArcGIS: |

Paso 1. Nos vamos a ArcToolbox seguido de Spatial Analyst Tools y finalmente
Map Algebra. En la ventana que aparece, escribimos la siguiente expresién
Log10("C_Flow_acc"). ‘ ” 1og10('C_Flow_s¢cc)

Paso 2. Al archivo re:sultahte (Red_'ljog) le | I Con(Red_tog® >« 2, Red_109")
aplicamos la siguiente condicional: |

. Con("Red_Jog" o= 2, nRed“Iogv. ‘ 'S Stream Link - ‘ ‘ lﬂm ‘
. oo |l routstresmaster .l
. { [Redh_con a2}

Paso 3. Vamos a Hydrology, luego en || @rma——— 12K

Stream Link, indicamos la red hidrica | mmqmwMamw_m '@ . |

(Redh_con), la direccién de flujo (C- |

) Coat ) (e (5o ||

flow,_dir). ) = = —
. . [ 4, sweam Crder o ’ . l=le eSS “

Paso 4. Vamos a Hydrology, luego en || retsencuss |
, [Redsegm =1 {

Stream Order. Indicamos la red de || ieutfowdrectinnste |
rC;ﬂuw_dir =] it

flujio segmentada (Red_segm), ‘el || ovputraster -
! I {Red_segm) || onouso oEtoRGLGGKPadroga pemo s posoeed_erden | [E5)
raster de direccién de flujo y elegimos || *ethedolstrean orderig foptona)

como método STRAHLER.

o -
.
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Paso 5. Vamos a Hj/drology, luego en (=, swomtorese el )

Input sream raster “1
Stream Feature, en la ventana que [t =g |
. . Input flow direction raster
aparece indicamos el raster que [ rowdr ci=)
Output pohyline featires

contiene el orden de la red de flujo 0 RS0 € HIROLOGH kg o s pcsied i [E5)

(Red_orden), el raster de direccién de L Swmoity polnes foption)

flujo (C_flow_dir). | o) ) (o) ||
5 o EEIT

| yg}@ T AR
Finalmente  tenemos ot otherva \; 4} e

como resultado las ‘—1m'c°m§ ~¢4ﬂ§& R
. | L. Sy

B < Layers
A Salida_cuenca

—I

ordenes de la red —: .
hidrica.. ::
@ O Cuenca jntep
[ cuenca_shp
0 C.tin
O Red_orden
B O Red_segm 1]
B I l Redh con

Fuente: Aéua y SiG, 2013 -

\4\‘\

F.2 DENSIDAD DE LA RED DE DRENAJE (Dd)

La densidad de drenaje (Horton, 1945) es otra propiedad fundamental de una
cuenca, que controla la eficiencia del drenaje (Jones, 1997) y sefiala el estado
erosivo (Senciales, 1999).

Horton (1945), deﬁnié-la densidad de drenaje de una cuenca como el cocienté
entre la longitud total"de los cauces (perennes, intermitentes y efimeros) que
conforman el sistema fluvial de la cuenca, y el area total de la cuenca.

... (16)

Dd: Densidad de drenaje (km/km?);
Li: £ longitud de los cauces (km); A:Area de la cuenca (km?)

Debiéndose interpretar el resultado como el nimero de cauces existentes
por Km2
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Figura 32. Red de drenaje en funcién de magnitud de orden.
Fuente: Siatl, 2011,

La densidad de drenaje expresa las caracteristicas geo-ecolégicas del
territorio de la cuenca. Los factores que controlan la densidad de drenaje son:

- Litologia de! Sustrato.
- Permeabilidad del suelo y capacidad de infiltragion.

- Cobertura vegetal y tipo de la misma.

“Los materiales geol6gicos duros y résistentgs tales como el granito, gneiss,
arenisca y cuarcitas, tienden a originar BAJAS DENSIDADES de drenaje. Esto
es debido a que la erosion fluvial es dificil (...) En materiales blandos, tales como
Margas y arcillas, las cuencas por pequefias que sean, pueden suministrar la
escorrentia suficiente como para erosionar el cauce (...) Los materiales muy
permeables, como las arenas o las gravas tienden a originar altas densidades
de drenaje, dado que la infiltracion es grande (...) Una roca débil producira mucha
menos densidad de drenaje en un clima humedo, donde una espesa cobertura
vegetal protege el material subyacente que en una regién arida, donde no existe
dicha cobertura”. (Strahler, 1964).
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Cuadro 10. Clasificacién de cuencas por su densidad de drenaje.

VALOR Dd , TIPO DE
DESCRIPCION CARACTERISTICA
(km/km?) ROCA
- ) gneiss,
, Regularmente Altamente resistentes .
0.1-18 ' ) arenisca y
drenada a la erosion .
. cuarcitas
~ Poco resistente ala Margas y
19-36 Normaimente drenda . ]
erosion arcillas
Cuencas bien Facilmente
3.7-56 , . Arenas, gravas
drenadas erosionable

Fuente: Fuentes, 2004 y Suarez, 2010.

Densidad de drenaje con de una cuenca con ArcGIS:

Table

R R @{)’J@ {jpc

IEIERECEEER

Paso 1. Calculamos la longitud de toda

la red de flujo. Para ello vamos a la
tabla de atributos y agregamos un

campo al que llamaremos Longitud.

Paso2. Luego damos clic derecho sobre el
campo agregado y seleccionamos la opcién
Calculate Geometry. -

Paso3. Ahora dando clic sobre el campo
GRID CODE, hacemos una consulta

seleccionando la opcibn Summarize.

Paso 4. En la ventana que aparece, en

Longitud seleccionamos la opcién Sum y |
guardamos el archivo de salida como: | j

Longitud_total_red_hidrica.
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Add field o m&m —

[ionced ) v

. 10
[Dublr e e e .j ] 17
H—a

T |m o = s

) (

© Sort Ascending
Sort Descending
Advanced Sorting... |

"F

: Statistics...
Field Cateulator... ‘I
PN Caleulate Geometry.. 1}
Tum Field Off

™

11}

Coooe L soon anne Lxo uone 1
f. SortAscending 0.151242
g . . . 0.508446
F  SortDescending 0390254

Advanced Sorting... 0.236581

e e [ 0.156485
I Summarize... Il 0.653873

, — 0.483091
z Shtlmcsr.ri. 040803

s
- 2. Chooss one or more sunmary datistics 1o be included inthe
L outputtable:

@ GRID_CODE -
@ FROM_HODE
® TO_NOOE
e Era]




Table | ’ »

Paso 5. Clic en OK y

obtenemos una tabla con la | |
j i 2 1 %i
informacién. 1 2 253 101040202 | [§
2 1k 149 53.010828 ‘}i .
3 ] 41 ] __65 30821113 ] |§
4 S » 70 2088857 | 1§ -
5 3 20| 6594100 |§
|
"o 1.5 » |[E]®| 0ontof6 Selected) i}
| red_tidrica |[Lengitud totalved hidrical) I

Paso 6. Llevamos el resultado a Excel y obtenemos la longitud de la red hidrica
es de 478.45 km y el numero total de cormiente es 1132. Luego la densidad de
drenaje de la cuenca (L/A) es 478,45/207,45 = 2,3. La Densidad de corrientes
que se define como la relacién entre el.nimero total de corrientes en la cuenca .
y su érea total seria 1132/207,45 = 5.45.

Fuente: Agua y SIG, 2013

2.2.6 MOVIMIENTO DE AGUAS ‘SUBT'ERRANEAS.
La dinamica del flujo en un medio poroso saturado se describe mediante la ley

r

de Darcy. . ¢

2.2.6.1 Ley de Darcy

El agua subterranea se desplaza desde los niveles energéticos méas altos a los
mas bajos, por lo que su energia procede esencialmente de las diferencias de -
‘nivel y presiéon. Cuando la proporcionalidad entre el gradiente hidraulico y 1a

velocidad del agua se expresa en términos matematicos, se obtiene una ley lineal :
conocida con el nombre de Ley de Darcy. (Wiest, 1971).

Q: Caudal (m2/s;1/min;1/8); K:conductividad hidriulica. (m
Jdia); 8:seccién, sred.(m?); Ah/Al ¢ Gradiente hidriulico
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Mas generalmente, la ley de Darcy dice que la velocidad del flujo a través del
medio poroso es directamente proporcional a la gradiente de presion
piezometrica o carga hidraulica h:

. Figura 33. Ley de Darcy
Fuente: Arghys, 1999

El flujo natural del agua subterranea se puede esquematizar mediante redes de
flujo. En la Figura 34, se muestra el esquema del flujo subterraneo teniéndose
en cuenta las carécteristicas de unsuelo hombgéneo eisétropo. : .
s Area de recarga, son aquellas en las que el flujo subterraneo presenta una
componénte vertical descendente. |

* Area de descarga, el flujo subterraneo presenta una componente

9

ascendeénte.

- "'7¢r-§r¢f!- e bacel

Toble de agual  ~ * Intermedies / subregienal
T Manentides | Regionel
. Ries R Zenes de Recerge / Infitracién

10 Zenas de Descarge / Exfiltracién

Figura 34. Redes de flujo de aguas subterraneas.
Fuente: Sdnchez, 2008 ’
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Cuadro 11. Clasificacién de algunos materiales sedimentarios segun su

permeabilidad o conductividad hidraulica (m/dia).

Rango 107 10+ 102 10° 10° 107
. .. | Impermeabl | Poco Algo ! Muy
Calificacion | o permeable | permeable Permeable | ormeable
Callificacién ‘Aculifero Acuifero
-l dela Acuicludo | Acuitardo Acuifero regular a excelente
formacion pobre bueno
. Limo Arena
. Arcilla Arena fina L
Séemplos compacta ﬁ;':;oso Arena limosa ICI;T:\'/:\ y Grava
. Pizarra : Caliza limpia
materiales . Arcilia arena
Granito limosa fracturada Arena fina

Fuente: Custodio y Liamas, 1983

" Cuadro 12. Caracteristicas de almacenamiento de las rocas.

Capacidad de | Capacidad | Capacidad de Material

ACU'FEROS_ Almacenar de drenar Transmitir Caracteristico

' ’ Gravas, arenas,
Acuiferos Alta Alta Alta calizas

. Limos, arenas

_| Acuitardos Alta Media/alta Baja ‘| limosas y

Z : z -| arcillosas
Acuicludos _ Alta Muy baja Nula Arcillas_

‘ : ' Granito gneises y
Acuifugos Nula Nula Nula marmoles

;

Fuente: Gonzélez, 2004

~ Cuadro 13. Rangos de valores medios de porosidacf- y permeabilidad de las

distintas rocas.

ROC A POROSIDAD PERMEABILIDAD
: (%) (M/DIA)
NO CONSOLIDADA .
Arcillas 45-60 10€-104
Limo 20-50 103-10
Arena 30-40 "~ 10-10*
Grava 25-40 102-10°
CONSOLIDADA
Argilita 5-15 107-10
Arenisca 5.20 102102
Caliza 1-10 10-2-10
Conglomerados 5-25 1041
Granito 10'5-10 107-103
Basalto 104-50 105-102
Pizarra metamorfica 1041 10-°-10%
Esquistos 1041 10-9-105
Gneis 10-5-1 109-10°
Rocas Volcanicas 10-80 106-10
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2.3DEFINICION DE TERMINOS BASICOS

Formaciéon Geologica.- Es una secuencia de rocas, generalmente de
- caracteristicas semejantes, en cuanto a litologia, fésiles y edad. (Davila, 2011).
Cuenca Hidrografica.- Segun Ortiz, 1995, area de alimentacién de una red
natural de drenaje, cuyas aguas pluviales son recogidas y confluyen hacia un
colector comun, el cauce principal de la cuenca.

Oferta Hidrica.- Volumen disponible de agua para satisfacer la demanda
generada por las actividades sociales y econémicas del hombre. (Corponarifio).
Divisoria de Aguas o Divortium Aquarium.- Davila, 2011 dijo que es la linea
de cumbres o de maxima altura de los terrenos entre dos vertientes, que separa
las aguas de las lluvias o de los deshielos. La divisoria de aguas da lugar a la
formacion de las cuencas hidrograficas. :

Punto de salida.- Término utilizado dentro de |a definicion de cuenca
hidrografica de Dominguez, 2006 y dentro de la definicién de curva hlpsométrlca
de Villon, 2002. Que refiere al punto de salida del drenaje de una cuenca.
Acuifero.- Rocas que almacenan y transmiten agua en cantidades significativas.
(Martinez E, Martinez P. y Castafio. 2006)..Las zonas que poseen agua se llaman
acuiferos. Formaciones geolégicas capaces de almacenar y transmitir agua.
(Davis, Wiest, 1971) . ‘

Acuitardo.- Rocas que almacenan agua y la transmiten lentamente. (Martinez
E, Martinez P. y Castafio. 2006). Formaciones geolégicas que, aunque
almacenan agua y la transmiten en cantidades significativas a escala regional,
no son suficientes para abastecer por si mismas instantjémeamente allos poZos.
(Davis, Wiest, 1971)

Microcuenca.- Es toda area que desarrolla su drenaje directamente a la
corriente principal de una Subcuencg. (Centro Agronémico Tropical de
Investigacion y Ensefianza, 2007)

Rodriguez (2014), propone, en razén de uh anélisis de subcuencas dentro de la
Regién Cajamarca y obtiene datos de la tendencia que las microcuencas estan
en areas hasta aproximaciones a 70 Km? y las subcuencas su tendencia es de
70 Km? a 700 km?, y las cuencas de 700 Km? a mas.
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CAPITULO Il
MATERIALES Y METODOS

3.1 UBICACION GEOGRAFICA

El 4rea de estudio se localiza en la cordillera occidental de los Andes Peruanos
al noreste del valle de Cajamarca, centro poblado de Puyllucana, distrito de los
Bafios del Inca, provincia y departamento de Cajamarca. Con una altitud que
varia de los 2,687msnm. a los 3,305msnm. (ver plano n°01).

La microcuenca Puyllucana, se encuentra comprendida dentro del cuadrangulo
159 de la carta nacional, entre las ‘siguientés' coordenadas UTM, datum WGS84
en la zona 17S:

Cuadro 14. Vértices que delimitan la zona de estudio:

[Vertice | Este (Longitud) | Norte (Latitud) |
NW | 780000 | 9211000
—NE | 785500 | 9211000
~SE_ | . 785500 | 9207000 '
—SW | 780000 | 9207000

3.2 ACCESIBILIDAD . -
Cuadro 15. Accesibilidad haciala zona de estudio: '

T T Tipo de Tipo
Distancia|{ - - Tiempo
Tramo carretera/ | transporte | .
«m) |- 1 (min)
. acceso IMovilidad
Cajamarca - B.I. - T ! ' !
] 8 { Afirmada | Auto . 20
Puyllucana | j ] 1
Cajamarca-Otuzco | 85 | Afrmada | Auto | 30
[ Cammode .
B.Il. - Puyllucana 2 A pié 20
| herradura |

BI= Bafios del Inca
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3.3 CLIMAY TEMPERATURA

De acuerdo al rango de altitud presente (2,690msnm. - 3,300msnm.), la zona de
estudio de ubicaen la Regién Natural Quechua (ver Mapa de Pisos Altitudinales),
establecido dentro de la ocho regiones naturales o pisos ecolégicos del Pery; lo
que determina que su clima sea templado, seco; soleado durante el dia, pero frio
durante la noche.

Regién Quechua.- Es la region natural mas habitada por su clima fresco, apta
para la vida humana, el cultivo de especies vegetales y crianza de ganado. Se
distribuye entre el territorio de Yunga en su limite superior y el limite inferior de

la Jalca. En esta Regién se encuentran las ciudades capitales de provmma
(Sanchez, 2010)

La regién presenta dos estaciones caracteristicas; una lluviosa de Diciembre a
Marzo y otra seca de Abril a Noviembre, con sus respectivas etapas
transicionales; sin embargo este ciclo tiene penodos excepcionales cuando se
presentan anos de sequia y/o de abundantes precipitaciones, con funestas

consecuencias para la agricultura, ganaderia y en general, para la economia de
la regién.

Cuadro 16. Temperaturas en Cajamarca.

Temperatura Maxima Promedio: 12 °C.
‘Temperatura Minima Promedio: 10 °C. )
Temperatura Promedio: | 8°C.

Fuente: (www.turismoperu.com).

Cuadro 17. Precipitacion en Cajamarca.
Presentacién Maxima Promedio: 618.8 mm.

Precipitacién Promedio Mensual: 51.6 mm.

Fuente: (www.turismoperi.com).

Cuadro 18. Meses de Liuvia en Cajamarca.

Periodo Lluvioso: Diciembre, Enero, Febrero MarzoyAan.

“Meses Mas Lluvioso: Febrero y y Marzo

Fuente: (www.turismoperd.com).
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3.4 TIPO DE INVESTIGACION
» Tipodescriptivo.- Se describen las diferentes caracteristicas o rasgos como
la topografia, geomorfologia, unidades litolégicas, entre otras observadas in
situ.
* 'No experimental.- No se realiza experimento.
* Secci6n transversal.- Se realiz6 en un determinado periodo de tiempo,
durante 05 meses: de enero 2015 a junio del 2015.
= Método descriptivo,‘ correlacional y causal.- Incluyé la descripcién,
andlisis y correlacion entre los datos de campo y estudios e interpretaciones
bibliograficas existentes. Se describié las relaciones entre mas de dos
‘variables.

3.5 DISENO DE INVESTIGACION

3.1.1 Trabajo de gabinete inicial:

Revision bibliografica: ’ s :
v" Recopilacién, revisién y sintesis de la informacién necesaria, como libros,
'trabajos de tesis, estudios anteriores, planos, imégeneé satelitales, paginas

‘Web.
Re;:oleccién de informacion base en formato vectorial y raster:

v Informacion espacial topogréfica a escala 1/100,000 en formato shapefile,
segun formato de carta nacional. Ministerio de educacién MINEDU-MED
“Servidor de informacién espacial. !

v ’.Archivé digital en formato shapefile de la geologia, fallés, pliegues,
buzamiento, del cuadrangulo 15g a escala 1/50,000 actualizada hasta el
-2011. “serv_geologia_nuevos”. INGEMMET.

v -Mapas tematicos de Peru en formato shapefile (Cuencas hidrogréficas,
limites regionales, provinciales y distritales) del Ministerio del Ambiente
MINAM - Perd.

v Imégenes ASTER GDEM en formato GeoTIFF con coordenadas UTM, con
resolucién espacial de 30 metros y referencia al geoide WGS84/EGM96.
- Geoservidor Ministerio del Ambiente - Per. '
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v Imagen satelital de alta calidad online “World Imagery” de la galeria de

mapas en ArcGIS, ultima modificacion el 19 de febrero de 2015.

v Imagenes satelitales de alta calidad, georreferenciadas del Google Heart
versién Pro, actualizadas hasta 20 de junio del 2014,

v Iméagenes satelitales LANDSAT de 08 bandas. /andsatlLook "Natural Color"
Image, landsatl.ook “Thermal Image”, landsatLook “images with geographic
reference”. USGS Science for a changing World.

Procesamiento de la informacién:

v Todo la informacién se trabaj6 empleando el software ArcGIS v10.2,
obteniendo asi en primera instancia los plaﬁos base a escala 1:15,000: plano
topografico (curvas cada 10m), plano geolégico a escala 1:50,000, plano de
1irﬁagen satelital (resolucién espacial 30m) a escala 1:15,000.

3.1.2 Trabajo de campo:

v Observacién (orden y detalles) de la zona de estudio: microcuenca
puyliucana.

v Describir con ayuda de los planos base los accesos y lugares mas 6ptimos
parairealizar: la toma de datos GPS, entre otros descritos a continuacion.
Analizar las caracteristicas en cada estacién para de ésta manera identificar
la_distribucién de geologia de la zona, rios tributarios, zonas de recarga
acuifera, entre otras caracteristicas. '

- Datos GPS:
- En coordenadas UTM, sistema WGS84, zona 178, erro-r-:|:3m.
- Cartografiado geolégico:
Registro en libreta de campo: titulo, fecha, hora, localidad, referencias,
nombre de la estacion, coordenadas UTM (este, norte, cota), tipo de roca,
limites con otras unidades (techo, piso) y demas caracteristicas.
- Datos Litolégicos:
Tipo de roca (sedimentaria, ignea, metamorfica)
Color (en muestra fresca y muestra alterada)
Grado de intemperismo (suave, moderado, alto)
- Datos Estructurales:
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Estratificacion (tipo de estratificacion)

Caracteristicas (longitud, pliegues, rumbo, buzamiento)
- Datos de Fallas y diaclasas:

Tipo de falla

Rumbo, buzamiento,
- Datos de manantiales:

Coordenadas UTM (este, norte, cota)

Mediciones (largo, ancho, profundidad)

Caudal (ml/s, I/s), temperatura (°C)

v Presentacién de resulfados: revisar y ordenar datos cualitativos y cuantitativos

obtenidos en campo.

3.1.3 Trabajo de gabinete final: - :

Toda la informacién fue ordenada y trabajada en procesador de texto (Microsoft
Word 2013), hoja de calculo (Microsoft Excel 2013) y plasmada en informe
pérciai (55%), y el informe final (100%). Los cuadros de la bolumna eétrigréﬁca y
perfiles han sido hechos en el software AutoCAD y los planos finales han sido
elaborados con informacién digital y corregida en campo a escala 1:15,000. Para
ser impresos en hoja A3 (420x297 mm).

3.6 DESCRIPCION DE EQUIPOS E INSTRUMENTOS DE MEDICION

Recursos de Gabinete Recursos de Campo

= Laptop Core i5 _ ) » Carta Topografica a escala 1/10,000:
* Impresora a colores = Carta Geoldgica a escala 1/50,000.

» Software ArcGIS v.10.2 . = Imagen satelital a escala: 1/10,000

= Microsoft Office v.2013 * Picota

= Materiales de Oficina : = Brujula tipo Brunton,

* G.P.S Navegatorio.

= Lupa (10x, 20x)

= Rayador (dureza 7).

= Acido clorhidrico 2 mol.

= Libreta de campo, lapiz, colores.
protactor.

= Camara Digital 14 mpx.
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3.7 TECNICAS DE PROCESAMIENTO Y ANALISIS DE DATOS

3.7.1 Procesamiento de datos

Para la generacion de fa microcuenca, se tuvo como base un diagrama de flujo
de las fases para la obtencién de parametros en SIG la cual permite llevar un
orden para crear, editar y administrar modelos, encadenados a una secuencia
de herramientas de geoprocesamiento en forma de organigrama:

s i e T 4 G G e W S e Y S i S i e > e e ek i W - an an — s i e e e e

' . . tesmmiosancscnnsionamanaana FURAOR
! AMBIENTEDE SIG [ ?
H Colmnas i 1 | Teblade atributos]|

: ‘ i 1 [indice de alargamiento

‘ Long. Cauce Princ. ; le

Ancho méaximo de Coef. de Forma

1 ; / cuenca ! Kt

i | Histogremes | m Permetro o dvsoriel—4” | (oot o Compaciasd

1 | de mapas de (] - : ! Kc 1

¢ | cuencas, red | Area de la cuenca P

1| dedrenaje, - . -

: ] DTMa, '\.{ Long. do conientes| % \\.{ Densided de dreneje|

Altura Media

Areas de franjas
E y proms. altimétricos
Numero de corrientes]

Figura 35. Diagrama de flujo de las fases para la obtencién de paradmetros
morfométricos en SIG.

Fuente: Funtes, 2004 . -

Para el célculo de ios parametros morfométricos se tiene como base ia
clasificaciéon de los items generales de Ibafiez, S. et al. 20011 y la descripcién
de los parametros de autores como; Firco, Horton R., Strahler A., Reich V., Steno
N., Hutton J., Faustine J., Jiménez F., Llamas J., Heras R., Jardi M., Villon M.,
Viramontes O., Campos A., entre otros.

3.7.1 Anélisis de datos

Todos los anélisis se basan en la siguiente frase:

“El resultado de los trabajos en SIG, va a depender en gran medida del tipo de
datos, asi como de 1a habilidad del que lo realiza, al procesar la informacién
geoespacial’. (Alcantara, 2015).
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3.8 GEOLOGIA

Localmente en la cuenca de estudio, existen rocas del cretaceo inferior con
edades del aptiano al albiano medio (Formaciones: Farrat, Inca, Chulec y
Pariatambo) y también rocas del Cretaceo Superior de edades del albiano
superior al turoniano (Formaciones: Yumagual, Quilquifan-Mujarrun vy
Cajamarca).

La caracteristica litolégica de la secuencia sedimentaria esta marcada por rocas
esencialmente calcareas en la parte superior (Formaciones: Chilec y
Pariatambo, Yumagual, Quilquifian-Mujarrun y Cajamarca) y en menor
proporciéh de rocas clasticas en la parte inferferior (Formaciones: Farrat e Inca).
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Figura 36. Mapa geolégico de los alrededores de Cajamarca, superponiendo la delimitacién de la microcuenca Puyllucana.

Fuente: Lagos y Quispe, 2007
Modificado por el tesista
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Figura 37. a. Columna estratigrafica, alrededores de Cajamarca y Bafios del inca.
b. Porcentajes de areas ocupados por los tipos de rocas en la microcuenca.

Fuente: Lagos y Quispe, 2007
Modificado por el tesista
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El abundante aporte terrigeno de las unidades calcareas en el area de estudio
se explicaria por: la existencia de los mares cercanos a las costas (Formacion
Chulec, Formaciones: Quilquifian y Mujarrun); por la erosién de las tierras
emergidas durante el periodo de regresion marina del Cretacico Superior
(Formacién Celendin), D. Borkowski, (1994). La disminucién del material terrigeno
en las Formaciones: Pariatambo y Cajamarca indicaria mares mas o menos
profundos muy alejados de la costa. '

Esto sugiere que este sector de la cuenca estuvo sometido a movimientos de
leve subsidencia lo cual iba configurando paulatinamente el aito del Marafién. El
gran espesor que exhibe el grupo. Goyllarisquizga, cerca de 2000m, con las
mismas caracteristicas sedimehtolégicas siguieren que la cuenca estuvo

sometida a un constante hundimiento a medida que se rellenaba de sedimentos
(Krumbein y Sloss, 1963). ‘ '

] - — _ I
Lo goow . 7d°W 7°W 0° -

76|°W

Figura 38. Mapa paleogeografico durante jurasico superior (MALM).
Fuente: Megard, 1973

El Bloque del Marafién empez6 a emerger a fines del Jurasico Superior (MALM),
como respuesta a movimientos epirogenéticos (INGEMMET, 1995) configurando
sistemas de fallas escalonadas a ambos lados de este bloque a manera de horts
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y graben, formandose dos cuencas; estas dos cuencas se comportaron de
manera distinta: la Cuenca Occidental experiment6 una subsidencia desde el
Jurésico Superior mientras‘que la Cuenca Oriental permanecia levantada (Reyes
1980 y Borkowski, 1994). A fines del berriasiano- valanginiano hasta el aptiano, la
Cuenca Occidental sufri6 una emersién dando lugar a la depositacion clastica en

un ambiente marino playero a deltaico (Grupo Goyllarisquizga).

Los sedimentos de la parte inferior del Grupo Goyllarisquizga (Formacién Chimu)
son mayormente de ambientes fluviales a deltaicos, en la parte intermedia se
observa una secuencia marina (Formacioén Santa) con algunos niveles con
Paraglauconia y Cassiope (Aldana, 2008) Lucinidae (Morales, 2009) que indican
corrientes de .aguas salobres de poca profundidad y muy cercanos a la cdsta,
posteriormenté se observan niveles con Weichselia peruviana, Pelcurdia (Aldana,
2008) que indican una depos'itacién en un ambiente continental y quizé' cercano
a una zona transicional (Formacién Carhuaz). En la parte superior se observan
las mismas cgractekisticas continentales que la Formacion Chimu (F;orma(:ién
Farrat). |

Figura 39. Presentacion geografica y paleogréfica del margen andino durante el

cretaceo inferior.
Fuente: Digitalizado boletin de la Sociedad Geolégica del Peni v.88. p.74. 1998.
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En la zona de investigacién encontramos formaciones pertenecientes al
Cretaceo Inferior y parte del Cretaceo Superior, denotandose el paso de un
ambiente sedimentario tipo continental a transicional y a marino poco profundo.
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Figura 40. Columna estratigrafica, alrededores de Cajamarca y Bafios del Inca.
Fuente: Lagos, 2009
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3.8.1 ESTRATIGRAFIA

3.8.1.1 Serie Sedimentaria

A fines del berriasiano-balanginiano hasta el aptiano, esta depresion sufrié una
emersion dando lugar a la depositacion del Grupo Goyllarisquizga, en el aptiano
superior hasta el santoniano medio se inicia la ransgresiébn marina
probablemente como consecuencia del deshielo de los casquetes glaciares
debido al incremento de temperaturas en las regiones polares afectando al Peru
meridional y central (Nufiez 1994 y Moulin, 1979).

El estadio aptiano estd representado por areniscas curazosas de escasa
potencia, Interestratificadas con lutitas y denominado Formacién Farrat;
sobreyace a las lutitas de la Formacion Santa - Carhuaz e infrayace a la
Formacion Inca. ’

Durante el Albiano inferior, se inicia la transgresién marina de facies playera; en
este intervalo, se debositan calizas arenosas y ferruginosas de color grié
paduzco, interestratificadas con lutitas verdosas y pardo arnarillentas, astillosas
y fosiliferas, denominada Forrnacion Inca, ésta formacién es bastante
ferruginosa, de tal modo que al intemperizarse adopta colores rojo y amarillo
brillantes. La formacién inca representa el depoésito basal de la transgresién
marina Albiana.

El estadio Albiano inferior-medio_deja, como testigo de esa transg;resién, una
secbencia de margas, calizas y lutitas con una abundante fai.ma de equinoideos,
gasterépodos y pelecipodos denominada Formacién Chulec, cuya parte inferior
estd compuesta de margas amarillentas y pardas, fosiliferas y astillosas,
interestratificadas con gruesos banco de calizas grises; la parte media esta
compuesta de lutitas pardas, astillosas, friables y fosiliferas, interestratificadas
con capas de caliza con exégira; la parte superior consiste de margas y calizas
en capas delgadas de estratificacién ondulada, algo nodular y tizosa.
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Hacia el final del Albiano medio un mar de aguas profundas deposita una
secuencia de lutitas calcéreas, bituminosas, negras, interestratificadas con
calizas también bituminosas de olor fétido, riqamente fosiliferas, principalmente
en concreciones grandes, discoideas, con fauna de ammonites y conocida como
Formacion Pariatambo; ademas, contiene pelecipodos y gasterépodos.

Sobre una marcada discordancia erosional que indica emergencia del eje del
Marafion, el estadio albiano - cenomaniano deposita margas de aguas poco
profundas y calizas arcillosas de color gris a gris claro, de estratificacion
ondulada. En la base hay intercalaciones de areniscas finas, de estrafificacion
cruzada. En la purte media, gruesas capas de caliza nodular contienen restos de
Ostrea e Inoceramus. La parte. superior se caracteriza por la presencia de
ammonites y fésiles pertenecierites a Exégyra, lo que permite clasificar a ésta
secuencia estratigrafica como Formacién Yumégual.

Entre el cenomaniano inferior a medio, las condiciones marinas vuelven a ser
imperantes, depositando calizaé y margas q_ue constituyen la Formacion
Mujarrin, la cual esta canpuesta de dos miembros: el miembro superior, llamado
Culebra (compuesto de margas y calizas de color gris claro, bastpnte fosiliferas
conteniendo exdgiras y ammonhes mal preservados) y r’el miembro inferior
llamado choro (compuesto de caliza de color gris claro, ligeramente dolomitica
de potentes bancos y se caracteriza por su mayor resistencia a la erosién que la
formacion Yurnagual, a la que sobreyace. ;

Una disminucién en la profundidad de los mares, ocurrida entre el cenomaniano
y los albores del turoniano deposita una secuencia compuesta de lutitas y
margas amarillentas y parduzcas, interestratificadas con delgados estratos de
caliza nodular amarillo parduzco denominada Formacién Romirén. Caracteriza
a esta formacién la abundancia de fésiles, especialmente el exégyra
olisiponensis, que forma grandes bancos. Ha sido considerado como integrante
del grupo quilquifian.
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La Formacion Coiior pertenece al mismo evento marino que la infrayacente y
se caracteriza por la presencia de margas azulinas, nodulares, interestratificadas
con calizas de color gris oscuro anegro y con fauna de cefalépodos que marcan
el turoniano inferior.

En el turoniano medio, el mar empieza a profundizar, llegando al maximo a fines
del Turoniano superior. Este magno evento tiene como consecuencia la
sedimentacién de una secuencias de calizas de color gris oscuro a gris azulado,
maciza, densa, litografica y de estratos potentes, denominada Formacion
Cajamarca. Esta caracterizada por Intercalaciones de caliza gris azulada,
compuesta de detritus calcareo, menos macizos que las calizas y margas
azuladas predominantes y conteniendo una variada fauna de moluscos.

Funte: Onern, 1977
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Figura 41. Cuadro de correlaciones entre unidades litoestratigraficas del Cretaceo en la margen peruana.
Fuente: Jacay, 2005 ' . ' '
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3.8.1.2 Unidades Litoestratigraficas

CRETACEO INFERIOR ]
- A

GRUPO GOYLLARISQUISGG

\_
‘ FORMACION FARRAT (ki-f)j

Area 3D: 0.94 km2 - 94.15 has.

Porcentaje: 10.28 %.

Litologia: Areniscas cuarzosas blanquesinas de grano fino a medio de gran
resistencia a la erosién, teniendo en la base estratos de 10 a 40cm. con

estratificacién cruzada, aumentando de potencia hacia !a parte superior
(estratocreciente) con estratos de hasta 1m. y admentando manera general el
tamafio de grano (granocreciente), pasando de manera gradual a la formacién
inca, presentando el ello intercalaciones de limolitas y litarenitas. sobreyace a las
\utitas de la Formacién Carhuaz e infrayace a la formacién inca. |

Potencia: aprox. 550m. - '

Edad: Aptiano

Ambiente Sediementario: Playero-Deltaico.

Correlacién: Localmente con la parte superior de la Formacién Llacanora; hacia
el norte se extiende con el mismo nombre y hacia el sur con las regiones de
Sihuas y Pomabamba.

Figura 42. Fracturamiento en la Formacién Farrat.
Coordenada E: 782723, Coordenada N: 9207732
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Area 3D: 0.53 km2 - 52.92 has.

Porcentaje: 5.78 %.

Litologia: Inicialmente llamada “capas rojas” por Tafur (1950) fue posteiormente
definida por Benavides (1956). Consta de areniscas de grano fino ferruginosas en
disminucién progresivamente hacia el techo con intercalacion de limolitas en
aumento progresivo en la misma direccién, estratos de 20 a 40 cm. dando una
tonalidad fuertemante rojiza, debido al intemperismo y a la oxidacién de la
hematita. Evidenciandose algunos plegamiento y huellas de fésiles.Sobreyacs a
la Formacién Farrat e infrayace a la formacién chulec.

Potencia: aprox. 100m. l '

Edad: Albiano inferior

Ambiente Sedfemeniario: Transic_ional,i de un ambiente marino de poca
profundidad con abundante oxigenacion. )

Correlacién: En el érea de la costa (Lima) con la Formacién Chilca, con la
Formaciones Cushabatay en la parte inferior del Grupo Oriente y la Formacion
Angostura (regién de Puno). _

Figura 43. Areniscas grises y rojizas de la Formacién Inca.
Coordenada E: 782314, Coordenada N: 9208625
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CRETACEO INFERIOR

) N
FORMACION CHULEC (ki-chu)

Area 3D: 1.94 km2 - 193.58 has.

Porcentaje: 21.14 %.

Litologia: Fue determinada por Laughlin (1925) y Benavides (1956) la elev6 a la

categoria de Formacién. Esta Formacion es fosilifera por excelencia, consta de:

calizas arenosas, lutitas calcareas y margas, las que por intemperismo adquieren

una textura terrosa de color amarillento (caracteristica para distingirla en campo).

En la parte media encontramos una intercalacién de calizas lutaceas en bancos .
potentes con calizas nodulares de estratos finos. Encontramos fésiles y
macrofésiles de: ammonites, exégyras, bivalvos, entre ofros equinoideos,

gasterépodos y pelecipodos. Sobreyace concordante a la Formacién Inca e

infrayace concordante a la Formacién Pariatambo.

Potencia: aprox. 320m.* | -
Edad: Albiano inferior-medio

Ambiente Sediementah'o: Marino poco profundo. Depositado en un ambiente |
marino somero poco profundo de alta energia de transporte, representa el inicio .
de la gran transgresién marina de!l Cretaceo. "
Correlacién: Se correlaciona con la parte inferior de la Formacién Crisnejas que

aflora en el valle del Marafién y con la Formacién Santa Ursula.

Figura 44. Macrof6sil (ammonite 27x40cm) en la Formacién Chulec.
Coordenada E: 782696, Coordenada N: 9209273
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- CRETACEO INFERIOR
L S r\_'\\ ) - S

FORMACION PARIATAMBO (ki-pa)

Area 3D: 1.27 km2 - 126.86 has.

Porcentaje: 13.86 %.

Litologia: Intercalacion de lutitas calcareas con calizas micriticas, nodulares de
coloracién oscura en estratos delgados con un olor fétido al fracturarlas debido
a su contenido de abundante materia organica y con presencia de chert (silice).
Los afloramientos de ésta unidad muestran un nitido comportamiento estrato
creciente. Se caracteriza por la presencia de microfésiles (micritas y esparitas) y
presencia de huellas de ammonites. Benavides (1957) determiné unas biozona de
oxytropidoceras carbonarium en la base de esta unidad. Yace concordantemente
con la Formacién Chulec e infrayace, con suave discordancia la Formaciéon
Yumagual.

Potencia: 'aprox; 185m.
Edad: Albiano medio
Ambiente Sediementario: Se deposité en un ambiente marino de mayor
profundidad que el chilec y en condiciones euxinicas. )
Correlacién: Se correlaciona con la parte supetior de la Formacién Crisnejas y
con la Formacién Yacu Ushco. Se extiende ampliamente en los andes centrales
del Peru.

Figura 45. Intercalacién de estratos delgados de caliza con lutitas calcareas de la
Formacién Pariatambo. Coordenada E: 784488, Coordenada N: 9208575
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- Area 3D: 3.57 km2 - 357.31 has.

" Porcentaje: 39.03 %.

Litologia: Determinada por Laughlin (1925). Consta de calizas nodulares y

margosas de color color gris claro a gris amarillento, presencia de calcita

secundaria (rellenando las fracturas) y escasos niveles de lutitas. Presenta

abundancia de fésiles (exdgyras, turritelas, pelecipodos), como caracteristica

. principal encontramos biozona de exégyra en el .miembro superior de la

- formacién. Sobreyace concordante a la Formacién Pariatambo e infrayace

- concordante a la Formacion Mujarran. _

Se la divide en tres periodos de formacion de litologia:

a) Superior: Secuencia de margas y calizas grises parduscas en bancos méas o
menos uniformes. Presencia de mineral aragonito en el cerro Coﬁorpunta'.

b) Medio: Miembro lutdceo margoso amarillento, dentro de un conjunto
homogéneo, con escarpas alongadas debido a su dureza uniforme.

c) Inferior:  Delgado miembro intermedio bastante fosilifero, por lo que
litolégicamente se puede confundir con la Formation Mujarrun-Quilquifian.,

Potencia: aprox. 625m.

Edad: albiano superior-cenomaniano inferior

Ambiente Sediementario: Se deposité en un ambiente marino de poca

~ profundidad. o .

_ Correlacién: Se correlaciona con la parte inferior -del Grupo Pulluicana

(conformado por las Formaciones Yumagual y Mujarrin, pero para el caso

. especifico de Cajamarca se considera al Grupo Quilquifian y la Formaci6n

~ Mujarran como una sola unidad) y con la parte baja de la Formacién Jumasha

del centro del Peru.
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Figura 46. Calizas nodutares margosas con fracturas rellenas de calcita de la
Formacién Yumagual, cerca al contacto con la Formacion Pariatambo.

9208580

784489, Coordenada N:

Coordenada E:

T 1.4“.
e

kg

-

Figura 47. Formacién Yumagual evidencidndose un fuerte fracturamiento.

Coordenada E: 784387, Coordenada N: 9208633
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(GRUPO QUILQUINAN |

! o .
| FORMACION MUJARRUN (ks-qm)

Area 3D: 0.65 km2 - 65.45 has.

Porcentaje: 7.15 %.

Litologia: Determinada por Benavides (1956) que diferencia en la Formacion
Mujarriin a los miembros Choro y Culebra y el grupe Quilquifian conformado por
las formaciones Romirén y Cofior.

Consta de intercalacion de Calizas nodulares, margas, lutitas calcéreas pardo-
amarillentas con abundantes fésiles. :

En la base encontramos secuencia de calizas nodulares intercaladas con
margas y lutitas amarillentas, seguido de lechos de qalizas nodulares con margas
pardo amarillentas fosiliferas y con bancos de calizas claras con lutitas arenosas
y margas delgadas con abundantes fésiles,

Forman suelos de coloraciéon gris marrones y topografias suaves debido a su
poca resistencia a la erosion. La parte inferior de la secuencia (Formaciéon
Mujarran) descansa concordantemente sobre la Formacion YUmaguaI, mientras
que la parte superior (Formacion Quilquifian), infrayace con discordancia
paralela a la Formacion Cajamarca.
Potencia: aprox. 140m.

Edad: cenomaniano medio -.vturonianO'ianrior /

Ambiente Sediementario: Se depbsité en un ambiente marino{)oco profunfo,
de menor profundidad que la Formacién Pariatambo. .
Correlacién: Se correlaciona con la Fomiacién Jumasha que la encontramos
aflorando en Yauyos-Lima en la cual se considera que ésta Formacién es la
mejor caliza en el Peru para la generaciéon de cuevas.
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a) Formacion Romiron: Delgados lechos de calizas nodulares margosas
pardo-amarillenta también fosiliferas, se caracteriza por presentar
abundantes fésiles de exégyras , bivalvos, algunos amonites, gasterépodos,
ostreas.

Figura 48. Intercalacion de calizas nodulares con margas pardo amarillentas
: de la Formacion Romiron. iy

Coordenada E: 783665, Coordenada N: 9210026

b) Formacion Cofior: La Formacion Cofior presenta bancos de calizas claras
con lutitas arenosas y margas delgadas con abundantes fosiles. -

Figura 49. Contacto Formacién Cofior y Formacion Cajamarca.
Coordenada E: 783418, Coordenada N: 9210192
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Area 3D: 0.18 km2 - 18.12 has.

Porcentaje: 1.98 %.

Litologia: Determinada por Benavides (1956).

Consiste generalmente de calizas gris oscuras ha azuladas y macizas con
bancos potentes de 3.8 metros, con delgadas capas de lutitas y margas
gris amarillentas hacia el techo. Cuyos afloramientos presentan escasos fosiles
(ostreas) y exhiben una topografia con abundantes estructuras de disolucion
como huellas de gotas de lluvia, rizaduras (ripple marks), surcos (lapiaz). Las
calizas de esta ‘unidad presentan venillas de calcita de hasta 1cm. siendo
consideradas calizas relativamente puras. Sobreyace concordante al Grupo
Quilquifian-Formacion Mujarrin e mfrayace igualmente ala Formacnén Celendin.
Potencla aprox. 530m. B

Edad: turoniano meduo-supenor

Amb:ente Sediementario: Se deposité en un amb|ente marino de regular
profundldad

Correlacién: Se correlaciona con la parte superior de ia Formacrén‘! Jumasha
corresponde a la patrte inferior de la Formacién Otuzco.

Fugura 50 Callzas dela Formacnén Cajamarca
Coordenada E: 767669, Coordenada N: 9210564
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CUATERNARIO
s ,
HOLOCENO

o e -

Depésno FLUVIAL (Q-ﬂ)

Area 3D: 0.16 km2 - 18.29 has.

Porcentaje: 1.78 %.

Litologia: Estos dep6sitos estan representados por acumulaciones de material
transportado por cursos fluviales depositados en el fondo y riberas de la
desembocadura del rio Puyllucana hacia el rio Garnde al NW de la microcuenca
en estudio. Consta de cantos rodados angulosos, s‘ubangulosos y redondeados
con acumulaciones de arenas, limos y arcillas mconsohdadas (gravas y gravillas)
formada por acumulacién reciente,

Epoca: Holoceno hasta el presente.
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3.8.2 GEOLOGIA ESTRUCTURAL

Desde un punto de vista mas extenso al area de estudio, tenemos presente un
conjunto de anticlinales y sinclinales siguiendo rumbo andino, de pliegues
amplios y alargados. Al sector SW del area de estudio abundan los pliegues
tumbados y recostados. Al NE y NW del 4rea de estudio los pliegues estan
cubiertos por las secuencias piroclasticas y tobaceas de los Volcanicos
Huambos. Las estructuras poseen una orientacion N6OW-S60E con una clara
inclinaci6n al oeste y es transversal al corredor estructural Chicama-Yanacocha.
(Lagos et al, 2006).

Figura 51. Zona estructural-alrededores de Cajamarca, pliegues amplios y alargados
Fuente: Lagos, et al. 2006
Modificado por 6l tesista

Existen pliegues de amplia longitud de onda como es el caso del anticlinal de
Bafios del Inca y el sinclinal de Otuzco, dentro de las cuales se encuentra
ubicado la microcuenca Puyllucana (figura 51).

El sinclinal de Otuzco es un tipico pliegue en abanico con rumbo N75W y el
anticlinal de Bafios del Inca con rumbo N85W,; éstos pliegues son el resultado de
fuertes esfuerzos tectdnicos de direcciones NE-SW de edad post-Cretacica que
se desarrollarén durante la fase orogénica Inca, que afecté practicamente a
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todos los sedimentos Cretacicos en Peru. Los pliegues y fallas se desarrollaron
durante la fase compresiva, sin embargo, encontramos fallas profundas pre-
existentes (Pefia, 2006) como es el caso de la falla Cajamarca.

3.8.2.1 Anticlinal Bafios del inca

Los flancos del anficlinal estan formados por capas de areniscas cuarzosaé de
la formaci6n farrat, en le eje se encuentra las lutitas, limolitas y areniscas de la
formaciéon carhuaz; mas antiguas y ménos resistentes a la erosién. El
buzamineto del flanco norte del anticlinal tiene angulos moderados (entre 30°-
40°). El flanco sur tiene mayor pendiente (hasta 70°) demostrando el caracter
asimétrico de éste anticlinal. (Reyes, 1980)

3.8.2.2 Sinclinal Otuzco

El anticlinal Bafios del Inca sé va convirtiendo hacia el norte en el sinclinal
Otuzco. Se puede observar toda la secuencia de Formaciones Inca, Chulec
Pariatambo, Yumagual Qunlquman—Mu;arrun Cajamarca y Celendin en el eje de
sinclinal. La mayoria de los sedimentos son calizas con intercalaciones de
margas y lutitas. Una falla pa‘ra|e|é al eje se observa por el centro de sinclinal.
Anal6gicamente al anticlinal de Bafios del Igica, la estructura contintia hacia el
norte mostrando areniscas resistentes de la Formacién Farrat. El centro del
anticlinal esta erosionado y relleno por los depésitos fluviales con sedimentos de
la Formacién Carhuaz. Al norte sédimentos Cretacicos se encuentran cubiertos
por secuencias de rocas volcanicas (flujos piroclasticos, lahares, tobas) de
grupos huambo y san pablo. (Reyes, 1980)
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Figura 52. Corte geolégico transversal, observando la microcuenca Puyilucana en una zona de plegamiento, entre el anticlinal
Bafios del Inca y el sinclinal de Otuzco, limitada por los cerros cofiorpunta y tuyoloma.
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3.8.3 HIDROGEOLOGIA

3.8.3.1 Hidrogeologia de Cajamarca y Bafios del Inca

De acuerdo a estudios realizados por el INGEMMET, se tiene identificado tres
acuiferos potenciales: Las areniscas cuarzosas -de la Formacién Chima (ki-
chim) tienen un espesor de 600m, forman el acuifero basal en rocas fracturadas
sin rreleno haciéndola muy permeable (K=de 12 0 83 m/dia; test de campo; Pefia,
2006) yace sobre un acuitardo formado por lutitas laminadas negras con
intercalaciones de areniscas finas y grises, pertenecientes al Jurésico
(Formacién Chicama, Js-chic). La parte superior de este acuifero esta formado
por margas y limolitas de poca permeabilidad de la Forrﬁacién Santa (100-150m)
y por areniscas y lutitas de la formacién Carhuaz (500m), haciendo un espesor
de 600;650m; y confinando al acuifero. El acuifero medio -est4 formado por
areniscas de la Formacion Farrat y tiene un espesor de 500m. Una secuencia
~ gruesa (1,650-1,750m) de lutitas y margas de escasa permeabilidad con
: intercaléciones de lutitas y margas de escasa permeabilidad con intercalaciones
de areﬁiscas y calizas; separa el acuifero medio del acufféro superior. El
acuifero superior tiene carécter fracturado-karsticos, formado por calizas de la
Formacién ngamarca encima de este se encuentra los sedimentos del
Cretaceo superior.

En el 4rea de los Bafios del Inca, las-secuencias litolégicas de las Formaciones
Santa, Farrat y Carhuaz forman un anticlinal. En los flancos de ésta estructura
aflora las areniscas cuarzosas de la Formacion Farrat, mientras due en el eje, se
encuentran rocas profundamente erosionadas de las Formaciones Santa
(margas y limolitas) y Carhuaz (lutitas y areniscas rojas). En el eje del anticlinal
y en profundidad; los estratos impermeables de la las Formaciones Santa y
Carhuaz fueron sometidos a fracturacién intensa donde se produjo una flexion
que abrié los caminos para la surgencia del agua subterranea procedente del
acuifero confinado Chimu.

( Fuente: Pefia, Jiri y Lenka, 2007)

77



Lineacidn de interseccion

Cuarcitas

Figura 53. Plegamiento de estructuras geol6gica, generando grietas propicias tanto

Fuente: INGEMMET, 2007.

Cuadro 19. Clasificacién Hidrogeolégica de la‘s rocas, Cajamarcé.

para recarga como para la surgencia de aguas subterraneas.

Clasificacién
Formacién Descripcién de la unidad geclégica / espesor hid touic
Chimy En I3 parte inferior secuencia de areniscas, cuarditas y lutitas, en fa parte supetior Acuifero en rocas fracturadas
{Ki-chi) ] aruesos bancos de cuarcitas blancas / 600 m {caudal mediano)
| Santa Secuencias de lutitas, calizas margosasy ateniscas gris oscuras /. 100-150m Acuitardo
1(Ki-s3) b (caudal pequefio)
| Carhuaz Secuencias de areniscas rojas y verdosas y lutitas grises / 500 m | Acuitardo
(Ki-ca) L o _ . . {caudal pequefio)
famat Cuardtas y areniscas blancas de grano medio a grueso / S00m Acuifero en rocas fracturadas
|inc@a - Areniscas calcdreas, Iutitas ferruginosas y estratos de cuarcitas / méx.100m -~ Acuitardo
i=in) - ) ) (caudal pequefio) -
{Chalec Catizas arenosas fos‘iliferas, {utitas calcdreas y margas mari6n beiges / 200-250m Acuitardo
{Ki=¢hu) . ] {caudal pequeiio)
Pariatambo [ Ltitas con calizas negras bituminosas de estranﬁcaaén delgada, en algunos sitios con | Acuitardo
{Ki-pa) | nédulos de chert y dolomita / 150-200m {caudal pequefio)
1Grupo Pullicana | Secuencia de margas y calizas grises cof intercataciones fosmferas locales y nédulos de | Acuitardo
{ Formacidn Yunagua! {caliza/700m 3 (caudal pequehio)
1{Ksyu) . . _
Quilquifian (alizas nodulares masivas con intercalaciones de margas y lutitas amarillas. Sobre ellag [ Acuitardo
|{Ks-qm) secuendas de alizas nodulares y margas en capas delgadas, y en la parte superior (caudal pequefio)
|y Majarun bancos de calizas claras con lutitas y margas con abundantes fésiles / 500 m ‘
{{Ks-gm) _ ) C
{Cajamarca Masivas calizas gris a azulinas con intercalaciones finas de lutitas y margas del mismo | Acuifero en rocas
| (Ks~¢a) color. Crean bancos de morfologia acentuada y flancos ¢on fenémenos karsticos / facturadas y cirsticas
i 600-700m B {no ha sido estudiado)
Celendin Secuentias de lutitas, margas e intercalaciones finas de calizas claras / 200 m Acuitardo
Ks-ce) (caudal pequefio)
formace Chota (onglomerados alcireos grises en el oeste, areniscas m;as y arenas tobaceas en € este l ?
{{Ks=cho) _1300m areniscas, en el este areniscas tobdceas /300m ) ;

Fuente: INGEMMET, 2007.
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3.8.3.2 Modelo hidrogeolégico conceptual - microcuenca Puyllucanay
alrededores

En el extremo SW de la microcuenca Puyllucana encontramos el acuifero de la
formacion farrat (clasificacion hidrogeolégica de las rocas-INGEMMET, 2007)
que se encuentra en el flanco derecho (segun direcciéon de corte geolégico, Fig.
60) del anticlinal Bafios del Inca, éste acuifero que denominaremos acuifero
principal, se hubica en el cerro Cofiorpunta y se compone de areniscas de grano
fino a medio en estratos que van aumentando de potencia del piso hacia el techo,
se encuentran muy fracturadas teniendo la denominacién de acuifero fisurado
con una permeabilidad (K) de 10 a 15 m/dia (esudios de INGEMMET), lo que
permite una buena infiltracién descendiendo hasta el limite inferior del acuifero y
volviendo muy posiblemente a ascender por las fisuras en profundidad de los
acuitardos cretacicos suprayacentes al acuifero Farrat como son los acuitardos
de las Formaciones: Inca, Chulec, Pariatambo, Quilquifian-Mujarran, acuifero
Cajamarca y acuitardo Celendin, éstas ultimas presentan una fallainversa la cual :
permite un mejor ascénso de las aguas suberraneas. Dichas fisuras son—
originadas debido al plegamiento en Idé. ejes del sinclinal de Otuzo y el anticlinal
de Luichupucro. )
Sub-superficialmente, el acuifero principal (acuifero farrat) decbido a su gran
fracturacion seria el mayor aportante de aguas metedricas y subterraneas hacia
la microcuenca Puyllucana, seguido del acuitardo de la formacién Yumagual que
denominaremos acuitardo principal,‘se hubica casi en la parte cental de la.
microcuenca Puyllucana y esta conformado por margas y calizas gris parduzcas
con abundancia de fésiles y presentando fracturacién en menor prc;porcién que’
el acuifero principal pero considerable para el paso de aguas.

En el extremo NE de la microcuenca Puyllucana encontramos una parte del
acuifero de la Formacién Cajamarca (clasificaciéon hidrogeolégica de las rocas-
INGEMMET, 2007) que denominaremos acuifero secundario, hubicandose en
el cerro Tuyoloma y se compone de calizas gris oscuras a azuladas con delgadas
intercalaciones de lutitas y margas, siendo las calizas poco fracturadas y
presentando fenémenos karsticos.

79



Ki-chi
7

30501

fooo . D

ELEVACION (m.s.n.m.)

Linea de flujo su

v\
R

B
Ks-ca Rls  Ks-ce
Loz o Trangueitts

e\

X1

Ks-am ; Ki-pa
Ks-yu

.q
C° Lilcliconsz Ks-yu  gs.qm Ks-ca

[ 7 Sl R L ‘m .
H (0 RN

AR

/vf Linea de flujo sy

14

] l

i

UNIVERSIDAD NACIONAL DE CAJAMARCA
FACULTAD DE INGENIERIA

Escuela Académico Profesional de Ingenieria Geolégica

Caracterizacién Hidromorfométrica de la Microcuenca Puyllucana

Tesis: -Bafios de! Inca-Cajamarca, Mediante la aplicacion ArcGIS

LPIano: CORTE GEOLOGICO DIST. CAJAMARCA - DIST. LA ENCANADA
Tesista: Bach, José Luis Alcantara Membrillo C 1
Asesor: Ing. Alejandro C. Lagos Manfrique l =

Fecha: _Julio 2015 I escate: Referenciat |




3.9 DELIMITACION SEMI-AUTOMATICA DE LA MICROCUENCA
HIDROGRAFICA PUYLLUCANA MEDIANTE EL SOFTWARE ARGIS.

3.9.1 Obtencién de un DEM v
Se puede obtener un DEM (Digital Elevation Model) a partir de un TIN (Triangle

Irregular Network) creado por medio de curvas de nivel o descargar un DEM
online desde ASTER GDEM.

ASTER GDEM Versi6n 2, lanzado en Octubre, 2011:
Link de descarga: http://gdem.ersdac.jspacesystems.or.jp/index.jsp

- e
S
“
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3.9.2 Definir proyeccion

Antes de insertar en archivo ASTER GDEM v2. al ArcGIS, es necesario definir
en el software el Sistema de Coordenadas a trabajar que de preferencia y por
versatilidad se sugiere que sea en el WGS84 y la zona que en este caso se ubica
en fa zona 17 sur.

r—_ . Data Frame Propemes 1
Festure Caché | Annotation Extert indicators | Frame | Size and Postion
[ Gerend *Cooinate Spden | Wt |_Gor_|
W« | [rechec wseadh g@@|@o{3
— ] i ~
B £ Projected Coordinate Systems )
8B UM i
E)-WGS1984 i

8 e Somhem Hemisphere
@ weS 1984 UT™ Zone 175

Onmmdrmsymm 7

FCoommahe System VVGSiQS4UTM Zonei‘ls ol
i Projection: Transverse Mercator

Daturt WGS 1984 !

| Faise Easting: 500,000.0000
Fatse Northing: 10,000,000.0000
Central Meridian: -81.0000 .
Scale Factor: 0.9986 =z
, Latitude Of Origin: 0.0000 :
‘ Units: Meter ™

. {

| Aceptsr | [ Concelar | [ aghenr |

F|gura 55. Configuracién de Sistema de Coordenadas WGS84 Zona 17Sen
_ propiedades del Data Frame.
‘Fuente: ArcGIS v10.2.

3.9.3 Fill (relleno)

El primer paso es eliminar todas las posibles imperfecciones (como sumideros) -

del MDE, ya que a veces hay celdas vacias en la superficie del raster, aplicando
para ello la herramienta Fill cuya funcién es analizar toda la informacién det MDE
y readecuar aquellos obstaculos que se presenten para la correcta direccién de
la red de drenaje que tiene nuestra 4rea de estudio.

ArcToolbox > Spatial Analyst Tools > Hydrology > Fill
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© & Spatial Anatyst Tools ot e cackes ) o
& Conditiona WM nxlchmm 2
® & Density | BrCtEE o - 18
@ R Distance = )
® & Extraction
® K Genenfization
® § Groundwater
a %> Hydrology
’\ Basin
H
‘\ Flew Accumutation )
“\ Flow Difection |
A\ Flowlength i . |
*\ Sink i i
*\, Snap Pour Point !
‘f\ Stream Link
#\ Stream Order v
#, Stream to Feature -
*\ Watershed L

Figura 56. Ubicacién del comando Fill en ArcToolbox de ArcGIS
Fuente: ArcGIS v10.2.

[ ‘J[ Corent Hg-um..;nmm»h
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3.9.4 Flow Direction (direccion de flujo)

Seguidamente hay que definir la direccién de la red hidrica, para ello generamos
un raster que pontendré la direccion de flujos en cada una de sus celdas. (Se
utiliza la capa generada con Fill).

La direccién del flujo estd determinada por la dureccuSn mas empinada de
descendencia de cada celda o pixel. Se calcula como:

L cambio dc valorde Z
Maxima caida = « + 100
distancia

La distancia se calcula entre los centros de las celdas. El valor de salida de la

direccion del fiujo es un nimero entero (1, 2, 4, 8, 16, 32, 64, 128). Los valores
para cada direccién del centro son los siguientes:

[ws]2[eo[71] s8]0 T 1[5
74]67| 56] 49} 46]s0 | 4]s
69] 53] 44] 37| 38] 48] — Yl 0ok
) 64]s8|ss|22]31]|24] - 12sirs 1 @2 4|8
- |es]ar[ar]21]16]10 1fafa]s
[7a}s3]sa] 2] 1|12 Erfulifingas

Elevation surface Flow direction

Direction codmg

Figi_jra 58. Modelo D8, para determinar direccion de flujo.
Fuente: Greenlee, 1987

Hay ocho direcciones de salida validos relativos a las ocho celdas adyacentes
en las que el flujo podria viajar. Este enfoque se denomina cominmente como
un (D8) modelo de flujo de ocho direccion y sigue un enfoque presentado en
Je_nsen y Domingue (1988).

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direcction
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ArcToolbox = Flow Direction - ol

@ @ Spatiat Analyst Tools Fot st e _ A
® & Density (O ASTESTS UAS A Erae W Fiomtr 1 @ l
|
i

® % Distance ] O3Foroe o edpe cety o fow eutwad foptiens))
® % Extracticn Outpx drop ractes faptionsl) i
@ & Generalization - e
@ & Groundwater
8 & Hydrology
“\ Basin
AF |
“\ Flow Accumutation
BNl i
#\ Flow Length
A\ Sink
“\ Snap Pour Point
#\ Stream Link .
#\, Stream Order v

Strezm to Feature - R .
éwa'tﬂthcd " [T 1 cnm ] [errmens. | [Bomre>> |

Figura 59. Ubicacién del comando Flow Direction én ArcToolbox de ArcGIS.
Fuente: ArcGIS v.10.2 '
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Figura 60. Modelo DEM mostrando direcciénes de flujo.

Fuente: ASTER GDEM v2.
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3.9.5 Flow Accumulation (acumulacion de flujo)

Crea un raster de acumulacion de flujo en cada celda, determinando el nimero

de celdas aguas arriba que vierten sobre cada una de las celdas aguas abajo de

ella, descendiendo sobre la pendiente. (se utiliza la capa generada con Flow

Direction y opcionalmente un “raster de peso” como correccion en el casillero:

imput weight raster). '

* Las celdas de salida con una acumulacién de flujo alta son areas de fiujo
concentrado y se pueden utilizar para identificar canales de arroyo.

s Las celdas de salida con una acumulacién de fiujo de cero son alturas
topograficas locales y se pueden utilizar para identificar crestas.

ojlojojojo]o
of1{1]2]z2]o0
ofsf7]s]e]o
ofojojfo]1
Jojojo]1]aufo

1. 1ol214]7]3s)2

Flow accumulation

i ]+ :
Direction coding

Figura 61. Modelo para detereminar acumulacion de flujo.
Fuente: Greenlee, 1987 _
Si se requiere visualizar mejor la red de drenaje, es necesario cambiar el tipo de
visualizacién de Percent Clip (predeterminado) a Standard Deviations en la

pestafia Symbology de las propiedades del layer “Flow_acc”.

*. El Weight Raster, representa la escorrentia por cada celda. La podemos
obtener digitalizando (formato shape) en ArcGIS y con un Basemap Imagery
online (mapa base de imagen en linea) toda la escorrentia ya que la imagen
satelital integrada en el AcGIS es de alta resolucién. Teniendo en cuenta una
previa inspeccion insitu y posterior convercién en formato Raster.

ArcToolbox > Conversion Tools > To Raster > Polyline to Raster

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation
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Figura 62. Digital

6n de escorrentia sobre imagen satelital.

Fuente: ArcGIS v10.2
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ArcToolbox A T ow Accumutation -_6.

g @ Spatial Analyst Tools s - 38 *

@ & Conditionat PON———

® & Density {D-NASTESES WESPANCS Kheoe MPYIow - 1E

@ R Distance [ et) =

@ & Extraction o . e

@ § Generatization st o g

@ & Groundwater

& & Hydrology
“\ Basin
AFL__
5

*\ Flow Direction

“\ Flow Length

* Sink

“\, ‘$nap Pour Point

# Stream Link

#\, Stream Order v

#\ Stream to Feature ’

A\ Watershed

T o (o) (e

Figura 64. Ubicacion del comando F(ow Accumulation en ArcToolbox de ArcGIS
Fuente: Imégenes capturadas del software ArcGIS.
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3.9.6 Pour Point (punto de fluidez)

El Pour Point, punto de fluidez o punto de desfogue, es un punto (*.shp) ubicado
en el cauce principal de la zona baja de la cuenca donde toda la escorrentia
desemboca hacia un cauce mayor o el mar.

Create New Shapefile

N ]

i. Crear un shape tipo punto en €l MiSMO || rue type: [ " <)
sistema ‘de coordenadas en la que se Spatial Reference
Desorption:
esta trabajando (WGS84 zona 17S).

|Projected Coordnate System: .
tame: WGS_1984_UTM_Zone 175

Geographic Coordnate
Name: GCS_WGS_1384

I . v
i
< >

Dl D ‘

[JCoordinates will contain M vakues. Used to store route data.
[0 Coordinates wil cortein Z vakues. Used to store 3D dats.

Co ] [(ow]

Figura 66. Creacion shape tipo punto en ArcGIS.
Fuente: ArcGIS v.10.2 . :

“ 7 interpotate Shape - - oIl
- von surtace ¥ ° A
. . ‘ FasTeR coeM PUMLUCANAL T — dB8 .
ii. Luego interporiario con el || totrensom ’
[ m— . —. 3@
DEM para obtener sus || ireresusrcmeressmms - 18
coordenadas en " tres || [ . : ‘
. [L,_(".'P.‘;'L.‘) —— 7
i o v |
dimensiones. o — 3
) [Jreepatate Voroes Orty kptioral)
WWM‘(M L S, ey

ArcToolbox > 3D Analyst | -
Tools > Functional Surface > | |

1nterpolate Shape

v

Figura 67. Interpolacién del shape tipd punto con el DEM.
Fuente: ArcGIS v.10.2
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3.9.7 Watershed (cuenca hidrografica)

Determina el 4rea de contribucién por encima de un conjunto de celdas en una
matriz. Un watershed es el area en el cual el agua que drena dentro de ella, se
concentra en un colector comun o principal. El limite entre dos cuencas se
conoce como frontera de drenaje o divortium aquarum (divisoria de aguas). (se
utiliza la capa generada con Flow Direction y el punto de desfogue interpolado).

ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed

ArcToolbox - Watershed - SN

- | @ @ Spatial Anatyst Tools S fon dertoncose — g "
& & Conditionat e« e e ‘ 98
@ & Density | ot - .
® & Distance o g ——)
e o . ) S
B & Generstizstion (AT U YRt rrrariel 16
& & Hydrology
* Basin
“\ Fill
%, Flow Accumulation M

#, Fiow Direction
#\ Flow Length
*\ Sink

“\ Snap PourPoint
#\ Stream Link -
# Stream Order : v
é—ﬁto&mm = o] ] [gowmo )

Figura 69. Ubicacion del comando Watershed en Arclfoolbox de ArcGIS
Fuente: ArcGIS v10.2.

-'.Una vez generado el Watershed, debemos transformégr este raster a formato
vectorial (shape). Para ello, utilizaremos la herramienta Raster to Polygon.

ArcToolbox > Conversion Tools > From Raster > Raster to Polygon

4
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Figura 71. Delimitacién Microcuenca Puyllucana con mapa base topografico.
Fuente: ArcGIS v10.2
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Fuente: ASTER GDEM v2.

Figura 72. Microcuenca dellucana
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3.9.8 Diagrama de Flujo

PROPUESTA DE DIAGRAMA DE FLUJO PARA EL PROCESO DE DELIMITACION
SEMIAUTOMATICA DE LA MICROCUENCA PUYLLUCANA

ASER EEEY

PROYECCION
{Datum)

AL
{Rellenolde]
L ,

B o i

(Bhreeaon & s

CCUMULAmo

WAL ERSHED

CONVERSIO
— ECTORIA

T

INTERROIFACION
WOEMI(cuencalentsD i
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3.10 OBTENCION DE PARAMETROS MORFOMETRICOS DE LA
MICROCUENCA HIDROGRAFICA PUYLLUCANA EMPLEANDO ARGIS.

3.10.1 Descripcion General

La microcuenca Puyllucana se localiza en el Ccpp. Puyllucana, Dist. Los Bafios

del Inca, Prov. y Dep. Cajamarca. Hidrolégicamente pertenece a la sub cuenca

Chonta, ésta a la cuenca Cajamarca, ésta a la cuenca del Crisnejas, ésta a la
“gran cuenca del Marafion y ésta a su vez a la Region Hidrografica del Amazonas.

Cuadro 20. Datos generales de la microcuenca Puyllucana.

| Altura (msnm) N° de " Punto de desfogue
Nombre Ubicaci6n X : cuadricula | , .
Min. | Max - Este Norte
Microcuenca Dep. | a2 . 15-g San
1 - 2,687 | 3,305 780277.90 | 9210586.34
Puyllucana | Cajamarca , - Marcos |

3.10.2 Parametros Generales

i. Area (A)

%! poligono en formato shapg generado anteriormente a partir del rést?r

(watershed), es un vector en forma planimétrica (2D), para tener un resultado

mas real en el célculo del area, es conveniente realizarlo en forma de relieve
" (3D) mediante la generacién de una superficie TIN (Triangle Irregular Network).

METODO:
- Extraer curvas de nivel del ASTER GDEM v2,
ArcToolbox > 3D Analyst Tools > Raster Surface > Contour
- Crear TIN con las curvas de nivel.
ArcToolbox > 3D Analyst Tools > Data Management > TIN > Create TIN
- Interpolar Shape de poligono (microcuenca Puyllucana) con en TIN.
ArcToolbox > 3D Analyst Tools > Functional Surface > Interpolate Shape
- Cortar en TIN con el shape interpolado.
ArcToolbox > 3D Analyst Tools > Data Management > TIN > Edit TIN
- Calcular el volumen del TIN (brinda datos de: &rea 2D, area 3D y volimen).
ArcToolbox > 3D Analyst Tools > Functional Surface > Surface Volume
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Z_Factor Area_2D __Area3d |- Volume
: 1| 8793158.204047 | 9155763.238591 | 2594850604.2653

Figura 76. Célculo de volumen, drea 2D y 3D de la microcuenca Puyllucana.
Fuente: ArcGIS v10.2,

Entonces, del proceso tenemos:
Cuadro 21. Area y volumen - microcuenca Puyllucana.

Unidad de érea ' Unidad de volamen

*

{ m? km? m km®
Area 2D 8'793,158.20 8.79

Area3D | 915576324 916

-

Volumen 2'694'850,604.27 2.59

e ——————

| Area de la Cuenca (A) = 9.16 km?

De acuerdo con autores como: Fautino (1996), Rocha y Kurtz (2001), Campos
(1998) y conforme a la extencién del area; ésta recibe la denominacién de

microcuenca.
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ii. Perimetro (P)
Este parametro se calcula a partir del shape interpolado “microcuenca
Puyllucana” para asf tener la opci6n de calcularlo en forma de relieve 3D.

METODO:

- Abrir la tabla de atributos del shape interpolado microcuenca Puyllucanah
“Open Attribute table” crear un nuevo campo Perimetro y calcular fa geometria
“Calculate Geometry” escogiendo la propied'ad 3D Perimeter.

[Table ~ i — ox
BB 1RO %

Mic_Puy_Interp_ok - x

] FID| Shape® | ID ]| GRIDCODE | arest Perimetro
0[poygonzia | 11. 0| 6.793158 14298.385488
Calculate Geometry
Property: [30 perimeter v]
Coordinate System

A1 @Use coordnate system of the data source: _
- IPG WGS 1984UTM Zone 175 -

QO Use coordnate system of the data frame:
[Pcs: WGS 1984 UTM Zone 175

it Weowntis v, :
-1l [Jcatatate selacted records oniy .
About calaating geometry
I oK ! I Canced
lse « o0 m |@Q| (0 out of 1 Selicted) : '_“-'_.l

Mic_Duy_Imefp.o

Figura 77. Calculo del perimetro de cuenca “3D Perimeter”.
Fuente: ArcGIS v10.2. '

Entonces, del proceso tenemos:
Cuadro 22. Longitud del perimetro - microcuenca Puyllucana.
Unid. Longitud

m km

Perimetro 3D 14,298.39 14.30

[@@m@ammﬂ
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iii. Longitud de La Cuenca (Ly)
Se calcula mediante la interpolacién de la linea recta con la superficie TIN, para
de esta manera poder obtener una linea de longitud en relieve (3D).

METODO: _

- Interpolar el shape de longitud de ia cuenca con la superficie TIN.
ArcToolbox > 3D Analyst Tools > Functional Surface > Interpolate Shape

- Abrir la tabla de atributos del shape interpolado “Open Attribute table” crear
un nue,i.io campo “Longitud cuenca” y calcular la geometrlé “Calculate
Geometry” escogiendo la propiedad 3D length.

[Table ox
ERL ML RCRC RS
Longitud_interpolada x
FiD $hape * id | Longitud cuenca
_ 0|PoymeZil | ©). $313.913415
Calculate Geometry ..
_ Property: {30 length vl
B A 1 Coordnate system 2

@ Use coordinate system of the gata source:
|PCS: WGES 1984 UT™ Zone 175

O Use coordinate system of the data frame:
|9CS: WGS 1954 UTM Zone 175

. T Wnl)r\its ‘ 7

[Ocaladate setected records only
" ‘
Aot clakoting gsomey | o || cancel

[« o ui@mioomonswn -
|tongitud interpotada |

~ Figura 78. Caiculo del la longitud de cuenca “3D fength”.
Fuente: ArcGIS v10.2 '

Entonces, del proceso tenemos:
Cuadro 23. Longitud de la microcuenca Puyllucana.
Unid. Longitud

m km

Longitud 3D | 5,313.91 5.31

A Cov ol mr T Thwome AR A et T

Longitud de la Cu%ﬁca (Ly) =5.31 km
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iv. Longitud del Cauce Principal (L¢)

Se calcula mediante la interpolacion de la linea curva del cauce principal con la
superficie TIN, para de esta manera poder obtener.una linea de longitud del
cauce principal en relieve (3D).

METODO:

- Generar {a red hidrica con la herramienta “Raster Calculator” utilizando el
réster de acumulacién de flujo generado anteriormente e introduciendo la
condicional: Con ("FlowAccumulation"f‘> 100,1).

*. El valor asignado para la condicional es variable con cada cuenca.
ArcToolbox > 3D Analyst Tools > Spatial Analyst Tools > Raster Calculator

A 7 Raster Calcutator o - _n

Map Algebra expression . A

| X;:;;;:—“ - , - [ Conditional ﬁ

Qmcsrtropestst (716 o] [ ]l ][a]| ol 1

S jonolaocn =Ny
Stomon ACEIE] I e

Qe S DR,

Con(FHowAcaimidation® > 90,1) . ;

i

Output raster E

(VRS TESIS WIS PLANGS Shape MPREDHIDRICA 18 .

/ Vi

Figura 80. Condicional “Con” en la calculadora raster:

" Fuente: ArcGIS v10.2 -
/

- Hallar el orden de la red hidrica por el método Strahler con “Stream Order”.
ArcToolbox > 3D Analyst Tools > Spatial Analyst Tools > Hydrology > Stream Order
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—2
_3

9208™

780"

Fuente; ArcGIS v10.2

Figura 81. Orden de la red hidrica generada con “Stream Order”
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Nota: Generar la red hidrica en formato raster y obtener el orden de la cuenca
(los dos pasos anteriores), en este caso solo me sirve para determinar cual es
mi cauce principal ya que si se hace el calculo de la longitud con estos datos se
tendria mucho error (no coincide con la red hidrica digitalizada de una imagen
satelital). Asi que utilizaremos un shape tipo linea de la red hidrica digitalizado
de una imagen satelital de alta resolucion. .

-~ De la red hidrica digitalizada, borramos todos los afluentes (tributarios) y solo
dejamos el cauce principal, luego interpolamos con la superficie TIN
ArcToolbox > 3D Analyst Tools > Functional Surface > Interpolate Shape

- Calculamos la geometria “Calculate Geometry” escogiéndo la propiedad 3D
length. Ya que con la opcién de “Flow Length” presenta un peqqeﬁo margen
de error. ' "

B0 HREEx
Cauce;principal

_Shape* JORJE] 10] wWombre 1. Clase ,,,A:I jongitud ’ R '

0pPotyine2 | 69| 0| Cauce Principat | Pri -| 6339.420467

; Coordnate System B I
; QO Use coordinate system of the data source: ;
i |GCs:WGs 1984 ' P

| @ Use coordinate system of the data frame:
: IPS:WGSI%‘UTMIW 175

_ -Figura 82. Célculo del cauce principal de cuenca “3D length”:
Fuente: ArcGIS v10.2. ' g

Entonces, del proceso tenemos:
Cuadro 24. Longitud de! cauce principal de la microcuenca Puyllucana.

Unid. Longitud

m km

Longitud 3D 6,339.42 6.34

| Longitud del Cauce Principal (Lc) = 6.34 km
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v. Ancho de la Cuenca (W)
Este parametro est4 definido como la relacion entre el Area en relieve (A) y la
longitud en relieve de la cuenca (L).

A 9.16 :
W=§-=-“-= 1.73 km

531
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vi. Desnivel Altitudinal (DA)

Representa la diferencia entre la cota mas baja (Hm) y la cota mas alta (Hw)
dela cuenca.

METODO:

- - Ingresamos a las propiedades del DEM (recortado solola microcuenca), en ia
pestafia Source, en Stadistic, muestra los valores Min y Max de elevacion.

- O también ingresamos a las propiedades de la superficie TIN, en la pestafia -
Source, en el cuadro de Data Source, con el nombre de Z Range.

Layer Properties “

Gerwral| Source | Display | Symbology | Felds |

rExtmt — Co ) A A
Top: 92105607.768634 i
Left: 780278.430558 Right: 785099.550955 :
| Bottom: $207308.411651 .
f-Du'ta Source
X Datﬂ‘we ™ AL,
- ! ‘DMS\TBISLUISV’LANOS\ShmeNP L
TIN Dataset: tn_ok NE
Version: current il
Triangulation Method: delaunay conforming 3
Number of Data Nodes: 436915 .
.| hiumber of Data Trisngles: 968540 ;
L Rarrge: 12687 200000, 2205 000C01)
* | Projected Coordinate System: WGS_ 1984 UTM_Zone_175 - [
Projection; Transverse_Mercator £owl

e e B §

[ o [ Coctor | ot

=

" Figura 85. Propiedades de! TIN mostrando Rango minimio y maximo de eIevaaén
Fuente: ArcGIS v10.2.

A 2 e brriaat = g

A = (Hw=3305) - (Hn=2687) = 618 m

_ ™ Segun el cuadro de las zonas agroecolégicas de Cajamarca (Grillo, et al.
1988) la microcuenca Puyllucana se ubica en el REGION QUECHUA PARTE
BAJA Y ALTA, abarcando la Z.A. de tuberculosas-cereales y la Z.A del maiz.
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vii. Cotas del cauce principal

Esta representada por la cota inicial del cauce principal (cicp) y la cota final del
cauce principal (cfcp), las que no necesariamente tienen que coincidir con las
cotas maxima y minima de la cuenca.

METODO:

Ingresamos a la tabla de atributos del cauce principal interpolado y creamos dos
- columnas cicp y cfc, en las cuales calculamos su geometria eligiendo: Z
Coordinate of Line Start y Z Coordinate of Line End. Estos me dan las cotas o
~ alturas inicial y final respectlvamente del cauce pnnmpal

[’a_b' _ o , o x
L L L LR S _
jCauce principal : x
Shape * | OBJE| Wd Nombre Clase longitud cicp cfcp
§ 0|Polyine 2 69| 0| Cauce Principal | Principal 6339.420467 2693.9912 3099.3194

Calculate Geometry m
Property: : [Length v
Coordinate Syst -L;;'gth
QO use coordinateX Coordinate of Line Start
Y Coordinate of Line Start

GCS: WGS i Z Coordinate of Line Start

[ calatate selected records only . .
About calajating geometry -
A =" =

"o 0o |E].|(OomoﬂSelected).
|Guunn<lpai]|

Figura 87. Calculo de Ia cota inicial y la cota final def cauce principal.
Fuente: ArcGIS v10.2.
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viii. Longitud total de cauces

Es la sumatoria total de toda la red hidrica en relieve (3D) de la cuenca.

METODO:

Ingresamos a la tabla de atributos de toda la red hidrica interpolada y creamos
un nuevo campo en la cual al calcular la geometria escogemos 3D Lenght. Y
luego el la tabla calculada ingresamos a opcién Statistic, en la cual en Sum tengo
la sumatoria total de todos los shape dibujados que representa la red hidrica de

la cuenca.
Tabie . 8 x j
e B0 S X |
_Densidad_interpol x
10 Shepe* | W] Clse 1Q_m) seg| Shape Leng ] ORDEN 2 L A
0 [PolyineZM | 0] Secundario 0] 541918899 2 548509287 | 1%
{  1[roymezu 0 | Secundario ] 0] 245093948 1 253467579 | [ J
== - - i s P =] 212964055 | 1 °
j' Calculate Geometry n K] _ 269657746
alg e 835421559
ed| | Property: ‘!wlmgﬁ! . vi il 360677472
Ei§ - ; o ) 407.300893
[ 1l, CoerdmateSystem - - ) MYt 77771
- - ' Statistics of Densidad_interpof u
L ‘1" Froquoncy Distrivution
n 25 g
- 1 _ __ __ r
o 20 | ) ‘ 1
o 15
|
= Il 10 |
i N 0 5 —
g . o] ,
_1 ) L 242 2061 3860 5608 7517 9335

Figura 88. Célculo de la sumatoria de toda 1a red hidrica de fa cuenca.
Fuente: ArcGIS v10.2. ’

3.10.3 Parametros de Forma

i. Factor de Forma (RF)
Se expresa como la relacién entre el ancho en relieve 3D de la cuenca y su
longitud en relieve 3D.
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*. Segun cuadro 04, la microcuenca queda clasificada como Cuenca Alargada.

li. Coheficiente de Compacidad (KC)
Se expresa como la relacién entre el perimetro (en relieve 3D) de la cuenca y el
perimetro de un circulo de 4rea equivalente. Indica la tendencia a concentrar

volumenen de agua.

P 14.30

. KC = 0282\7:—0282 YR =133

P:perimetro de la cuenca (km); A: Area de ia cuenca (km?)

*. Seguin Cuadro 05, la microcuenca se encuentra en la clase kc2 de forma oval-

7

alargada con tendencia a crecida media. . §

iii. Rectangulo Equ‘ivalente

Es un rectangulo qué tiene ig'ual superficie, perimetro, coeficiente de compaci&_jad

y distribucion hipsométrica que la cuenca en cuestion. ademas de facilitar la

comparacion geométrica de las cuencas, permite ver la mﬂuencua de ‘sus

caracteristicas sobre la escorrentia.

- Para el calculo de los lados mayor y menor se aplica las siguientes formulas:
keVvA

Lado Mayor: L = m |

Lado Menor: l= -——-

Kc : Coheficiente de compacidad de Graveltus; A = Area de la cuenca (km?)
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- Lo siguiente es reclasificar el raster de la cuenca en intervalos de elevacién
para calcular el éarea 3D entre cada intervalo y obtener el 4rea acumulada
sobre la superficie, que me sirve para graficarlo.

- Convertimos el TIN a Raster: (figura 89)
ArcToolbox > 3D Analyst Tools > Convetsion > From TIN > TIN to Raster

- Reclasificamos en intervalos definidos (07 clases para éste caso): (ﬁghra 90)
ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify

- Interpolamos y separamos cada area de intervalo de reclasificacion para
calcular su superficie en relieve 3D de forma_individualmente, con la opcién
de “Surface Volume” (brinda datos de: &rea 2D, area 3D y volimen). (figura 91)
ArcToolbox > 3D Analyst Tools > Functional Surface > Surface Volume

~ - Con:los datos optenidos llenamos el siguiente cuadro en Microsoft Excel y
realizamos los céiculos correspondientes:

Cuadro 25. Areas entre curvas de nivel de la Microcuenca Puyllucana. iy

" —t
Ne | COTA | COTA | 4 23D Area3D | Area 3D sobre o ,
-] Min. | Méx. . X % de area | % de drea
ClA ) parcial Acumulada | la superficie
‘ {msn | {msn 2 2 2 entre C.N. | sobre C.N.
SE | : (km?) {km?) (km?) ; :
cmofm
1 2687 | 2700 0.09 0.09 .8.16 ' 1.62% 100.00%
2 [72700 | 2800 148 1.57 9.07 16:15% | 98.98%
3 2800 | 2900 1.32 2.89 .7.59 14.41% 82.83%
4 ‘2900 | 3000 1.78 4.67 6.27 19.40% 68.42%
S 3000 | 3100 233 7.01 4.49 25.48% 49.01%
6 3100 | 3200 143 8.44 2.16 15.62% 23.54%
7 3200 | 3305 0.73 9.16 0.73 7.92% 7.92%
9.16 | 100%
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Fuente: ArcGIS v10.2

782" 784"
Figura 89. . Conversion de TIN a formato Raster.
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Figura 90. Reclasificacion en 07 intervalos del Raster.
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Figura 91. Superficies 3D de rangos de elevacion reclasificados.
Fuente: ArcGIS v10.2
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- Para el célculo de las distancias de separacién (di) de curvas de nivel, se
aplica la siguiente férmula:
Aacss

2 'L

di =

Aacss = Area acum.sobre la superficie km?; A = Area dela cuenca km?; L = Lado mayor
= dil A7) = 0-44’(112; ﬂiz (46) = 1.29km, dil (AS) = 268&”‘; de‘ (A4) = 3.74&731;

‘ ion (ms.nm) -

K- [ R
3
n o M 2 4
- T T

50 75 1p0

Aea% .

1=5.46

Figura 92. Rectangulo equivalente de la Microcuenca Puyllucana.

*. Del rectangulo equivalente podemos deducir que las mayores areas referente
a la attitud A(en msnm) se ubican entre los rangos de 2900 a 3000 .y de 3000 a
3100, representando un 19% y 25% respectivamente; situados en la parte media
de la microcuenca Puyllucana. ‘

3.10.4 Parametros de Relieve

i. Pendiente Media de la Cuenca (Sm)
A una mayor pendiente correspondera una menor duracién de concentracion
de las aguas de escorrentia en la red de drenaje y afluentes al curso principal.
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- Se obtiene a partir del modelo réaster, utilizando la herramienta “Slope”
ArcToolbox > 3D Analyst Tools > Raster Surface > Slope

Ingresando a las propiedades del raster de pendientes, tenemos una
estadistica rapida donde encotramos el valor de la pendiente media.

Layer Propemes
; Generall Souce [Keyusadaa]am{way Symbology |
| { eroperty Vahue a
Datum D_WGS_1984
i ] 8 " Statistcs
1| & Ppendentes%
i Buid Parameters skipped cokumns: 1, rows: 1, ignored value(s):
! Min 0
’1 Max 101. 0992313110352
Mean ) ) «
Std dev, 14, 75005434519418
Classes 0 v

Figura 93, Valor de la pendiente media en el cuadro de propiedades.
- Fuente: ArcGIS v10.2. z .

‘Pendiende Med fe la cuenca (Sm) = 25.33%

*. Seglin cuadro 06, la microcuenca se encuentra en el rango de 25% a 50%
clasificandola como una cuenca empinada.
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ii. Pendiente Media del Cauce Principal (Sc)
- Interpolamos el shape tipo linea del cauce principal con el raster de pendientes:
ArcToolbox > 3D Analyst Tools > Functional Surface > Interpolate Shape

- Generamos una tabla de estadistica zonal con “Zonal Estatistics as Table”,
utilizando el cauce interpolado anteriormente y el raster de pendiente.
ArcToolbox > Spatial Analyst Tools > Zonal > Zonal Estatistics as Table -

[Table . &ox
E-1B- R0 x
Stadis_cauceP ' x|
0ID | OBJECTID | COUNT] MIN] MAX | RANGE | MEAH | SO | .
0] 69| 2642| 0 45812859 | 45812689 | 11.77563¢ | 6.799666 |
W o bs o [[BO] ooutefisetected) S

i c;ﬁcés_iﬁtemol

Figura 95. Valor de la pendiente media del cauce principal. |
Fuente: ArcGISv10.2 : L

[ pengientemedioclcanceprincipal Bﬂj |

- { -
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Cauce Principal

Figura 96. Cauce principal interpolado con el raster de pendientes.

Fuente: ArcGIS v10.2
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ili. Curva Hipsométrica

La curva hipsométrica, permite conocer la distribucion de masa en la cuenca

desde arriba hacia abajo. _

- Del cuadro 25 tomamos los datos de las columnas: % de area sobre C.N.
(curva de nivel) y N° Clase (que corresponde a rangos de elevacion).

CURVA HIPSOMETRICA

H
1
-

e

w
1
"

b g

AREA (%)

Figura 97. Curva hipsornétrica de la microcuenca Puyllucana.

*. Segun la forma de la grafica, podemos sefialar que la microcuenca Puyllucana
sei encuentra en una fase de madurez, en una etapé de Equilibrio que
corresponde a una cuenca geolégicamente madura. Ello implicaria; sin embargo,
un potencial erosivo que no debe despreciarse. ’

iv. Histograma de Frecuencias Altimétricas

Contienen la misma informacién que la curva hipsométrica pero con una
representacion diferente, dando una idea probabilistica de la variacion de la
altura en la cuenca.

- Del cuadro 25, tomamos los datos de las columnas: % de area entre curva de
nivel y N° Clase (que corresponde a rangos de elevacion).
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DIAGRAMA DE FRECUENCIA DE ALTITUDES
30.00%

E 25.00%

25.48%

£ 20.00%
§ 15.00%
10.00%
® 5.00%
0.00%

Altitud

Figura 98. Diagrama de frecuencia de altitudes, microcuenca Puyllucana.

*. Segun el grafico obtenido, la altitud mas frecuente se ubica en la clase n°5 que
. corresponde a un rango entre 3000 y 3100 m.s.n.m.

v. Altitudes Caracteristicas:

Nos permite identificar los valores mas representativos de las alturas:

- Altitud media (media):

Corresponde al valor altitudinal en !‘a posicion central de la microcuenca en
relieve 3D. Se lo obtiene ingresando a las propiedades del Raster.

A , Layer Properties pooT “
[ General | Source | Key Metadata | Extent | Display | Symbology |
Property Vase , : A
‘ Datum D_WGS_1964
B Statistics
B Raster_OK g
Build Parameters skipped columns: 1, rows: 1, ignored value(s):
#in 2687.046095703125
Max 3305
Mean 2982.093557125343
Std dev. 150.4918035308428 o
L Classes 0 v

Figura 99. Valor de la altitud media de la microcuenca Puyllucana.
Fuente: ArcGISv10.2

A i.—.
e

*. Este valor nos indica el promedio de la alturas de la microcuenca Puyllucana.

Altitud media = 2,982769 msnm

— -

4
i
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- Altitud mas frecuente (moda):

Se lo realiza obteniendo el promedio del rango de altitud clase n°5 que segun
la figura n°99 es la mas frecuente. Para ello generamos un raster solamente de
la clase n°5 e ingresando a sus propiedades obtenemos el valor buscado.

Layer Properties “
[ Genensi | Source | Key Metadata | Extent | Display | Symbology |

Property ’ Value »
Datum O_WGS_1984

£ Statistics

B altus_frec ) ' )
Suild Parameters skipped cokumns: 1, rows: 1, ighored value(s):
#in ) 2999.5146484375 )
Max ) 3100.416015625 ) ) .
Ivean € | 3049.132579541942 |-
Stddev. - 28.39742627652934 .
Classes : ) 0 - v .

Figura 100. Valor de la altitud mas frecuente de la microcuenca Puyllucana.
Fuente: Imégen capturada del software ArcGIS.

*. Este dato nos indica el valor de la alturag'que mas se repite en la microcuenca
Puyllucana. ' '
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- Altitud frecuencia media (mediana):
Valor de la altitud ubicada al 50% de las alturas en relieve 3D de la
microcuenca. Lo obtenemos interpolando al 50% los datos del cuadro n°29 las

elevaciones promedio (de las cotas min y max) con % de area sobre curvas de
nivel.

Cuadro 26. Valores de interpolacién para el 50% de las alturas.

X1 68.42 % Y1 -2950 msnm
X2 49.01 % Y2 | 3050 msnm
X 50.00 %

*. Este valor nos informa la altura que separa la microcuenca en dos partes
iguales, cada una de las cuales cuenta con el cincuenta porciento de los datos.

Para esto convertimos el shape del cauce principal (feature) en 3D con la
herramienta “Convert Feature to 3D y de superﬁcaé utilizamos el raster.

Convert Features to 3D - ]
Tmfeaueshtowbyhteroolawhei;ﬂsoﬁamfwe using an attribute as a
mceofhdd\ts,uwmgaspedﬁed
Input features: [MW ] v] E

Source of heights . S
@ Raster or TIN suface: Inasu.-: oK . vl @
QO nput featire attribute: <FeatnreZVaius> 7 T
(O Numeric constant: g.hoo o ___J
Output featires: [;o:u.uxsmswrsmnosmwm.ap.w o i@
Lok J[ coxel |

Figura 102. Conversion del cauce principal a 3D.
Fuente: ArcGIS v10.2

Teniendo activa la edicién el cauce 3D creado y con la herramienta “Profile
Graph” de la barra 3D Analyst, nos crea el perfil del cauce principal.
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Profile Graph Title E

Profile Graph Title
3400 . ' /_-
3050 ' ” g ' [
3,000 : 1 1
" 7" ‘
2850 : / ]
28 ‘_/_/‘/ g ‘
2,750 ,_/_/___7
2,700 4=
L M LS v L X L LY Lo L3 ¥ A S L
. 0 500 1,000 1500 2,000 2500 3000 3500 4000 4,500 ) 5000 5500 6,000
Profile Graph Subtitte

e el s

Figura 103. Perfil longitudinal del cauce principal, hicrocuenca Puyllucana.
Fuente: ArcGIS v10.2 ' :

3.10.5Parametros de la Red Hidroldgica

Ordenacién de Horton-Strahler .

Corrientes de mayor orden'en la je?arquié de Horfbn-Strahler corresponderan a
una red méas densa y comunicada y por ende a cuencas de menor tiempo de
respuesta hidrolégica.

Teniendo como base la red hidrolégica digitalizada en formato shape y estando
ésta en relieve 3D, procedemos a colocar manualmente el orden para cada linea
dibujada; ya que con la herramienta para la generacion automatica del orden
“Stream Order” se pierde precisién tanto en la ubicacién de las corrientes como’
en su longitud. ) ‘

Procedimiento para definir orden a las corrientes de la red hidrica:

se asigna el orden 1 a las corrientes que no presentan ningun tributario,
comunmente en las cabeceras de la red de drenaje.

Al juntarse dos corrientes de orden “n” da lugar a una corriente de orden “n+1".

Cuando se juntan corrientes de diferentes érdenes, la corriente resultante
tomara el valor de mayor orden.

*

. Ya que el orden méaximo define el orden de la cuenca, entonces se tiene un
grado de ramificacién o bifurcacién dentro de la microcuenca de orden 3.
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i. Densidad de la Red de Drenaje (Dd)

Se expresa como el cociente entre la longitud total de los cauces (perennes,

intermitentes y efimerqs) que conforman el sistema fluvial de la cuenca, y el area

total de la cuenca.

- Con base de los shape topografico, de orden, acumulacién de flujo e imagen
satelital, se realiza la digitalizacién de todos los posibles drenajes
(permanentes, intermitentes y efimeros).

- Se expresa como la relacién entre la sumatoria de la longitud en relieve 3D de
los cauces y su 4rea en relieve 3D.

" U: 2 longitud de los cauces (km); A:Area de la cuenca (km?)
- Calculamos la sumatoria de fa longitud en relieve 3D de los cauces en km,
ingresando a Statistics de la columna Longitud 3D en la tabla de atributos.

able - = L o T B __7 O x
&% 18R8ex .
Densidad_interpol X - x|
j— — pr—
10 Shape* | W ] Nombre Clese TIPO | G_m3 seg] Shape Leng | ORGEN_2 | Lengitud 30 I -~
0 | Polyine Z14 o] .. [Secundsro 0] 548516376 2 548.509287 ‘
1| Poyine Z1 0 Secundsio 0] 253487578 1 253467579 | | |
2] Polyine Z 0 T Secunderi 0| 212964055 1 212984055
3 | Polyine ZU 0 Secundsio 0]  304.595003 1 269657746
4 | Poy " N - T
5 [Powmn Statistics of Densidad_interpol .
6 [Powinl [ B 0 w .
7 | Polytin
8 m [
5 Poin v] frequency Disiiwiion
10 | Polylin
11 Pty 25
12 | Popin) 20 ]
13| o 15 — ‘ !
14 | Pobytn - ; :
15 | Poyin 10
16 | Polyin
17 { Powin
[ L B ]

242 2061 3880 5698 7517 9335

Figura 105. Célculo de la sumatoria de las longitudes 3D.
Fuente: ArcGIS v10.2

- Aplicamos la férmula para hallar la densidad: Dd=44.41/9.16=4.85

*. Segln cuadro 10, la microcuenca queda clasificada como una cuenca bien
drenada, facilmente erosionable y conformada por arenas y gravas. E! resultado
corresponde a un valor alto, por lo que segun Villon (2002), representaria una
zona con poca cobertura vegetal y suelos faciimente erosionables.
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Fuente: ArcGIS v10.2
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CAPITULO IV
ANALISIS Y DISCUCION DE RESULTADOS

No cabe duda que el desarrollo tecnolégico ha tenido un impacto muy -
significativo en el desarrollo de actividades del quehacer cotidiano, académico y
profesional, lo que ha revolucionado las tareas de las diferentes disciplinas; la
aparicion de los Sistemas de Informacion Geografica (SIG) vino a revolucionar
la manera en que se realizan los anélisis espaciales, convirtiendo a éstos en un
componente indispensable en casi cualquier area.
. ArcGIS es uno de los software's més completos y. robustos del mercado,
considerado como un SIG completo y por ende, unos de los mas usados a nivel
- mundial; por tal motivo debe emplearse este software correctamente ya que no
- discierne si los datos ingresados son correctos 0 no, para ello debemos hacer
_ uso de nuestro conocimiento, 16gica, criterio y experiencia.

4.1 ANALISIS GEOLOGICO E HIDROGEOLOGICO

" En el area de estratigrafia, se Qa complementado 'y corregido el cuadro

estratigrafico de Cajamarca (ver figura 107) propuesto por el INGEMMET 1980

y modificada por estudios de Tesis anteriores (afio 2012 y afio 201 3) de acuerdo

" a la informacién analizada de:

- Serie sedimentaria de Cajamarca (Inyentario, Evaluacién y Uso Racional de
los Recursos Naturales de la Zona Norte de Cajamarca, ONERN, 1977).

- Cuadro de correlaciones entre unidades litoestratigraficas del cretaceo en la
margen peruana (Andlisis de la sedimentaciéon del sistema cretaceo de los
andes del Peru central, Jacay, 2005).-

- Paralas eras, periodos, épocas y edades se ha utilizado el cédigo de colores
RGB de acuerdo a la Comisién de Mapeo Geolégico para el Mundo, Paris-
Francia (enero, 2012); y para las unidades litoestratigraficas se utiliz6 el
cédigo de colores RGB empleada por INGEMMET-Peru.

- El tiempo Ma (en millones de afios) ha sido tomado de *“International
Chronoestratigraphic Chart” v.2015.
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Geolégicamente los tipos de rocas que conforman la microcuenca Puyllucana
esta representada por una secuencia sedimentaria que en mayor proporcién lo
conforman rocas calcareas (Formaciones: Chulec y Pariatambo, Yumagual,
Quilquifian-Mujarrun y Cajamarca) representado un 83.2% del total del area 3D
y en menor proporcion rocas clasticas (Formaciones: Farrat e Inca) representado
un 16.1% del total del rea 3D de la microcuenca. (ver figura 37).

Nota: Para el célculo de las areas de las formaciones geolégicas cada poligono
fue interpolado con la imagen ASTER GDEM para poder hallar el &rea en relieve

3D y de esta manera tener un resultado mas exacto.

' 45.00% , = ’_

© 40.00% - 39,039

{ 35.00%

1 30.00% . . . - . . o R :
- 25.00% . ' i
‘ 21.14% ;
© 20.00% = [ :
| 15.00% : | 13.86% :
; 10.28% 1 i
. 10.00% - T 7.15% ' :
: 5.78%

{ 5.00% | l ] |- ie8%  178%
! , I
| 0.00% Lo ; B S ] . 1. Lo
Fm. Farrat Fm-Inca Fm. Chulec Fm. Fm. Gpo. Fm. Cuaternario

; Pariatambo Yumagual Quilquifiafi - Cajamarca  Fluvial

: Fm.

; Mujarrun

Figura 108. Porcentaje 4rea de Formaciones Geolégicas - microcuenca Puyllucana.
Fuente: ArcGIS v10.2 i '
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Q-Fluviat
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Fm. Inca

Fm. Chalec

Fm. Paristambo |

Fm. Yumagual i

Gpo. Quilquifian y |
Fm. Mujarmin |

Fm. Cajamarca |

" Figura 109. Superficié de'la geologla &n 3D:

Fuente: ArcGIS y10.2
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COLUMNA ESTRATIGRAFICA - MICROCUENCA PUYLLUCANA

t
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: Fm. Inca § fuertemente rojiza, debido al intemperismo y
. oxidacion de la hematita.
S A 2| Intercalacion de estratos finos de arenisca y
. g5 T A lime.
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Las edades geoldgicas de las rocas que conforman la microcuenca van desde el
Aptiano ¢125 millones de afos atras) al Turoniano (89.8 £0.3 milloneas de afios
atras) y el aporte cuaternario reciente de edad Holocenica (11,700 afios atras).

Estructuralmente la microcuenca se encuentra en una zona de plegamiento que
se originaron como resultado de fuertes esfuerzos.tecténicos de direcciones NE-
SW de edad post-cretacica y presentan amplia longitud de onda, entre el
anticlinal Bafios de Inca y el sinclinal de otuzco, el primero presenta una
inclinacion hacia el SW con rumbo N85SE, y el ségundo es un tipico pliegue en
abanico con rumbo N75W.

~ Con éstos datos se ha logrado mejorar el corte géolégiéo Cajamarca. Bafios del
Inca, elaborado por el INGEMMET vy presentado en: MODELO
HIDROGEOLOGICO DE LAS FUENTES TERMALES DE BANOS DE INCA -
CAJAMARCA, 2015. (ver plano C-1: corte geolégico dist. Cajamarca-dist. La
: Encéﬁa_da). : ' |

Hidrogeolégicamente se ha clasificado acuiferos pertenecientes a la
microcuenca Puyllucana como: '

*. Acuifero principal — Formacién Farrat ) (

*. Aculfero secundario — Formacién Cajamarca '

*. Acuitardo prinpipal — Formacién Yumagual

Y como resultado se ha elaborado una cuadro de Clasificacion Hidrogeolégica
- /

de las rocas (ver cuadro 27) y el plano hidrogeolégico de la microcuenca

Puyllucana (ver plano 06).
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Cuadro 27. Clasificacion Hidrogeol6gica de las rocas - Microcuenca Puyllucana.

[ FORMACION T | CLASIFICACION |
\ LITOLOGIA TECTONICA | :
| GEOLOGICA | HIDROGEOLOGICA |
f’ ""‘"'f‘g*"”"f‘?’* Areniscas cuarzosas de “Muy I A
N . | grano fino a medio fracturado
I'Friv: Faffate ) ,
1 o aumentando de potencia en Fisuras
5
; ___. | 1a parte hacia el techo. abiertas
| Areniscas,
arcillas ferruginosas con Poco
| Fm. Inca ) - e ACUITARDO
] intercalacion de limilitas. fracturado
Tonalidad fuertemente rojiza.
TemRYImR | ntercalacion calizas lutaceas
£ A { en bancos potentes con o
1 e . . (0,00]
} B Ghiiae margas y calizas nodulares ACUITARDO
3”5' ”“g gasy o fracturado
en estratos finos. Muy
| fosilifera )
("intercalacion de iutias )
calcareas con calizas | i
Poco
il nodulares oscuras en estratos . ACUITARDO
. . fracturado
H delgados. Olor fétido al
¥ fracturaras.
| Secuencia de margasen | N G
v . Fracturado |
A B estratos potentes, calizas gris )
| g, SAMENEL . Fisuras ACUITARDO
3 , R parduscas y iutitas )
' ‘ . abiertas
amarillentas. -
— e e i _
{ o Secuencia de Calizas )
Gpo. Quitquifian ‘ » Poco
L nodulares, margas y lutitas ACUITARDO
y Fm. Mujarrin fracturado
] pardo-amarillentas.
. “Fisuras |}
. Calizas puras y portentes de abiertas
| Fm. Cajamarca . \
] gris oscuras a gris azuladas. Procesos
karsticos

Fuente: INGEMMET, 2015
Modificada por el tesista
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4.2ANALISIS EN LA DELIMITACION DE MICROCUENCAS HIDROGRAFICAS

Lo cominmente usado y no recomendable:

i. Curvas de nivel a escala 1:100,000 en descarga libre de todo el Peru
presentada en por cuadriculas y en formato Shape (*.shp) del Ministerio de
Educacién del Peru, sobre la base de la Carta Nacional IGN, 2002. Con
intervalos entre curvas de 50m y de 25m en algunos casos.

Link para descarga de curvas de nivel:
http://sigmed.minedu.gob.pe/descargas/

ii. ASTER GDEM v1 (Aster Global Digital Elevation Model, Version 1), lanzado
en Junio, 2009. La version 1 del ASTER GDEM contiene ciertas anomalias
que afectan la precision del producto y puede ser impedimentos para la
utilizacién eficaz para ciertas aplicaciones. En consecuencia, el METI yla
NASA reconocen que la versién 1 del ASTER GDEM debe de ser visto como
"experimental" o "grado de investigacion". ASTER GDEM v1, lanzado en .
Junio, 2009: ‘
Link par—a descarga de ASTER GDEM v1:
http:/lgeosewidor.nﬁnarﬁ.gob.pemosewidmlduwnload_rasm.aspx

Lo recomendable: .

Utilizar uria imagen ASTER GDEM v2 (Aster Global Digital Elevation Modei,
Version 2), en formato GeoTiFF, previo registro es libre de descarga
(contribucién del Ministerio de Economia, Comercio e Industria MET! de Japény .
la Administracion Nacional de Aeronautica y del Espacio de Estados Unidos -
NASA). De la cual se pueden obtener curvas de nivel mas detalladas con )
intervalos de hasta 10m. ASTER GDEM v2, lanzado en Octubre, 2011:
Link para descarga de ASTER GDEM v2:

http://gdem.ersdac. jspacesystems.or.jp/index.jsp

*. Lo mejorado GDEM V2 afiade 260.000 estéreo-pares adicionales, mejora la
cobertura y la reduccién de la aparicion de artefactos. El algoritmo de la
produccién refinada proporciona una mejor resolucién espacial, una mayor
precision horizontal y vertical, y la cobertura del cuerpo de agua superior y la
deteccion. El ASTER GDEM V2 mantiene el formato GeoTIFF y la misma
estructura grillado y azulejos como V1, con envios de 30 metros y 1x1 azulejos
grado.
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Para la obtencion del raster de aculumacion de flujo (flow accumulation) es
preferible utilizar para a creacién un raster de peso (weight raster) como medida
de control ya que con esto ayudamos a definir mucho mejor la esconentia por
celdas y asi evitar errores como juntas entre lineas de acumulaciones de fujo
que no existen el la realidad.

Este raster de peso se debe realizar insitu y antes de efnpezar con la delimitacién
de 1a microcuenca ya que sirve para una serie de procesos como control para
acumulacioén de ﬂujo., para definir los cauces tributarios, definir y medir la ‘Iongiiud
mas real de toda la red hidrica, el cauce principal, entre otras.

4.3 ANALISIS EN LA OBTENCION DE PARAMETROS MORFOMETRICOS

Para el siguiente andlisis se realiza la compardcién de los parametros
morfométricos de la Microcuenca Puyllucana entre el formato tradicional (2D) y
el propuesto en el presente estudio de tesis (3D) y de ésta manera interpretar la

diferencia entre ambos resultados.

Cuadro 28. Parametros morfométricos 2D de a microcuenca Puyllucana.
T .
PARAMETROS MORFOMETRICOS 2D - MICROCUENCA PUYLLUCANA

Descripcion General

Microcuenca Puyllucana

Ccpp.Puyllucana, Dits. Los Bafios del Inca, Prov. Y Dep. Cajamarca. 1
Minima=2,687 y maxima: 3,303 m.s.n.m._ | |

| N° cuadricula 15g - San Marcos

Punto de o ) - R
i UTM Este: 780277.90; Norte: 9210586.34

salida

WGS84 - Zona 17 sur 1
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Parametros Generales

Simbolo Definicion Valor - Interpretacion

'Representacion de la ' ' |

A superficie de la 8.79 km? Microcuenca
cuenca ‘
 Medicion del
Perimetro P " parteaguas de la 14.11km ' Perimetro de la cuenca
_cuenca :

Linea recta desde la

. salida de la cuenca Influye en la :
Longitu de ' ) |
Ls hasta el parteaguas 5.28 km generacion de [
la cuenca ‘ -
en su punto mas escorrentia :
alejado. '

Longitud del Longitud desde el

. - Influyente en el tiempo
cauce _punto de salida hasta 6.31 km -

o + de concentracién
principal su cabecera ]

. - o a .o
Relacién entre el area

Ancho de la i : Ancho promediode la
w 3Dy la longitud 3D 1.66 km !
cuenca cuenca
de la cuenca _ |
Hm: )
Representa por la 3303y Ubicada en el Regién
Desnivel DA cota mas baja (Hm) y ' M Y Quechua Baja que
Altitudinal la cota mas alta (HM) ) 68.7 . representa la zona
“de la cuenca. ' - agroecolégica del maiz.
msnm
Cicp:
Representada por la :
2,687.15 - . ‘
Cotas del cota inicial del cauce Valor de altura minimo
cauce principal (cicp) y la ny y maximo del cauce ‘
cp:
principal cota final del cauce P principal.
o 3,100.04 -
principal (cfcp). .
msnm '

J— S S
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e — -
Simbolo Definicién Valor Interpretacion !

|

_ Sumatoria total de . ‘
Longitud total ) Longitud de toda lared -
todas las longitudes  42.98 km )

de cauces o hidrica de la cuenca.

de la red hidrica.

Parametros de Forma

Relacién entre el
Factor de

RF ancho de la cuenca y 0.31 - Cuenca alargada
Forma

su longitud.

“Relacién perimetro ' .

Coheficiente : Forma oval alargada
.delacuencay - . .
de KC - 1.34 con tendencia a crecida
) perimetro de circulo ‘ ) (
Compacidad - . . media. {
. de area equivalente.

Rectangulo que tiene Las mayores areas

principal

- igual supefrficie, L: referente a la altitud se |
. perimetro, coeficiente  5.42km  ubican entre los rangos -
Rectangulo : . ‘
) . de compacidad y de 2900 a 3000 y de
Equivalente .
distribucion i 3000 a 3100,
“hipsométricaquela = 1.62km representando un 19%
cuenca en cuestién. y 25% respectivamente
Parametros de Relieve
Pendiente ~ Valor cuantitativo ' ’ o o
media de la Sm pendiente media de 2453% Cuenca empinada
cuenca la cuenca. ‘
Pendiente ' : _ ‘
, Valor cuantitativo ; Ligeramente inclinada
media del . .
Sc pendiente mediadel = 10.24% a moderadamente 1
cauce -
cauce principal. ; ~empinada. i
|

e e m e e
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- Simbolo - Definicién Valor Interpretaciéon ;

| Se encuentra en fase

~ Permite conocer la ;
: i de madurez temprana,

Curva : distribucién de masa i
. s ) . en la Etapa de
Hipsométrica * en la cuenca desde ! e
. . ) " Equilibrio. Cuenca
. arriba hacia abajo. .
. : madura.
Contienen la misma ) %
. informacién que la : . ‘w
Histograma ) . . La altitud mas »
curva hipsométrica,
de . - frecuente corresponde
) dando una idea
Frecuencias o - a un rango entre 3000
R probabilistica de la
Altimétricas o ‘ -y 3100 m.s.n.m.
variacion de la altura ;
en la cuenca.
e e L [ .-[________,A__. e
. , . Corresponde al valor | Nos indica el promedio
Altitud media o : ‘
" altitudinal en la 1 2,995.00 * de la alturas de la
de la cuenca , . ; Lo
] ' posicion central dela | msnm - microcuenca
{(media) ‘ i
. cuenca. 1% Puyllucana
e - ‘L e N -_J,
_ , . Nos indica el valorde
Altitud mas - Corresponde al valor
S ’ -la alturas que mas se |
frecuente de altitudinal mas : 3,050.00 . i
‘ : repite en la :
la cuenca : frecuente de la © msnm . '
‘ microcuenca !
(moda) cuenca.
: ~Puyllucana.
] " Altura que separa la
Altitud ) , - microcuenca en dos
) Valor de la altitud ‘ ]
frecuencia L . 2,981.82 partes iguales, cada
. ubicada al 50% de las -
media : . msnm  una cuenta con el
, " alturas de la cuenca. . .
(mediana) j : cincuenta porciento de
" los datos.
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Herrtem - -

@rdenaciony

ENSGadlicy
Orenc/cHs

Simbolo

Dd

total de la cuenca.

Definicién Valor

: Sistema de
- jerarquizacién que

subdivide la red de

drenaje superficial en
segmentos de cauce Orden 3
en funcion del orden

de magnitud de los

mismos.

Se expresa como el

cociente entre la

longitud total de los
3.04

cauces (perennes,
(pe km/km?

intermitentes y
efimeros) y el area

“de la red hidrica de
- tercer orden.

Interpretacion |

Grado de vifurcacion

Cuenca normalmente
drenada, con poca
resistencia a la erosién
y conformada por
materiales blandos.

Cuadro 29. Parametros morfométricos 3D de la microcuenca Puyllucana.

Microcuenca Puyilucana

Ccpp.Puyllucana, Dits. Los Baiios del Inca, Prov. Y Dep. Cajamarca.

Minima=2,687 y maxima: 3,305 m.s.n.m.

WGS84 - Zona 17 sur

15g - San Marcos

UTM Este: 780277.90; Norte: 9210586.34
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Perimetro

Longitu de

la cuenca

Longitud del
cauce

principal

Ancho de la

cuenca

Desnivel
Aititudinal

Cotas del
cauce

principal

Simbolo

A

P

Le

W

Parametros Generales

Definicion Valor Interpretacion ]

"Representacion dela
superficie de relieve 9.16 km2 - Microcuenca

3D de la cuenca

‘Mediciondel ;

) . - Perimetro 3D de la

' parteaguas en relieve  14.30km -

| cuenca |
3D de la cuenca _ !
Linea recta en relieve
3D desde la salida de Influye en la

la cuenca hasta el - 5.31km  generacion de

parteaguas en su escorrentia

- punto mas alejado.

e e

R

Longitud en relieve :
. Influyente en el tiempo |

3D desde el punto de

. 6.34 km
" salida hasta su de concentracién
cabecera
Relacion entre el 4rea ’ -
: . " Ancho promedio de la
3Dylalongitud3D - 1.73km ‘
- cuenca |
de la cuenca , ) |
o e B IR T S
Representa por la 3305 - Ubicada en el Regién
cota mas baja (Hm) y ' y Quechua Baja que
la cota mas alta (HM) ) 68.7 ' representa la zona
! de la cuenca. C ' agroecolégica del maiz.
, msnm |
Cicp: ’
Representada por la
© 2,693.99
cota inicial del cauce Valor de altura minimo
principal (cicp) y la y maximo del cauce
Cfep: -
cota final del cauce principal 3D.
) 3,099.32 ‘
principal (cfcp). ;
msnm |
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Simbolo1 Definicién . Valor . Interpretacion

Sumatoria total de
Longitud 3D de toda ia

Longitud total todas las longitudes .
) 4441 km red hidricade la
de cauces en relieve 3D de la
cuenca.
red hidrica.
Parametros de Forma
relacion entre el
Factor de ancho 3D de la
RF 0.33 Cuenca alargada

Forma cuenca y su longitud
3D.

Relacién perimetro

Coheficiente » Forma oval alargada
3D de lacuencay ‘ . i
de KC 1.33  contendencia a crecida
perimetro de circulo

Compacidad i : media.
_de area equivalente. :

. - - o

rectangulo que tiene Las mayores areas ‘
igual superficie, L: referente a la altitud se -
. perimetro, coeficiente  5.46km  ubican entre los rangos
Rectangulo :
) de compacidad y ~de 2900 a 3000 y de

Equivalente

distribucién 1 3000 a 3100,

hipsométrica que la 1.68km representando un 19%

cuenca en cuestion. y 25% respectivamente °

Pendiente Valor cuantitativo
media de la Sm pendiente media de 25.33% Cuenca empinada
cuenca la cuenca.

Pendiente

dia del Valor cuantitativo : Ligeramente inclinada
media de ‘ '
Sc pendiente mediadel = 11.80% ' a moderadamente

cauce ! :

~cauce principal. ‘ . empinada.

principal

i i L

— J— - e e = . U U U U S
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Simbolo . Definicion Valor Interpretacion

| . : Se encuentra en fase
Permite conocer la
: de madurez temprana,

Curva , distribucién de masa {
_ _ ‘ - en la Etapa de ;
Hipsométrica - en la cuenca desde J
i . ] - Equilibrio. Cuenca
arriba hacia abajo. :
. madura. }
Contienen la misma
' informacion que la .
Histograma . . La altitud mas
curva hipsometrica,
de . frecuente corresponde
) dando una idea
Frecuencias o a un rango entre 3000
. probabilistica de la -
Altimétricas o y 3100 m.s.n.m.
variacion de la altura
en la cuenca. :
_ . Corresponde al valor Nos indica el promedio
Altitud media o :
‘ altitudinalenla . 2,982.09 - de la alturas de la

de la cuenca L )
posicion centralde la : msnm . microcuenca

(media)

cuenca en relieve 3D. |, Puyllucana

N

Nos indica el valor de

Altitud mas Corresponde al valor
o la alturas que mas se

frecuente de altitudinal mas 3,049.13 .

repite en la
la cuenca frecuente de la . msnm )
] microcuenca
(moda) cuenca en relieve 3D. _

Puyliucana.

T

i ; " Altura que separa la
Altitud - Valor de la altitud . microcuenca en dos
frecuencia ubicada al 50% de las | 3,044.90 : partes iguales, cada
media " alturas en relieve 3D msnm  una cuenta con el
(mediana) : de la cuenca. ; ! cincuenta porciento de
| 1 los datos.
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3 [ Simbolo Definicion Valor Interpretacion
~ Sistema de
- jerarquizacion que

" subdivide la red de : .
- " Grado de vifurcacion

Orden 3 de la red hidrica de
tercer orden.

" drenaje supefficial en
segmentos de cauce

: en funcién del orden

. de magnitud de los

- Mismos.

' Se expresacomoel

cociente entre la i
' ) Cuenca bien drenada,
longitud total de los . )
4.85 facilmente erosionalble |
Dd cauces (perennes,
) ] kmvkm?  y conformada por
intermitentes y . ;
materiales permeables.
efimeros) y el area

total de la cuenca 3D. ‘

Cuadro 30. Comparacién: parametros morfométricos 2D y 3D - microcuenca
Puyllucana.

S e e e s [ JE

COMPARACION: PARAMETROS MORFOMETRICOS 2D Y 3D
- MICROCUENCA PUYLLUCANA

Descripcion General

Nombre . Microcuenca Puyllucana
Ubicacion j Ccpp.Puyllucana, Dits. Los Banos del Inca, Prov. Y Dep. Cajamarca.
Altura 1 Minima=2,687 y maxima: 3,305 m.s.n.m.

.

—4

N° cuadricula 15g — San Marcos

Puntode | ;1\ Ecte: 780277.90; Norte: 9210586.34
salida L
Datum WGS84 - Zona 17 sur
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Perimetro

Longitu de
ia cuenca

Longitud del
cauce
principal

Ancho de la
cuenca

Desnivel
Altitudinal

Cotas del
cauce
principal

Longitud total
de cauces

1

i
t

B _J}

]

!

|

|
;

Parametros Generales

A 879km? 9.16 km?

P 1411km 14.30 km

Lv 528km 5.31 km
6.31km 6.34 km
W 166km  1.73km

Hm: Hm:

3,303y 3,305y

DA HM: HM:

2,687 2,687

msnm msnm

Cicp: Cicp:
2,687.15 2,693.99

Yy y

Cfcp: Cfep:
3,100.04 3,099.32

msnm msnm

42.98km 44.41km
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o Valor2D Valor3D Variaciéon

0.37 km?

190 m

30m

30m

70m

Hm: 2

HM: 0
msnm

Cicp:
6.84

Cfcp:
0.72
msnhm

1.43 km

Interpretacion

4.21% adicional por la
forma del relieve.

No varia la clasificacién
(Microcuenca)

1.35% adicional por la
forma del parteaguas en el
relieve.

0.57% adicional en la
influencia de generacién
de escorrentia.

0.48% adicional en la
influencia del tiempo de
concentracion.

4.22% adicional
por la forma del relieve

0.06% adicional
por el DEM utilizado

0.25% adicional
por el DEM utilizado

3.33% adicional en el 3D

por el DEM utilizado



Pardmetros de Forma

} :;rln Valor2D Valor3D Variacion Interpretacion
Factorde | 0.02 6.45% adicional.
Forma i RF 0.31 0.33 No varia la clasificacion.
J (Cuenca alargada)
Coheficiente W 0.75% restante.
de . KC 1.34 1.33 0.01 No varia la clasificacion.
Compacidad | (Forma oval alargada con
o | tendencia a crecida media.
Rectangulo L:5.42km L:5.46km L: 40m  3.70% adicional.
Equivalente 1:1.62km 1:1.68km 1:60m  No varia la distribucién.
Parametros de Relieve
1 bolo Valor2D Valor3D Variacion Interpretacion
'; 3.26% adicional.
. 0 S ) .
Peqdlente Sm 2453% 2533 % 0.8% Si varlq la clasificacion.
media de la (de empinada a
cuenca moderadamente empinada)
Pendiente 15.23% adicional.
. o ) .
media del Sc 1024% 11.80 % 1.56 % Ng varia la cl;snt_"ncacnén.
cauce (ligeramente inclinada a
principal moderadamente empinada)
Curva No varfa la clasificacién.
Hipsométrrica; {cuenca madura)
Hlstczjg;ama E No varia la distribucion.
L (rango entre 3000 y 3100
Frecuencias m.sn.m.)
Altimétricas T
Afitud media . 209500 298209 1291  043% restante
de la cuenca e
) msnm msnm msnm por el DEM utilizado
(media)
" Altitud mas
frecuente de 3,050.00 3,049.13 0.99 0.03% restante
la cuenca msnm msnm msnm DEM utilizado
(moda)
Altitud O mrtin:
frecuencia 2981.82 304490 6308  2.12% adicional.
media msnm msnm msnm por el DEM utilizado
(mediana)
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Ordenacién
Horton-
Strahler

Densidad de ‘*
Drenaje ’

|

BarametrostdellalRedftiidrologica

sim
bol
Orden 3
3.04
Dd kmvkm?

Orden 3

4.85
km/km?

km/km?

o Valor2D Valor3D Variacién -

No varia la clasificacion.

Si varia la clasificacion.
(de normalmente drenada y
poco resistente a la erosion

1.81

Interpretacion

a bien drenada y facilmente

4.4 CALCULO DE LA OFERTA HIDRICA DEL CAUDAL

4.4.1 F6rmula

Racional

erosionable)

El método racional se utiliza en hidrologia para determinar el Caudal Instantaneo
Maximo de descarga de una cuenca hidrografica. (Linsley y Franzini, 2012)

Donde:

Q = caudal de escorrentia (m’/s)

C = coeficiente de escorrentia

| = intensidad de la precipitacién (mnvh)
A = supefficie de la cuenca (ha)

CxIxA
Q=55

360

Cuadro 31. Coheficiente de escorrentia para el método racional.

COBERTURA TiPO DE PENDIENTE (%)
DEL SUELO SUELO > 50 20-50 5-20 1-5 0-1
Impermeable 0,80 0,75 0,70 0,65 0,60
Sin vegetacion | Semipermeable 0,70 0,65 0.60 0,55 0,50
Permeable 0,50 0.45 0,40 0,35 0,30
Impermeable 0,70 0,65 0,60 0,55 - 0,50
Cultivos Semipermeable 0.60 0,55 0,50 045 0,40
Permeable 040 0,35 0,30 0,25 0,20
Pastos, Impermeable 0,65 0,60 0,55 0,50 0,45
vegetacién | Semipermeable 0,55 0,50 0,45 0,40 0,35
ligera Permeable 0,35 0,30 0.25 0,20 0.15
Impermeable 0.60 0,55 0,50 0,45 0,40
Hierba Semipermeable 0,50 0.45 0,40 0,35 0,30
Permeable 0,30 0,25 0,20 0,15 0,10
Bosque, Impermeable 0,55 0,50 0,45 0,40 0,35
vegetacién | Semipermeable 0,45 0,40 0,35 0,30 0,25
densa Permeable 0,25 0,20 0,15 0,10 0,05

Fuente: Benites, et. al. 1980, citado por Lemus y Navarro, 2003.
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Cuadro 32. Precipitacién mensual en Cajamarca.

PRE RIS NEVIEN STHATREGIOSE g 0

Mes Diciembre} Enero Febrero Marzo Abril

Rango de Precipitacion (mm) | 50-100 | 100-200 | 100-200 | 100-200 50-100

Fuente: SENAMHI, 2013

Tenemos precipitacién maxima (Pméx). = 200mm/dia = 8.33 mm/h

Oferta hidrica del caudal en 2D:

0.50)(8.33 mm 879 ha ‘
S CED 360/&)( ) 1047 ™, = 10,170 Y,

Oferta hid}ica del caudal en 3D:
(0.50)(8.33 ™™/, (916 ha)

= m’ = ) ‘
3 360 10.60 ™ /g = 10,600 ¥4

Diferencia entre caudal 3D y 2D:
Qsp ~ Q20 = 430 Vs

Por lo tanto, se concluye que existe un déficit en el célculo que corresponde
al 4.23% del caudal aportado en la zona de estudio.

4.5 IDENTIFICACION DE POTENCIALES AREAS DE RECARGA ACUIFERA
DENTRO DE LA MICROCUENCA PUYLLUCANA
Intersectando los resultados hidrolégicos (flow direction), hidrogeolégicos .
" (acuifero principal, acuifero secundario, acuitardo principal) y a la clasificacién -
de pendientes (rango 0-8%), se ha elaborado un plano donde nos indica cuales .
serian las areas puntuales mas probables de que ocurra recarga acuifera. (ver
plano 07). Las cuales quedarian identificadas (una vez comprobadas por alguin
metodo insitu) para preservar y proteger de posibles contaminantes antrépicos.

Cuadro 33. Zonas de recarga acuifera.

Zona Cerro Lugar
Norte 1 C° Tuyoloma El Capulif
Norte 2 C® Mojarron Chinchin tres cruces
Sur C° Condorpuriuna Chinchin tres cruces
Este C° Cofiorpunta Puyllucana y Alto Otuzco
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9210™

9208™

¥
-/ _
K/,

Class Hidrogeoldgica
[ ] Acuttere Principal - %
(] Acuitero Secundesio  Eg Y
[ ] Acuitardo Principsl  Dinection coding
780™ 782™ 784
Figura 112. Superposicion de los raster: flow direction, pendientes bajas y los shape: acuifero principal, secundario, acuitardo principal

Fuente: ArcGIS v10.2
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n ArcGIS -




4.6 CONTRASTACION DE LA HIPOTESIS

Se determind la oferta hidrica del caudal aportado en la microcuenca Puyllucana,
dando fiabilidad que el valor en relieve 3D es el mas cercado a a la realidad.
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CAPITULO V
CONCLUSIONES Y RECOMENDACIONES

5.1 CONCLUSIONES.

La microcuenca es estudio estructuralmente se ubica en una zona de
plegamiento, entre el anticlinal Bafios de Inca y el sinclinal de Otuzco producto
de fuertes esfuerzos tecténicos de direcciones NE-SW de edad post-
Cretéclca por lo que es el causante en la forma de dlsposm|6n de las
Formaciones Geoldgicas que se observan superfi cialmente.

Se logré hldrogeolégncamente clasificar los acuiferos pertenecuentes ala
microcuenca Puyllucana como: Acuifero principal (Formacién Farrat), Acuifero
secundarlo (Formacién Cajamarca) vy Acuitardo _principal (Formacuén
Yumagua!)

Se ha logrado establecer a manera de propuesta con el software ArcGlS una
secuencia de procesos en forma del relieve 3D para la delimitacion de
microcuencas y obtencion de sus pérémetros morfométricos, diferenciando
una variaciéon de los valores en 2D y en 3D que van desde 0.03% hasta un
15.23% debido un bajo relieve de la microcuenca (cuenca madura).

La variacién del valor del caudal aportado en 2D y en 3D es del 4.23% que
representa el porcentaje de error que se comete al no realizarlo de manera
mas cercana a la realidad, en relieve 3D.

5 2 RECOMENDACIONES

Corroborar con otros software de la plataforma SIG, la variacion de los datos
morfométricos al obtenerlos éstos enforma 2D y en reheve 3D.

Que se considere como una propuesta de metodologia el proceso de
obtencién de los parametros morfométricos en relieve 3D realizados con el
software ArcGIS.

= Al determinar la oferta hidrica del caudal se sugiere que ésta se hallen en

relieve 3D ya que representan un valor mas cercano a la realidad.
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|Ref. Se ubica al sur de! C°
Mojaron No se pudo tomar{

Cuadro 34: Cuadro 35:
~FICHA 01 - DATOS HIDROGEOLOGICOS | [ FICHA 02 - DATOS FDROGEOLOGICOS' ]
9 2 ) 4 P R 2 '« | - %
IN E} 3 C‘ 2 5 Hora N EJ| 3 G .:_ 3 5 - %31 Hora
- : fv 5
miminan e P it 3 7'7 . I, O . J!_J »

Cédigo CMP-01 9:28am ' Codigo | omp02 - | o:30am

Sector Chimchim Tres Cruces Sector Chimchim Tres Cruces

| Distrito: Bafios del Inca Distrito: Bafios del inca B

L Provincia: Cajamarca i Proirlncia: Cajamarca |

Departamento: | Cajamarca o | Departamento: | Cajamarca

| Tipo de fuente: | Manantial Captacién | X Tipo de fuente: | Manantial | Ceptacién | x}
 Régimen de flujo | Permanente | X | intermitente Régimen de fitjo | Permanente Tintermitente  {x
 Uso: Doméstico Uso: Doméstico y friego

Unidad Acuitardo - Unidad | Acuitardo - Fm. RN

Hidrogeol6gica: | Fm. Chitec | Hidrogeolégica: | Chilec

Caudal | Método de | Respon,. |y Caudal | Método de | Respon_ JNAD

i/s) medicién | sable (i/s) medicién | sable
- - LA - - LA
Observaciones. ) Observaciones:

Ref. Se ubica al sur del C° Mojarron |
{No contenia agua. ‘

PR

Ref. Se ubica al Sur del C* Mojarron i
No se pudo tomar caudal.
| Se encuentra encofrado con cemento. .

Fig. 115 Manantial 01

1 caudat. )
. | Fig. 113 Captacién 01
Cuadro 36: Cuadro 37:
Cédigo 9:36801 RWPDF
d A e - " NSNS
 Sector | Chimchim Tres Cruces Sector Chimchim Tres Cruces
| Distrito: | Bafios del Inca _ Distrito: Bafios dei Inca
Provincia: | Cajamarca Provincia: Cajamarca ]
Departament?; Cajamarca . ‘ Departamento: | Cajamarca
Tipo defuente: | Manantial | X Captacion | Tipo de fuente: | Manantial Reservorio | X |
| Régimen de flujo | Permanente | X' f intenmitente | |Régimen de flujo Permanente Ilntermitente X
. Doméstico,  distriucion  para  otras | , .
Uso: ~ lcaptaciones. - | |Uso: ‘R:Veg.o )
Formacion Acuitardo - Fm. il }Unidad Acuitardo - Fm.
Geolégica: Chutec | T | Hidrogeolégica: | Paristambo |
Caudal | Método de | Respon_ Caudal | Método de [Respon_ |
_(Us) ] medicién | sable {I's) medicién _{sable
- - LA, - - LA.
Observaciones: Observaciones:

Ref. Se ubica al Sur del C° Mojarron.
L*A'P = 3.40*1.70°0.5 m
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Cuadro 38: Cuadro 39:
"FICHA 05 - ~DATOS H|DROGEOLOG|(EOS """ FICHA 06 - "DATOS H HIDROGE OLOGICOS
| i - B
[ | - w
s 2 | b Iz
NE E‘g | ¢| 3088 & hora I N E; of 3092 ;I Hora
2 3 34
| Codigo CMP-03 10:25am | Codigo CMP-04 - 10:38am
| Sector | Chimehim Tres Cruces — { Sector { Chimchim TresCruces
| Distrito: | Bafios del Inca )  Distrito: ] Bafos detinca N
} Provincia: | Cejamarca § Provincia: | Cajamarca -
Departamento: | Cajamarca . | Departamento: | Cajamarca
'.‘ TIPO de fuento' ‘ Manant»al Captacuén R 7)@ - ‘ 'I'Ipo de fuente' Manantial i Captacuén X |
A Réglmendeﬂujo fermanente E 1,}(?@,19,“ “‘ X | - } | Régimendeflujo“Pennanente 1 lntemmente‘ x | i
| Uso: { Riego o S qusee Doméstncoynego o
Unidad " Acuitardo - Fm. Tunidad Acuitardo - Fm. NN
1 Hidrogeolégica: | Pariatambo %jﬂidrogeoléglca: | Pariatambo
Caudal f’M'étocode ‘ R;spon_ [caudal ] _M&édode ‘ Respon
{__{Us) ] medicién |sable 14us) _medicién_Isable
- | vasoy . .
- 0069 | croném,_ | LA = L. _LA
Observaciones: . - : bsewaca
 Ref. Se ubica &l SW del C° Mojan‘on Ref. Se ubica al Sur del C° Mo;armn
¥ €1agua sale por un tubo de %’ Captacién tipo muro seco.
) TL'A=2.30*T.56 m
Cuadro 40 Cuadro 41:
| . : e s 1 N
I g 5 |daa ‘ B lhom |IM Z el § |da2% ‘ Hora
i | 3 - [ & 1 ‘ : - 4
: | ; 1 il
Cédigo CMP-05 11;;.0.,,.,ﬂi fcosigo | CMP06 11:37am
{ Sector Chimchim Tres Cruces- €] Capuil | | Sector . | E1 Capuii N
Distrito: | Bafiosdelinca _||ostrito: | Bafiosdeltnca
{ Provincia: { Cajamarca . ~ ] {Provincla: = | Cajamaca
(bepartamento: Cajamarca ) ‘ Del?am',“,?,'?pfé Cajamarca l o )
| Tipodetuente: | Manantial | | ceptecien | x| || Tipodetuente: | Manantial | | Captecien | x}
| Régimen deﬂujo Permaneme ; 1 tntermitente X | { Regimen déflu]o‘ Permanente Intermitente X
:‘t}so: _ Doméstncoynego - Juso: ] E@éstlcoynego
Unidad Acuitardo - Fm. Bl | Unidad TAcultardo - Fm. [
| Hidrogeolégica: | Yumagual ‘ Hidrogeolégica: | Yumagual
[Caudal | Método de Respon_. {Caudai - ; Miétodo de R;SPON_
{Ug) | medicion |sable L {Us) 1 medicién [sable _
L i - LA -1 - ] LA
Observaciones: ] ' Observaciones: )
| Ref. Se ubica al NW del C* Mojarron. Ref. Se ubica al SW del C* Mojarron. |
| Sin agua. Sin Agua. ‘
| Notiene vélvulas para repartir ! agua. | | { Cercade unacasa . L
| I - | Fig. 119 Captacion 05 | R Fig. 120 Captacion 06
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Cuadro 42: Cuadro 43:
FICHA 09 - DATOS HIDROGEOLOGICOS - ~=FICHA 10 . DATOS HIDROGEOLOGICOS
-d n

[ 1 - v -
IN 2 Ej § C| 3082 5 R Hora N g El = c} 3067 g 8 Hora

g w g 8 5 “ 2
{ codigo MMP-02 12:03pm Cédigo CMP-07 1 12:390m
| Sector ] ElCapuli _ | Sector i ElCapuli
| Distrito: _] Bafios delinca ' Distrito: Bafios del Inca
| Provincla: = { Cajamarca e | Provincia: | Cajamarca -
| Departamento: | Cajamarca o | Departamento: | Cajamarca
| pode fuente: | Manantial | x| captacien  § | | Tipo de tuente: | Manantiat | captacion | x}
| Régimen de flujo | Permanente | X {intermitente | | 3Régimendeflujo Permanente | Tintermitente | x |
Jueo: { boméstico ) {use: o ,i;DOméstico'
o 1 Acuitando = Fm. | ~ “[Acuitardo - Fm. k..
{ Unidad i . I Unidad . o
™ . I Quiquifiafi ‘ ‘ . | Quilquifiafs | 3
| Hidrogeoldgica:  Mujarrun | Hidrogeotégica: Mujarrun | *
I . 1 i ,, . ] ———
jCaudal | Método de |Respon_ | Caudat Método de | Respon ;
{_{Us) ] medicién }sable ‘j_l_s_),_ | _medicién_]sable ;
| - . LA [ - .
‘ Observaclones ; Obsewaaones
| Ref. Se ubica al SW del C° Tuyoloma. 1 Ref Se ubica Oeste del C° Tuyoloma _
JLA*P = 2.80"1.30°0.35 m ‘ 1 \ s
3 “ Flg 122Captad6no7

Cuadro 44: Cuadro 45
e | - . E
_ 1 - 1 | }
N g Ej s c} 3061 i g Hora N ! E ! C] 3058 s ; Hora
1
$ | & -
- . | B
| codigo CMP-08 B 12:40pm | § Codigo | cmp-09 12:40pm
{sector  Teicapui ~ {[sector ] Capul o
Distrito: Bafios del inca ) | | Oistrito: Bafios del Inca _
 Provincla: | Cajamarca o "1 | provincia: | Cajamarca ]
| ) ) ( Lo 1
| bepartamento: i | Departamento Cajamarca e 1
| oo — — — | Tipo de fuente: Manamual | 1 Captecion Txt |
§ Tipo de fuente: | Manantial 1 Caq taclén X i . S
it ¥ - s ¥ N - Régimen deflujo Pemanente | | intermitente X |
! Régimen de ﬂujo Permanente | lintermitente {x | ‘ A o M S
oo - —— — m——les §Usq:” Doméstico
use: ) Doméstico , — | [Unidad Acuiardo - Frn.
Unidad Acuitardo - Fm. ] Hidrogeolégica: | Yumagual = i
Hidrogeolégica: | Yumagual | I . .
— [ Caudal | Métodode | Respon_
| caudal Métocode Respon,_ L. fis) 1 _medicién | sable
(s} medicién_| sable ‘ N LA Tt
- - _LA "Observaciones. ]
Observaciones: Ref. Se ubica al oeste del C° %
Ref. Se ubica al Qeste del C° Tuyoloma. s 3

Tuyoloma.

Reservorio para una vivienda

__Fig. 124 Captacién 09
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Cuadro 46: Cuadro 47:
FICHA 13 - DATOS HIDROGEOLOGICOS FICHA 14 - DATOS HIDROGEOLOGICOS
- g n
N 5 E g Cl 3015 5 § Hora N g E 5 c| 3017 5 8 | Hora
u -
g8 R d & e w g
Cédigo RMP-02 12:52pm Cédigo RMP-03 12:57pm
Sector El Capuli Sector €l Cepuli
 Distrito: Bafios del Inca Distrito: Bafios del Inca
-§ Provincia: | Cajamarca Provincia: Cajamarca
' Departamento: | Cajamarca | Departamento: } Cajamarca
Tipo de fuente: | Manantial Reservorio X | Tipo de fuente: | Manantial Reservorio
Régimen de flujo | Permanente intermitente  § X Régimen de flujo | Permanente | [ intermitente { X |
Uso: Doméstico y riego ' Uso: Dornéstico y riego
I Undoa | Bt
Hidrogol6gica: Mujarrun Hidrogeoldgica: Mujarrun
Caudal Método de | Respon s
- Caudal Método de [Respon_
{is) 1 medicién |sable Vs) | medicién_|sable
Obsc; - = . " LA
rvaciones: ; " -
i : Observaciones:
T oy, UDica ol Qeste det C° Ref. Se ubica al Oeste del C° )
L*A*P = 5.22°2.35%0.40 m Tuyoloma. ] -
Fig. 125 Reservorio 02 L*A*P = 5.0°2.0"0.40 m ‘  Fig.126 Reurvoﬂor 03
Cuadro 48: Cuadro 49:
FICHA 15 - DAFOS HIDROGEO_‘LOGICOS FICHA 16 - DATOS HPROGEOLOGICOS J
3 ) . T ) S .
e .
B (43 ; : 03 |
N g g ]38 ﬁ Hora N & |§ 3 |d¢ 303 ! ; Hora
> -
) R . g R
- -
Cédigo { cme-10 1258pm | | Codigo RMP-04 ) | 1:08om
" Sector El Capui [ Sector  EICepull
Distrito: Bafios del Inca Distrito: Bafios del Ince
Provincia: | Cajamarca Provincia: Cajamarca
Departamento: Cajamm Departamento: } Cajamarca
Tipo de fuémg; Manantial Captacion X Tipo de fuente: | Manantial Reservorio
Régimen de flujo | Permanente  { X | intermitente Régimen de flujo { Permanente intermitente X
Uso: | Doméstico y riego Uso: Doméstico
Unidad Acuitardo - Fm. 3 ¥ Upidad | Acuitardo - Fm.
Hidrogeolégica: | Yumagual Hidrogeolégica: | Yumagual
& - .
Caudal | Método de | Respon_ 1 | Caudal | Método de | Respon_
{Us) 1 medicién |sable {/s) medicién_| sable
.03 f‘a"’fy LA _ - - LA
= : & Observaciones:
Observaciones: Yl ; .
|Ref. Se ubica ol Oeste del C° Ref. Se ubea al Este del C* A
Tuyoloma. LAY = 284152 m
Flg. 127 Captacion 10 - »




Cuadro 50: Cuadro 51:
— FICHA 17 - DATOS HIDROGEOLOGICOS ™ FICHA 18 -DATGS FDROGEOLOGICOS
"z w
L ; = 4
N i ]z |cfsooo | § | [Hoe NE e £ |dass T
] & “w ! g - e !
Cédigo CMP-11 1:24pm Cédtgo ] CMP-12 ) 1:33pm
Sector El Capuli Sector Puylucana
| Distrito: Bafios del Inca  Distrito: | Bafios del Inca
Provincla: Cajamarca ) Provincia: Cajamarca
| Departamento: | Cajamarca 1 Departamento: Cajamarca )
7Tlpodofuornto: Manantial | Captacion X | Tipo de fuente: | Manantial Captacion
Régimen de flujo | Permanente Intermitente | X’ | Régimen de flujo | Permanente [ ntermitente | x
Uso: { Doméstico Uso: ' Doméstico
u nm& "Acuitardo - Fm. Unidad Acuiterdo — Fm.
: . | ouiquisat Hidrogeolégica: | Yumagual
Hidrogotégica: | Mujarrun
Caudal Método de | Respon
Caudal Método de } Respon_ ; -
(Vs) medicién | sable . {Vs) medicién |sable
L ‘ . LA - ! - ] LA
rere vy Observaciones: ‘
Observationes: g " o :
{Ref. Se ubica al Oeste del C° | Ref. Se ubica al Sur del C° Tuyoloma. A .
| Cofiorpunta. : Tl W,
i ! Fig.130 Captacion 12
Cuadro 52: Cuadro 53:
TCHA 19 - DATOS FADROGEGLOGICOS  FICHA 20 - DATOS FIORGGEOLOGICOS
- ' - 2
. - - } ‘2 | &
N d=a | § Hors N o 2005 Hor
- : F 4 !
| Cédigo CMP-13 1:38pm Cédigo CMP-14 1:51pm
Sector Puyllucana / Sector Puylucana '
- Distrito: Bafios del Inca Distrito: Bafios del Incq )
Provincia: Cejamarca Provincia: Cajamarca
Departamento: | Cajamarca ' Departamento: | Cajamarcs
' Tipo de fuente: | Manantial Captacién X  Tipo de fuente: | Manantial Reservorio
Régimen de flujo | Permanente Intermitente X Régimen de flujo | Permanente Intermitente X
Uso: Doméstico Uso: Doméstico '
> P Unidad Acultardo - Fm.
Unidad Acuitardo - Fm. ‘ .
Hidrogeolégica: | Yumagual  Hidrogeolbgica: | Pariatambo
. ‘ Caudal | Método de | Respon
Caudal Método de | Respon_ " ? pon_
‘ ‘ {l/s) medicién |sable
(i/s) medicién_| sable LA
- . LA L d bl
Observacionss Observaciones:
: Ref. : rte ata del Cpp.
Ref. Se ubica al Oeste del C° of. Se ubica parte alta del Cpp.
) . Puyliucana
Tuyoloma. - :
e Fig. 131 Captacién 13
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"El resultado de los trabajos en SIG, va a depénder en gran
medida del tipo de datos, asi como de la habilidad del que lo
realiza, al procesar la informacion geoespacial”.

(Luis Alcantara, 2015)




PY
@ esr lI Understanding our world.

' CONTRATO DE LICENCIA

ARCGIS v10.x

-2015-



\ eSl’I Understanding our world. ] Contrato de Licencia

ArcGIS suscripcién 1D de la cuenta
Su numero de identificacion de suscripcion es 9796243704. Tenga esto en sus archlvos Yy
hacer referencia a él si necesita ponerse en contacto con nosotros.

éNecesita ayuda o tiene preguntas?

Si usted esta en los Estados Unidos y tienen dificultades para activar tu cuenta de ArcGIS
Online, envienos un correo electrénico a support@esricom o llame 1-888-377-4575
{opcidn 2). Si se encuentra fuera de los Estados Unidos, pongase en contacto con su oficina
local de ESRI. '

Gracias,
Su equipo de ESRI Servicio al Cliente

Estado de la suscribcién

—s

200 créditos restantes
Caduca el: 06/12/2015

COMPRAR SUSCRIPCION
ID: 9796243704

S

pdg. 2



'
@ esrl i -orstanding aur world,

Inicio Galeria Map.- Escena Grupos

José Luis Al 7

Perfil de José Luis

Mi contenido  Mi organizacién

Contrato de Licencia

José v q

Hola, José Luis Alcantara Membrillo

Tu cuenta de prueba de ArcGIS Online estd ahora activa. Descarga ArcMap; ArcGIS Pro y otras

aplicaciones listas para utilizar para disfrutar de toda la plataforma ArcGIS.

Nombre
José Luis

Apellidos
Alcantara Membrillo

Correo electronico
luighy25@hotmail.com

Nombre de usuario
luighy25

Biografia
Escribe algo sqbre ti mismo. Puedes incluir cosas como:

Esri.com | ArcGIS Marketplace | Ayuda | Términos de uso  Privacided [ Contacta con Esri | Comunicar abuso

Tu organizadon

Informacion de contacto

Areas de experiencia

Intereses

Cualquier otra informacién que.quisieras que los demds
sepan

Estimado José Luis Alcantara Membrillo:

. {

Gracias por elegir a probar ArcGIS.

: Sélo un recordatorio, la versién de ArcGIS incluye lo siguiente:

¢ ArcGIS Online -
* ArcGIS Desktop
e ArcMap

¢ ArcGIS Pro - Tenga en cuenta que ArcGIS Pro no requiere un cédigo de autorizacion. Se requiere
un conjunto separado de instrucciones de activacién que se pueden encontrar en trial.arcgis.com.

» Aplicaciones adicionales listas para usar

£Quién puede ver tu perfil?
QOrganizacién

Idioma
Spanish-Espafiol

Region
Pera

iinidades
Esténdar de Estados Unidos

Rot
Administrador

Organizacién
caga-luighy

URL de {a organizacion
https://Luighy.maps.arcgis.com

Aqui estd el codigo de autorizacidn de software para ArcMap: EVA276506859

Para completar la instalacion del software, siga las siguientes instrucciones:

Descargar, instalar y Autorizar

1. Primero debe descargar ArcMap en su ordenador. Visita trial.arcgis.com encontrar la descarga si no

lo has hecho ya.

2. Después de haber descargado y colocado los archivos de instalacion en la carpeta de destino de su

eleccidn, inicie el archivo setup.exe si el programa no se inicia automaticamente.

3. Cuando se le solicite, seleccione ArcGIS Desktop Avanzado (Arcinfo) de uso individual. Haga clic en

Autorizar ahora.

pdg. 3
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4, Ei Asistente de autorizacidn de software le guiara a trevés dei resto del proceso de autorizacion.

a. En el cuadro de didlogo Opciones de autorizacion, compruebo la he instalado el software y la
necesidad de autorizar su opcidn y haga clic en Siguiente.

b. En el cuadro de didlogo Método de autorizacion, marque la Autorizar con ESRI utilizando la opcién
de Internet y haga clic en Siguiente.

c. Complete los campos obligatorios para ambas de las paginas de informacion de autorizacién y luego
haga clic en Siguiente.

d. En el cuadro de didlogo Numero de autorizacion de software, introduzca el nimero de autorizacion
EVA276506859 y luego haga clic en Siguiente. (Este nimero de autorizacion puede ser compartida con
cuatro personas mas.)

e. En el cuadro de didlogo Extensiones Autorizar Software, seleccione Tengo niimero (s) de
autorizacidn para autorizar una 0 mas extensiones. Introduzca su nimero de autorizacién y al lado de
las extensiones que le interesan a continuacidn, haga clic en Siguiente.

5. Su software de prueba ArcMap ahora sera autorizado para su uso.

Por favor, no responda a este correo electrénico generado automaticamente.
Por favor, guarde este e-mail para consultas futuras.
Gracias,

El equipo de ArcGIS

Esri.com | Privacy | Contact Vs
Copyright © 2015 Esri, All rights reserved.
Esri, 380 New York Street, Redlands, CA 92373, USA.

PREPARESE PARA UTILIZAR APLICACIONES :

iBuenas noticias! Como parte de los beneficios de su version de prueba gratuita de ArcGIS, usted
también consigue el acceso a un conjunto de aplicaciones hstas para usar que se ejecutan en
navegadores, escritoriosy dispositivos moviles.

’

Colector para ArcGIS
Use su teléfono mtellgente para recopilar y actualizar la informacién en el campo, ya sea
conectado o desconectado.

Navigator para ArcGIS
Buscar e ir a los activos de su empresa, trabajar en conjunto con Colector para ArcGIS, y vaya fuera
de linea.

Explorer para ArcGlS
Acceda a sus mapas, buscar y visualizar tus datos y breves partes interesadas.

Dashboard Operaciones para ArcGIS

Monitorear, rastrear e informar sobre eventos, sistemas o personas y obtener una imagen de
operacion comun.

plg. 4
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Esri Mapas para Office
Hacer mapas dinamicos de sus datos de Excel y afiadir Esri datos demogréficos para obtener mas
contexto sobre un area.

Descubre un mundo de aplicaciones
No se olvide: Usted puede encontrar incluso mas aplicaciones y contenidos disponibles para los
suscriptores de ArcGIS Online en el ArcGIS mercado.

¢Necesita ayuda o tiene preguntas?

Si usted estd en los Estados Unidos, envienos un correo electrénico a service@esri.com, llame 1-
888-377-4575 (opcién 5), o péngase en contacto con su oficina local de Esri. Si se encuentra fuera
de los Estados Unidos, por favor péngase en contacto con su oficina local de Esri.

Gracias,

Su equipo de Esri Servicio al Cliente.

Esti.cord | ArcGiS.com | Brivacy | Gontact Us
Copyright © 2015 Esri. All rights reserved.
Esri, 380 New York Street, Redlands, CA 92373, USA.

pdg. 5
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Esri, 380 New York St, Redlands, CA 92373-8100, EE.UU.  Yeklene: +1 §09-793-2883 « Fax: #1 $09-793-5053

IMPORTANTE~LEER DETENIDAMENTE

Salvo si es sustituido por un contrato de licencia firmado entre usted y Esri, Esri esté dispuesta a otorgarle una
licencia de uso de los Productos solamente si acepta todos los términos y condiciones contenidos en el presente
Contrato de Licencia. Por favor, lea detenidamente los presentes términos y condiciones. No podr4 utilizar los
Productos hasta que haya aceptado los términos y condiciones del Contrato de Licencia. Si no desea aceptar los
términos y condiciones segiin se establecen, marque la casilla ""No acepto el Contrato de Licencia". Seguidamente,
podri solicitar el reintegro de los precios aplicables que haya abonado.

CONTRATO DE LICENCIA
(E204 06/13/2014)

El presente Contrato de Licencia lo formalizan usted (en adelante, el "Licenciatario”) y Environmental Systems Research
Institute, Inc. ("Esri"), una entidad de California con domicilio social en 380 New York Street, Redlands, California 92373-
8100, EE.UU.

TERMINOS Y CONDICIONES GENERALES DE LA LICENCIA
CLAUSULA 1. DEFINICIONES
Definiciones. Las sn;,guientes definiciones corresponden a los términos utilizados en-este documento:

a. Por "Cédigo(s) de autorizaci6n" se entendera toda clave, nimero de autorizacién, cédigo de habilitacién o
activacion, credencial de inicio de sesi6n, codigo de credencial, nombre de usuario y contrasefia, o bien cualquier
otro mecanismo necesario para el uso de un Producto.

b. Por "Beta" se entendera cualquier version alfa, beta o Producto preliminar.

s¢.  Por "Uso de Proveedor de Servicios de Aplicaciones Comerciales” o "Uso de PSA Comercnales" se entenderd la

' generacién de ingresos mediante el suministro de acceso al Software u Online Services a través de una Aplicacién
de Valor Afiadido, por ejemplo, previo cobro de una cuota de suscripcién, cuota de servicio o cualquier otra cuota de
transaccion, o mediante la generaci6n de ingresos por publicidad por encima de los considerados ocasionales.

d. Por "Contenidos" se entender4 la definicién del Anexo 3.

e. Por "Datos" se entendera el conjunto de datos digitales de Esri o de terceros que incluiran, entro otros, datos
vectoriales geograficos, informes de datos exploracién o atributos tabulares asociados, tanto si est4n combinados
con ¢l Software y los Online Services como si se facilitan de manera independiente. ‘

f. Por "Licencia de Implementacion” se entenderd la licencia que autoriza al Licenciatario a ceder a terceros, en
régimen de sublicencia, el Software seleccionado y los Cédigos de autorizacién asociados.

g. Por "Documentacién” se entendera toda la documentacién de consulta para usuarios incluida con el Software.

h. Por "Online Services” se entendera cualquier sistema geoespacial basado en Internet, incluyendo las aplicaciones y
sus correspondientes API (aunque excluyendo los Datos y los Contenidos), albergados por Esri o sus licenciatarios,

con-el objeto de guardar, administrar, publicar y utilizar mapas, datos y demas informaci6n.

i. Por "Documento(s) de pedido" se entender un presupuesto de venta, un pedido de compra o cualquier otro
documento que identifique los Productos que encargue el Licenciatario.

j. Por "Licencia Perpetua" se entenderd una licencia para utilizar una versién de un Producto por la cual se habran
pagado los correspondientes precios de licencia, con caricter indefinido, a menos que Esri o el Licenciatario la den
por terminada tal y como se autorice en virtud del presente Contrato.

k. Por "Producto(s)" se entender4 el Software, los Datos, los Online Services y la Documentaci6n cedidos bajo licencia
en virtud de los términos y condiciones de este Contrato de Licencia.

1. Por "Muestra(s)" se entendera los c6digos de muestra, aplicaciones de muestra, asi como muestras de extensiones de
los Productos.

m. Por "Crédito(s) de servicio” se entenderan las unidades de cambio asignadas a una suscripcién a los Online Services,
por la cuantia especificada en el Documento de pedido. Cada Crédito de servicio otorga al Licenciatario el derecho
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de consumir una cantidad especifica de Online Services, cantidad que podra variar en funcién de los Servicios de
Internet consumidos. A medida que los Online Services sean consumidos, fos Créditos de servicio se cargaran
automaticamente en la cuenta del Licenciatario, hasta alcanzar el nimero maximo de Créditos de Servicio
disponibles. Se pueden adqumr Créditos de servicio adicionales en la manera descrita en el Anexo 3 (también
disponibles en hilp://www.esri.com/legal).

n. Por "Software" se entendera la totalidad o parte de la tecnologia de software, propiedad de Esri (excluyendo los
Datos) a la que se acceda, o se descargue, desde un sitio web autorizado de Esri, o bien que se proporcione mediante
cualquier soporte y cualquier formato, incluyéndose copias de seguridad, actualizaciones, paquetes de servicio,
parches, soluciones provisionales o copias combinadas autorizadas.

o. Por "Plazo de la Licencia" se entenderé una licencia o acceso de uso de un Producto suministrado durante un
periodo de tiempo limitado ("Plazo"), o bien mediante suscripcién o transaccion.

p. Por "Aplicacién de Valor Afiadido" se entendera una aplicacion desarrollada por el Licenciatario para ser utilizada
conjuntamente con el uso autorizado de cualesquiera Software, Datos u Online Services.

CLAUSULA 2 — DERECHOS DE PROPIEDAD INTELECTUAL Y RESERVA DE TITULARIDAD

Los Productos se ceden bajo licencia, no se venden. Esri y sus licenciantes son los propietarios de los Productos y de todas
las copias de los mismos, los cuales estan protegidos por las leyes de EE.UU., asi como por la legislaci6n, tratados y
convenios internacionales en materia de propiedad intelectual y derechos de propiedad, incluyéndose secretos comerciales. El
Licenciatario se compromete a utilizar todos los medios razonables para proteger los Productos contra el uso, la
reproduccion, la distribucion o la publicacién no autorizados. Esri y sus licenciantes se reservan todos los derechos no
otorgados especificamente en el presente Contrato de Licencia, incluyendo los derechos de cambiar y de mejorar los
Productos.

CLAUSULA 3 —~ OTORGAMIENTO DE LICENCIA

3.1 Otorgamiento de Licencia. Esri otorga al Licenciatario una licencia personal, no exclusiva e intransferible
exclusivamente para el uso de los Productos tal y como se estipula en los Documentos de Pedido (i) respecto de los cuales se
hayan pagado los precios de licencia; (ii) con arreglo a lo dispuesto en €l Contrato de Licencia y de acuerdo con la
configuracién encargada por el Licenciatario, o bien que pueda autorizar Esri o su distribuidor autorizado; y (iii) durante el
Plazo que-corresponda o, en caso de no haberse estipulado o identificado ninguno, hasta su terminacién cen arreglo a lo
dispuestd en la Cléusula 5. Ademas del Ambito de Uso detallado en la Cléusula 4, Apéndice 1, el Ambitd de Uso (E300) serd
de aplicacion a Productos especificos. El Anexo 1, el Anexo 2, el Anexo 3 y el Anexo 4 comprenden colectivamente el
Apéndice 1, Ambito de Uso (E300), y también estén disponibles en fa URL http:/www.esri.com/legal/software-license. Los
Anexos solo son de aplicacién a los Productos identificados de forma especifica en un Anexo. Apéndice 1 - El Ambito de
Uso (E300) incluye los Anexos de los siguientes tipos de Productos, que quedan incorporados por referencia:

Soﬁ‘ware Las condiciones de uso de productos de Software especificos se establecen en el Anexo L

Datos. Las condiciones de uso de los Datos se establecen en €l Anexo 2.

Online Services. Las condiciones de uso de Online Services se establecen en el Anexo 3.

Programas de Uso Limitado. Las condiciones de uso de programas no comerciales, sin fines de lucro, educativos u
otros programas de uso limitado se establecen en €l Anexo 4.

e o

3.2 Licencias de evaluacién y Beta. Los Productos adquiridos con arreglo a una licencia de evaluacién o un programa Beta
estin exclusivamente destinados a su evaluacién y prueba, y no para uso comercial. Cualquier uso comercial de los mismos
sera bajo cuenta y riesgo del Licenciatario, no proporcionando Esri ni sus distribuidores servicio de soporte y mantenimiento
para los mismos.

CLAUSULA 4. USO

4.1 Usos autorizados

a. Enlo que respecta a los Productos que le sean licenciados, el Licenciatario podra

1. [Instalar y guardar los Productos en uno o méas dispositivos de almacenamiento electrénico;
2. Hacer copias con fines de archivo y copias de seguridad informaticas de rutina;
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3. Instalar y utilizar la version mas reciente del Software simultineamente con la versién que deba ser sustituida
durante un periodo de transicion razonable que no excedera de seis (6) meses, siempre y cuando la implementacion
de alguna de las versiones no exceda la cantidad de licencias otorgadas al Licenciatario; una vez concluido este
plazo, el Licenciatario no podré utilizar el Software en una cantidad total superior a la que haya adquirido;
Implementar el Software en la configuracién licenciada en un ordenador de sustitucion; y

Distribuir el Software a terceros, asi como cualesquiera C6digos de autorizacién asociados necesarios para el uso de
una Licencia de implementacion.

bl

Uso de Proveedor de Servicios de Aplicaciones Comerciales. El Licenciatario podra destinar el Producto para Uso de
PSA Comercial siempre y cuando el Licenciatario (i) adquiera una licencia de Uso de PSA Comercial, o bien (ii) sea una
organizacion gubernamental o sin fines de lucro que explote un sitio Web u ofrezca un servicio por Internet cobrando
una cuota para cubrir gastos y sin dnimo de lucro.

El Licenciatario podré personalizar el Software utilizando (i) cualquier lenguaje de macros o de secuencias de comandos,
(ii) interfaces de programacion de aplicaciones (API) publicadas, o bien (iii) bibliotecas de cédigo fuente o codigo
objeto, aunque solo en la medida en que dicha personalizacion esté descrita en la Documentacion.

El Licenciatario podra utilizar, copiar o preparar obras derivadas de la Documentacion suministrada en formato digital y,
posteriormente, reproducir, visualizar y distribuir la documentaci6n personalizada solo para el propio uso interno del
Licenciatario. Las partes de 1a Documentacion facilitada en formato digital combinadas con otros programas de software,
asi como la documentacién impresa o digital, estdn sujetas al presente Contrato de Licencia. El Licenciatario deberd
incluir el siguiente aviso de atribucién de copyright reconociendo los derechos de propiedad de Esri y de sus
licenciantes: "Partes de este documento incluyen propiedad intelectual de Esri y de sus licenciantes, y son empleados
aqui bajo licencia. Copyright © [el Licenciatario debera insertar las fechas de copyright pertinentes de los materiales
originales] Esri y sus licenciantes. Todos los derechos reservados”.

Componentes de fuentes. Todas las fuentes suministradas con un Producto podran utilizarse con el uso autorizado de
cualquiera de los Productos. Las fuentes de Esri también se pueden utilizar por separado para imprimir documentos
creados por los Productos. Las restricciones adicionales de uso de las fuentes de terceros incluidas en un Producto se
establecen en el propio archivo de fuentes.

Acceso de Consultores o Contratistas. Con sujecion a lo dispuesto en la Seccién 3.1, Esri otorga al Licenciatario el .
derecho a permitir a sus consultores o contratistas €l uso de los Productos exclusivamente para el propio beneficio del
Licenciatario. En tal caso, el Licenciatario asumir4 la plena responsabilidad del cumplimiento de este Contrato de
Licencia por parte de dichos consultores y contratistas, y deberé asegurarse de que dejen de utilizar el Producto una vez
que concluyan los trabajos que realicen para el Licenciatatio. Queda prohibido el acceso a los Productos o et uso de4os
mismos por parte de consultores o contratistas si no es exclusivamente para beneficio del Licenciatario.

El Licenciatario podra utilizar, copiar, reproducir, publicar, exhibir publicamente o redistribuir a terceros imagenes de
mapas ¢ informes que contengan imégenes de mapas procedentes del uso de los Productos de Esri en copia impresa o en
formato electrénico (por ejemplo, PDF, GIF, JPEG) con sujecion a las restricciones establecidas en este Contrato,
siempre que el Licenciatario adjunte una declaraci6n de atribucién a las imagenes de mapas reconociendo a Esri y/o los
licenciantes aplicables como fuente de las partes de Datos utnlxzados para las imigenes de mapas. A efectos de disipar
toda duda, todos los datos que el Licenciatario proporciona o utiliza en el uso de los Productos que no sean los Datos
seran y deberén seguir siendo propiedad del Licenciatario o de los licenciantes externos.

4.2 Usos no permitides. Salvo en la medida en qué la legislacién vigente prohiba o suprima las siguientes restricciones, o
segun lo aqui estipulado, el Licenciatario no podra

a. Vender, alquilar, arrendar, ceder en réginien de sublicencia, emplear de forma compartida, asignar o utilizar los-
Productos para Uso de PSA Comercial o de servicios;

b. Proporcionar a terceros el acceso directo a los Productos de tal manera que los terceros puedan utilizar el Producto
de forma directa, desarrollar sus propias aplicaciones de GIS o crear sus propias soluciones conjuntamente con el
Producto;

¢. Distribuir a terceros Software, Datos u Online Services, de forma total o parcial, incluido sin limitaciones las
extensiones, los componentes o los DLL;

d. Distribuir Cédigos de Autorizaci6n a terceros;

Descompilar o desensamblar los Productos, o someterlos a ingenieria inversa;

Intentar eludir las medidas tecnolGgicas que controlan el acceso a los Productos o el uso de los mismos;

™o
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g. Guardar, almacenar en caché, utilizar, cargar, distribuir o ceder en régimen sublicencia el Contenido o utilizar de
cualquier otro modo los Productos infringiendo los derechos de Esri o de terceros, incluidos los de propiedad
intelectual y los de privacidad, las leyes antidiscriminaci6n o cualquier otra ley o reglamento que sea de aplicacion;

h. Eliminar u ocultar cualesquiera avisos y/o leyendas de patentes, derechos de autor, marcas comerciales relativos a
los derechos de propiedad de Esri (o de sus licenciantes) contenidos en o fijados a cualquier Producto, resultado de
Producto, archivo de metadatos o pagina de atribuciones Online y/o impresa, de los Datos o de la Documentacion
incluidos en virtud de este documento;

i.  Separar o utilizar de manera independiente partes individuales o componentes del Software, los Servicios de Internet
o los Datos;

j-  Incorporar cualquier parte del Producto a un producto o servicio que compita con cualquier Producto;

k. Publicar o comunicar de cualquier otra manera los resultados de pruebas comparativas de una version Beta sin el
consentimiento previo por escrito de Esri y sus licenciantes; ni

1.  Utilizar, incorporar, modificar, distribuir, proporcionar acceso o combinar cualquier codigo mformétlco
suministrado con cualquier Producto de una manera que someta a dicho c6digo o cualquier parte del Producto a las
condiciones de una licencia de cédigo abierto, incluyendo entre otras, aquellas que exijan que el codigo (i) se
divulgue a terceros en el formulario de codigo fuente, (ii) se ceda bajo licencia a terceros con €l objeto de elaborar
obras derivadas, o (iii) se redistribuya a terceros sin cargo.

CLAUSULA 5 —PLAZOY RESOLUCI(')N

El presente Contrato de Licencia entrard en vigor en el momento de su aceptacion. El Licenciatario podré. resolver este
Contrato de Licencia o cualquier Producto licenciado en todo momento notificdndolo por escrito a Esri. Cualquiera de las
partes podra resolver este Contrato de Licencia, asi como cualquler licencia, en caso de producirse un incumplimiento que no
sea subsanado en el plazo de treinta (30) dias a contar desde el momento en que la parte infractora reciba una notificacion a
tales efectos, aunque la resolucion ser4 inmediata en caso de que la infraccién no pueda ser subsanada. Una vez resuelto este
Contrato de Licencia, se extinguirdn asimismo todas las licencias otorgadas en virtud del mismo. Una vez resueltauna .
licencia o el Contrato de Licencia, el Licenciatario debera (i) dejar de acceder al o a los Productos afectados y de utilizarlos;
(ii) borrar los datos de caché derivados de los Online Services del lado del cliente; y (iii) desinstalar, borrar y destruir todas
las copias de los Productos afectados que obren en poder o estén bajo el control del Licenciatario, incluyendo partes
modificadas o combinadas de los mismos, en cualquier formato, acreditando la adopci6n de dichas medidas ante Esri o su
distribuidor autonzado

CLAUSULA 6 — LﬁMlTAClé‘N DE GARANTiAS Y EXENCIONES DE RESPONSABILIDAD

6.1 Limitacién de garantias. Salvo que la presente Clausula 6 estipule lo contrario, Esri garantiza que, durante un periodo
de noventa (90) dias a contar desde la fecha en que Esri expida el Cédigo de autorizacién que permita el uso del Software y
de los Online Services, (i) el funcionamiento del Software y los Online Services no modificados se ajustarén sustancialmente
a lo indicado en laDocumentacién publicada en condiciones normales de uso y servicio; y que (ii) el soporte sobre €l que se
facilita el Software estara libre de defectos materiales y de mano de obra. ’

6.2 Exencién de responsabilidad particular, LOS CONTENIDOS, LOS DATOS, LAS MUESTRAS, LAS SOLUCIONES
PROVISIONALES, LOS PARCHES, LAS ACTUALIZACIONES, LOS SERVICIOS EN LINEA NO SUJETOS A
TARIFAS Y EL SOFTWARE DE EVALUACION Y BETA SE FACILITAN "TAL CUAL", SIN GARANTIAS DE
NINGUNA {NDOLE.

6.3 Exenci6n de responsabxhdad de Internet. LAS PARTES RECONOCEN Y ACEPTAN EXPRESAMENTE QUE
INTERNET ES UNA RED DE REDES PRIVADAS Y PUBLICAS, Y QUE (i) INTERNET NO ES UNA
INFRAESTRUCTURA SEGURA, (ii) LAS PARTES NO TIENEN NINGUN CONTROL SOBRE INTERNET, Y

(iii) NINGUNA DE LAS PARTES SERA RESPONSABLE POR DANOS EN VIRTUD DE NINGUNA
INTERPRETACION O FUNDAMENTO RELATIVO AL RENDIMIENTO O A LA FALTA DE FUNCIONAMIENTO DE
CUALQUIER PARTE DE INTERNET, O RESPECTO A POSIBLES REGULACIONES DE INTERNET SUSCEPTIBLES
DE RESTRINGIR O PROHIBIR EL FUNCIONAMIENTO DE LOS SERVICIOS EN LINEA.

6.4 Exencién de responsabilidad general. CON LA EXCEPCION DE LAS GARANTIAS LIMITADAS
ANTERIORMENTE INDICADAS, ESRI NO OTORGA NI RESPONDE POR OTRAS GARANTIAS O CONDICIONES
DE TODA INDOLE, SEAN EXPLICITAS O IMPLICITAS, INCLUYENDO, ENTRE OTRAS, GARANTIAS O
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CONDICIONES DE COMERCIABILIDAD £ IDONEIDAD PARA UN DETERMINADO PROPOSITO, INTEGRACION
EN SISTEMAS Y NO INFRACCION DE DERECHOS DE PROPIEDAD INTELECTUAL. ESRI NO GARANTIZA QUE
LOS PRODUCTOS VAYAN A SATISFACER LAS NECESIDADES DEL LICENCIATARIO, QUE EL MANEJO DE
LOS MISMOS POR PARTE DEL LICENCIATARIO VAYA A SER ININTERRUMPIDO, SIN ERRORES, TOLERANTE
A FALLOS O SIN FALLOS; NI QUE TODAS LAS NO CONFORMIDADES PUEDAN SER CORREGIDAS O VAYAN
A SERLO. LOS PRODUCTOS NO HAN SIDO DISENADOS, FABRICADOS NI PREVISTOS PARA SER UTILIZADOS
EN ENTORNOS O APLICACIONES SUSCEPTIBLES DE PROVOCAR MUERTE, LESIONES O DANOS
PERSONALES, MATERIALES O AL MEDIO AMBIENTE. EL LICENCIATARIO NO DEBERA SEGUIR NINGUNA
SUGERENCIA DE RUTA QUE PUEDA RESULTAR PELIGROSA, INSEGURA O ILEGAL. DICHOS USOS SERAN
POR CUENTA Y RIESGO PROPIOS DEL LICENCIATARIO.

6.5 Compensacién exclusiva, La compensacién que exclusivamente asistird al Licenciatario y la responsabilidad que asume
Esri por incumplimiento de las garantias limitadas expuestas en la presente Clausula 6 se limitar, segin el criterio exclusivo
de Esri, a (i) la sustitucién de cualquier soporte defectuoso; (ii) la reparacién, correccién o solucién temporal del Software o
de los Online Services, con arreglo al Programa de mantenimiento de Esri o del distribuidor autorizado del Licenciatario,
seglin proceda; o bien a la (iii) devolucién de los precios de licencia pagadas por el Licenciatario en concepto del Software o
de los Online Services que incumplan la garantia limitada de Esri, siempre y cuando el Licenciatario desinstale, elimine y
destruya todas las copias del Software o de la Documentacion, deje de utilizar los Onlme Services y se acredite la adopci6n
de dichas medidas ante Esri o su distribuidor autorizado.

CLAUSULA 7 — LIMITACION DE RESPONSABILIDAD

7.1 Exenci6én de determinados tipos de responsabilidades. ESRI, SU DISTRIBUIDOR AUTORIZADO Y SUS
LICENCIANTES NO ASUMIRAN RESPONSABILIDAD ALGUNA FRENTE AL LICENCIATARIO DERIVADA DE
LOS COSTES GENERADOS POR LA ADQUISICI(‘)N DE PRODUCTOS O SERVICIOS SUSTITUTQS; LUCRO
CESANTE, O CUALQUIER DANO INDIRECTO O CONSECUENCIAL; PERDIDASDE VENTAS O GASTOS
EMPRESARIALES; INVERSIONES; COMPROMISOS COMERCIALES; PERDIDAS DE FONDO DE COMERCIO; O
CUALESQUIERA OTROS DANOS INDIRECTOS, ESPECIALES, INCIDENTALES O CONSIGUIENTES DERIVADOS
DE, O RELACIONADOS CON, EL PRESENTE CONTRATO DE LICENCIA O EL USO DE LOS PRODUCTOS,
INDEPENDIENTEMENTE DE QUE HUBIESEN OCURRIDO CON ARREGLO A CUALQUIER TEORIA DE
RESPONSABILIDAD, TANTO SI A ESRI, SU DISTRIBUIDOR AUTORIZADO O SUS LICENCIANTES SE LES
HAYA ADVERTIDO O NODE LA POSIBILIDAD DE DICHOS DANOS. LAS PRESENTES LIMITACIONES SE
APLICARAN INDEPENDIENTEMENTE DE LAS ACCIONES QUE PUEDA ACOMETER EN DEFENSA DE SUS
INTERESES EL LICENCIATARIO.

7.2 Limitacién general de responsabilidad. SALVO POR LO DISPUESTO EN LA CLAUSULA 8, INDEMNIZACI()N
POR INFRACCION, LA RESPONSABILIDAD TOTAL ACUMULADA DE ESRI Y DE SUS DISTRIBUIDORES'
AUTORIZADOS DERIVADAS DE-RECLAMACIONES DE CUALQUIER INDOLE, INCLUYENDO, ENTRE OTRAS,
CONTRACTUALES, EXTRACONTRACTUALES (ASf COMO NEGLIGENCIA), RESPONSABILIDAD DIRECTA,
INCUMPLIMIENTO DE GARANTIA, FALTA DE REPRESENTACION O POR ACCIONES DE CUALQUIER OTRA
CLASE, NO EXCEDERA DE LAS CUANTiAS QUE HAYA ABONADOEL LICENCIATARIO POR LOS PRODUCTOS
QUE HAYAN DADO ORIGEN A LA RECLAMACION,

7.3 Aplicacién de exenciones de responsabilidad y limitaciones. Las limitaciones y exenciones de responsabilidad del
presente Contrato de licencia serén de aplicaci6n, independientemente de que éste haya aceptado los Productos o cualquier
otro producto o servicio de Esri o su distribuidor autorizado. Las partes convienen en qué Esri o su distribuidor autorizado
han fijado sus precios y formalizado el presente Contrato de Licencia sobre la base de las exenciones y limitaciones de
responsabilidad aqui estipuladas, que las mismas reflejan un reparto de los riesgos entre las partes y que las mismas
constituyen la base esencial del acuerdo entre las partes. LAS PRESENTES LIMITACIONES SE APLICARAN
INDEPENDIENTEMENTE DE LLAS ACCIONES QUE PUEDA ACOMETER EN DEFENSA DE SUS INTERESES EL
LICENCIATARIO.

LAS GARANT{AS, LIMITACIONES Y EXCLUSIONES ANTEDICHAS PUEDEN NO SER VALIDAS EN ALGUNAS
JURISDICCIONES, Y SERAN DE APLICACION SOLAMENTE EN LA MEDIDA EN QUE AS{ LO PERMITA LA
LEGISLACION APLICABLE EN LA JURISDICCION DEL LICENCIATARIO. ES POSIBLE QUE LA LEY OTORGUE
AL LICENCIATARIO DERECHOS ADICIONALES A LOS QUE NO SE PUEDE RENUNCIAR. ESRI NO PRETENDE
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LIMITAR LAS GARANTIAS O RECURSOS DEL LICENCIATARIO EN NINGUNA MEDIDA EN QUE LA LEY NO
LO PERMITA.

CLAUSULA 8 — INDEMNIZACION POR INFRACCION

8.1 Tal como se describe mas adelante, Esri defenderd, indemnizard y protegera al Licenciatario frente a cualesquiera
pérdidas, responsabilidades, costes o gastos, incluyendo los honorarios legales razonables derivados de denuncias,
procedimientos o demandas de terceros que aleguen que el uso por parte del Licenciatario del Software o de los Online
Services infringen alguna patente, derecho de autor o marca comercial de EE.UU., siempre y cuando

a. ElLicenciatario notifique por escrito y a la mayor brevedad a Esri la existencia de dicha reclamacion;
_ b. ElLicenciatario aporte documentacién que describa las alegaciones relativas a la infracci6n;
c. Esri controle exclusivamente la defensa de cualquier procedimiento o negociacién relativo a la defensa o acuerdo
extrajudicial de cualquier reclamacién; y
d. ElLicenciatario coopere razonablemente en la defensa de 1a demanda a peticién y a expensas de Esri,

8.2 Si se determina que el Software o los Online Services vulneran una patente, derecho de autor o marca comercial de
EE.UU., Esri podré, a sus propias expensas, (i) obtener para el Licenciatario los derechos que le permitan seguir utilizando el
Software o los Online Services, o bien (ii) modificar los elementos supuestamente infractores del Software o de los Online
Services, manteniendo sustancialmente una funcionalidad similar. Si ninguna de las alternativas resultase viable desde un
punto de vista comercial, 1a licencia se dara por terminada y el Licenciatario cesara en el acceso a Online Services
infractores, y desinstalara y devolvera a Esri o a su distribuidor autorizado los elementos que sea la causa de la infraccién. En
tal caso, Esri procedera a indemnizar al Licenciatario conforme a lo dispuesto en la Seccién 8.1 y (i) Esri o su distribuidor
autorizado reintegrara los precios de licencia perpetua que haya abonado el Licenciatario en concepto de los elementos
infractores, prorrateados sobre la base de una depreciacion lineal de cinco (5) afios a contar desde la fecha inicial de la
entrega; y (ii) en el caso de Licencias Temporales y mantenimiento, reintegrar 1a parte no utilizada de los precios pagados.

8.3 Esri no vendra obligada a defender al Licenciatario, ni a pagar los costes, dafios u honotarios legales resultantes, por
denuncias o demandas que aleguen infraccién directa o concurrente, si dicha infraccién ha sido resultado de (i) la
combinacién o integracion del Software o de los Online Services con un producto, proceso o sistema no facilitado por Esri o
especificado por Esri en su Documentacién; (ii) la modificacién material del Software o de los Online Services por personas
distintas de Esri o de sus subcontratistas; o (iii) el uso del Software o de dos Online:Services una vez que Esri haya facilitado
modificaciones para evitar infracciones, o su utilizacion una vez que Esri haya solicitado una devolucion, tal y como se
estipula en la Seccién 8.2. .
8.4 CUANTO ANTECEDE CONSTITUYE LA TOTALIDAD DE LAS OBLIGACIONES DE ESR1Y SU

DISTRIBUIDOR AUTORIZADO CON RESPECTO A EAS INFRACCIONES O SUPUESTAS INFRACCIONES DE LOS -
DERECHOS DE PROPIEDAD INTELECTUAL DE TERCEROS.

CLAUSULA 9 — CLAUSULAS GENERALES

9.1 Futuras actualizaciones. El Uso de Productos licenciados en virtud del presente Contrato de Licencia esta cubierto por
los términos y condiciones contenidos en el mismo. Los Productos nuevos o actualizados pueden exigir condiciones de uso
adicionales o revisadas en virtud del Contrato de Licencia de Esri vigentes en ese momento. Esri publicara las condiciones de
uso nuevas o revisadas en http://www.esri.com/legal/software-license o bien notificar las condiciones nuevas o revisadas al
Licenciatario.

9.2 Reglamentos de control de exportaciones. Por la presente, el Licenciatario reconoce y acepta expresamente que el
Licenciatario no exportard, reexportara, importara, transferird, entregar ni proporcionara el acceso a Productos, Contenido,
Contenido de Licenciatario o Aplicaciones de Valor Afiadido, a (i) ningiin pais objeto de embargo por parte de EE.UU.;
(ii) ninguna persona incluida en la Lista de ciudadanos especialmente designados del Departamento del Tesoro de EE.UU.;
(iii) ninguna personal o entidad de la Lista de personas y entidades rechazadas o no verificadas del Departamento de
Comercio de EE.UU.; o (iv) ninguna persona o entidad o en ningiin pais donde dicha exportacion, reexportacion, acceso o
importacion infrinja leyes o reglamentos estadounidenses o locales de control de importaciones/exportaciones u otras
aplicables, incluyendo, entre otros, los términos y condiciones de cualesquiera licencia o exencién de licencia de
importacién/exportacion, y las enmiendas y complementos de tales leyes que pudiesen establecerse en cada momento.
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9.3 Impuestos, tasas y fletes. Los precios de licencia presupuestadas al Licenciatario excluyen impuestos o tasas aplicables
incluidas, sin caracter limitativo, los impuestos sobre las ventas, el uso y el valor afiadido (IVA), asi como los derechos y
aranceles de aduana, y gastos de flete y manipulacion.

9.4 Ausencia de renuncia. El hecho de que alguna de las partes renunciase a exigir el cumplimiento de cualquiera de las
clausulas de este Contrato de Licencia no se interpretard como una renuncia a las mismas ni afectard al derecho de dicha parte-
a ejercitar en cualquier momento los derechos que dimanen del presente Contrato.

9.5 Divisibilidad. Las partes convienen que, en caso de que alguna de las clausulas del presente Contrato de Licencia fuese
considerada maphcable por algin motivo, dicha cliusula sera reformada solamente en la medida necesaria para hacer
aplicable la misma.

9.6 Sucesores y cesionarios. El Licenciatario no podra ceder, otorgar en régimen de sublicencia ni transferir sus derechos ni
delegar sus obligaciones en virtud del presente Contrato de Licencia sin el consentimiento previo por escrito de Esri y su
distribuidor autorizado, y cualquier intento de hacerlo sin contar con dicho consentimiento careceré de toda validez. El
presente Contrato de Licencia serd vinculante para los respectivos sucesores y cesionarios de las partes de este Contrato de
Licencia. No obstante lo antedicho, un contratista del gobierno bajo contrato del gobierno para facilitar Productos podréa ceder
este Contrato de Licencia y los Productos adquiridos para entregarlos a su cliente gubernamental previa comunicacion por
escrito a Esri, siempre y cuando dicho cliente gubernamental acepte los términos y condiciones de este Contrato de Licencia.

9.7 'Supervivencia de los términos y condiciones. Lo dispuesto en las Clausulas 2, 5, 6, 7, 8 y 9 de este Contrato de
Licencia seguiran vigentes una vez que se haya producido la extincién o resolucion del mismo.

9.8 Compensaciones y medidas cautelares. El Licenciatario acepta que cualquier incumplimiento del presente Contrato de
Licencia por su parte pueden provocar daiios irreparables y que, en el caso de dichos incumplimientos, ademas de todos los -
recursos que pudiesen asistirle legalmente, Esri o su distribuidor autorizado estaran facultados para solicitar la adopcién de
medidas cautelares u otras formas de proteccion ante cualquier tribunal competente sin la obligacion de aportar una fianza o
de demostrar dafios como requisito necesario para su adopcion.

9.9 Licenciatario del gobierno de EE.UU. Los Productos son articulos comerciales, desarrollados con fondos privados, que -
se otorgan al Licenciatario en virtud de este Contrato de Licencia. Si €l Licenciatario es una entidad o un contratista del .
gobierno de EE.UU., Esri le cede los Productos bajo licéncia de acuerdo a este Contrato de Licencia en virtud del reglamento -
FAR, Subpartes 12.211/12.212, o DFARS, Subparte 227.7202. Los Datos y Online Services de Esri se ceden bajo licencia en
virtud de la misma politica DFARS Subparte 227.7202 como software informético comercial para las adquisiciones

realizadas en virtud de DFARS. Los Productos estdn sujetos a restricciones y este Contrato de Licencia rige estrictamente el
uso, modificacién, rendimiento, reproduccion, entrega, exhibicion o divulgacion de los Productos por parte del Licenciatario.
No se aplicaran aquellas disposiciones de la Licencia que sean inconsecuentes con la legislacion federal. Un Licenciatario del _
gobierno de Estados Unidos podra transferir el ‘Software a cualquiera de las instalaciones a las que s transfieran los
ordenadores en los que este tipo de Software esté instalado. Si algin tribunal, arbitro o u organismo rector determina que al
Licenciatario le asisten més derechos sobre cualquier parte de los Productos con arreglo a las leyes de compras pablicas
vigentes, dichos derechos se extenderan solamente a aquellas partes afectadas.

9.10 Legislacién aplicable y arbitraje

a. Licenciatarios de EE.UU., sus territorios y zonas insulares. El presente Contrato de Licencia se regira e interpretard con
arreglo a las leyes del Estado de California, sin tener en cuenta los principios de conflicto de leyes, aunque en todo caso
la legislacion federal de EE.UU. sera de aplicacion para los asuntos relativos a la propiedad intelectual y para el uso por
parte de los organismos del gobierno de EE.UU. Salvo por lo dispuesto en la Seccién 9.8, toda disputa derivada de, o
relacionada con, este Contrato de Licencia o el incumplimiento del mismo que no pueda ser resuelta mediante
negociaciones, sera definitivamente resuelto por un arbitraje dirigido por 1a American Arbitration Association con
arreglo a su Reglamento de Arbitraje Comercial. El laudo arbitral que se dicte podra ser ejecutado ante el tribunal
competente que corresponda. Si €l Licenciatario es un organismo del gobierno de EE.UU., este Contrato de Licencia
quedara sujeto a la Ley de Disputas Contractuales de 1978 y a sus correspondientes enmiendas (41 USC 601-613), sin
que sea de aplicacion la presente cliusula de arbitraje. El presente Contrato de Licencia no se regira por la Convencién
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de las Naciones Unidas sobre los Contratos de Compraventa Internacional de Mercaderias, cuya aplicacién queda
expresamente excluida.

b. Todos los demds Licenciatarios. Con las excepciones previstas en la Seccion 9.8, toda disputa derivada de, o relacionada
con, el presente Contrato de Licencia o su incumplimiento que no pueda ser resuelta mediante negociaciones, sera
definitivamente resuelta segiin las normas de la Camara Internacional de Comercio por un (1) arbitro nombrado en virtud -
de dichas normas. El idioma del arbitraje seré el inglés. El lugar del arbitraje sera el que convengan las partes. El
presente Contrato de Licencia no se regira por la Convenci6n de las Naciones Unidas sobre los Contratos de
Compraventa Internacional de Mercaderias, cuya aplicacion queda expresamente excluida. Cualquiera de las partes
deber4, a peticion de la otra, facilitar los documentos o testigos relevantes para los aspectos mas importantes de la
disputa.

" 9.11 Mantenimiento. El mantenimiento de los Productos que retinen los requisitos consistir en actualizaciones y otras
prestaciones, como el acceso al servicio técnico, especificados en la politica de mantenimiento a la sazén vigente de Esri o de
su distribuidor.

" 9.12 Comentarios. Esri estara facultada para utilizar los comentarios, sugerencias o peticiones de mejora de los Productos
que el Licenciatario comunique a Esri.

9.13 Patentes. El Licenciatario no podr4 solicitar, ni permitir que otros usuarios soliciten, una patente o derecho similar, en
ningiin lugar del mundo, basado en, o que incorpore, cualquier tecnologfa o servicios de Esri. Esta prohibicién expresa de
solicitar patente no seré de aplicacion al software y la tecnologia del Licenciatario, salvo en la medida en que afecte a la
tecnologia o los servicios de Esri, o cualquier parte de los mismos, sea parte de una reclamacion o realizacion preferente de
una solicitud de patente o similar.

9.14 Acuerdo integro. El presente Contrato de Licencia, incluyendo los documentos que incorpora, constituye el acuérdo
integro entre las partes, y sustituye a cualesquiera otros coritratos de licencia, acuerdos y convenios entre las partes relativos a
dicho asunto. Las condiciones adicionales o contradictorias incluidas en cualquier solicitud de licencia, factura u otro
documento de formato estandar intercambiado durante el proceso de solicitud, con excepci6n de los documentos relativos a
las descripciones, cantidades, precios e instrucciones de entrega de los Productos, seran consideradas nulas y sin efecto. Toda
modificacion o enmienda del presente Contrato de Licencia debera ser por escrito y estar firmada por ambas partes.

g . ; .
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